Notices

© Agilent Technologies, Inc. 2010

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

User Guide Part Number
G5400-90004

Edition
Revision 01, March 2010

Contact Information
Agilent Technologies Inc.
Automation Solutions
5301 Stevens Creek Blvd.
Santa Clara, CA 95051
USA

Technical Support: 1.800.979.4811
or +1.408.345.8011
service.automation@agilent.com

Customer Service: 1.866.428.9811
or +1.408.345.8356
orders.automation@agilent.com

European Service: +44 (0)1763853638
euroservice.automation@agilent.com

Documentation feedback:
documentation.automation@agilent.com

Web:
www.agilent.com/lifesciences/
automation

Acknowledgements
Microsoft and Windows are registered trademarks of the Microsoft Corporation in the United States and other countries.

Warranty
The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend
If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is delivered and licensed as “Commercial computer software” as defined in DFAR 252.227-7014 (June 1995), or as a “commercial item” as defined in FAR 2.101(a) or as “Restricted computer software” as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is subject to Agilent Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June1987) or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.

Safety Notices
A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.
## Contents

**Preface**  
About this guide  
Accessing Automation Solutions user guides  

1. **Safety guidelines**  
   General safety information  
   Emergency stops  
   Potential safety hazards  

2. **Introduction to BenchCel Workstation**  
   BenchCel Workstation description  
   Hardware overview  
   Accessories  
   Integration options  
   Labware considerations  
   Software description  

3. **Installing BenchCel Workstation**  
   Installation workflow  
   Verifying laboratory requirements  
   Unpacking the BenchCel Workstation  
   Mounting the robot on the BenchCel device  
   Integrating the devices  
   Connecting the power source  
   Connecting the pendant  
   Connecting and disconnecting the air source  
   Connecting the computer  
   Installing the safety shield  

4. **Setting up BenchCel Workstation**  
   Setup Workflow  
   Starting up and shutting down  
   Creating a BenchCel device in the VWorks software  
   Opening BenchCel Diagnostics  
   Creating profiles  
   Setting and managing teachpoints.
### Contents

5. **Setting sensor thresholds**  
   Overview for setting sensor thresholds ......................................................... 86  
   Calculating the Plate presence threshold ....................................................... 88  
   Determining the optimum Orientation sensor offset .......................................... 93  
   Calculating the Orientation threshold .......................................................... 97  
   Worksheet for setting sensor thresholds ......................................................... 99

6. **Preparing for a run**  
   Workflow for operating the BenchCel Workstation ........................................... 102  
   Handling the labware racks ............................................................................. 103  
   Filling and emptying the labware racks ........................................................... 105  
   Installing and uninstalling the labware racks ................................................. 109  
   Performing pre-run checks ............................................................................. 114

7. **Maintenance and troubleshooting**  
   Routine maintenance ....................................................................................... 116  
   Cleaning up after a protocol run ...................................................................... 118  
   Replacing the fuse ............................................................................................ 120  
   Hardware problems ......................................................................................... 123  
   Software error messages .................................................................................. 125  
   Diagnostic tools ............................................................................................... 132  
   Adjusting the stacker gripper pressure ............................................................. 144  
   Reporting problems ......................................................................................... 148

A. **BenchCel ActiveX control**  
   About ActiveX controls .................................................................................... 152  
   Properties .......................................................................................................... 153  
   Methods ............................................................................................................ 155  
   Events ................................................................................................................ 171

B. **Quick reference**  
   Rack-release button indicator light ................................................................. 176  
   BenchCel Diagnostics - Controls tab ............................................................... 177  
   BenchCel Diagnostics - Jog/Teach tab ............................................................. 180  
   BenchCel Diagnostics - Labware tab ............................................................... 183  
   BenchCel Diagnostics - General Settings tab .................................................. 188  
   BenchCel Diagnostics - Profiles tab ............................................................... 189  
   Teachpoint Details dialog box ......................................................................... 193

**Glossary** .......................................................................................................... 197

**Index** ............................................................................................................. 199
Preface

This preface contains the following topics:

- “About this guide” on page vi
- “Accessing Automation Solutions user guides” on page vii
About this guide

Who should read this guide

This user guide is for people with the following job roles:

<table>
<thead>
<tr>
<th>Job role</th>
<th>Responsibilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installer</td>
<td>Unpacks, installs, and tests the BenchCel Workstation before it is used.</td>
</tr>
<tr>
<td>Integrator</td>
<td>Writes software and configures hardware controlled by the VWorks software.</td>
</tr>
</tbody>
</table>
| Lab manager, administrator, or technician | • Manages the VWorks software  
                                    | • Develops the protocols that are run on it  
                                    | • Manages the BenchCel Workstation  
                                    | • Develops training materials and standard operating procedures for operators |
| Operator                        | Performs the daily production work on the BenchCel Workstation and solves routine problems. |

What this guide covers

This guide covers the description, installation, setup, operation, and maintenance of the BenchCel Microplate Handling Workstation (BenchCel Workstation).

This guide does not provide instructions for the following:

- VWorks Version 4 Automation Control Software
- Automation Solutions devices that are integrated with the BenchCel Workstation, such as the PlateLoc Thermal Microplate Sealer, the Microplate Barcode Labeler, and the Vertical Pipetting Station
- Third-party devices

For more information about these topics, see the relevant user guides for these products.

What is new in this revision

<table>
<thead>
<tr>
<th>Feature and description</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revised the description of the device ActiveX controls.</td>
<td>“BenchCel ActiveX control” on page 1</td>
</tr>
</tbody>
</table>

Software version

This guide documents BenchCel Diagnostics version 19.0.3 or later.
Related guides

You should use this guide in conjunction with the following guides:

- **VWorks Automation Control Setup Guide.** In addition to installation instructions, this guide explains how to define labware and labware classes, liquid classes, and pipetting techniques.
- **VWorks Automation Control User Guide.** This guide explains how to create and run protocols.
- Automation Solutions device user guides. These guides explain how to set up and use the devices that you integrate with the BenchCel Workstation, such as the *Bravo Automated Liquid Handling Platform User Guide.*
- Third-party device user documents, if applicable. These guides explain how to set up and use the third-party lab devices.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to access other user guides</td>
<td>“Accessing Automation Solutions user guides” on page vii</td>
</tr>
<tr>
<td>BenchCel Workstation safety guidelines</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Getting started with the BenchCel Workstation</td>
<td>“Introduction to BenchCel Workstation” on page 11</td>
</tr>
<tr>
<td>Reporting problems with the BenchCel Workstation</td>
<td>“Reporting problems” on page 148</td>
</tr>
</tbody>
</table>

**Accessing Automation Solutions user guides**

**About this topic**

This topic describes the different formats of Automation Solutions user information and explains how to access the user information.

**Where to find user information**

The Automation Solutions user information is available in the following locations:

- **Knowledge base.** The help system that contains information about all of the Automation Solutions products is available from the Help menu within the VWorks software.
• **PDF files.** The PDF files of the user guides are installed with the VWorks software and are on the software CD that is supplied with the product. A PDF viewer is required to open a user guide in PDF format. You can download a free PDF viewer from the internet. For information about using PDF documents, see the user documentation for the PDF viewer.

• **Agilent Technologies website.** You can search the online knowledge base or download the latest version of any PDF file from the Agilent Technologies website at www.agilent.com/lifesciences/automation.

**Accessing safety information**

Safety information for the Agilent Technologies devices appears in the corresponding device user guide.

You can also search the knowledge base or the PDF files for safety information.

**Using the knowledge base**

Knowledge base topics are displayed using web browser software such as Microsoft Internet Explorer and Mozilla Firefox.

*Note:* If you want to use Internet Explorer to display the topics, you might have to allow local files to run active content (scripts and ActiveX controls). To do this, in Internet Explorer, open the Internet Options dialog box. Click the Advanced tab, locate the Security section, and select Allow active content to run in files on my computer.

*To open the knowledge base, do one of the following:*

- From within VWorks software, select Help > Knowledge Base or press F1.
- From the Windows desktop, select Start > All Programs > Agilent Technologies > VWorks > User Guides > Knowledge Base.
To access the context-sensitive help feature:

1. In the main window of the VWorks software, click the help button 🎨. The pointer changes to 🤔. Notice that the different icons or areas are highlighted as you move the pointer over them.

2. Click an icon or area of interest. The relevant topic or document opens.
Features in the Knowledge Base window

1. **Navigation area.** Consists of four tabs:
   - **Contents.** Lists all the books and the table of contents of the books.
   - **Index.** Displays the index entries of all of the books.
   - **Search.** Allows you to search the Knowledge Base (all products) using keywords. You can narrow the search by product.
   - **Favorites.** Contains bookmarks you have created.

2. **Navigation buttons.** Enable you to navigate through the next or previous topics listed in the Contents tab.

3. **Content area.** Displays the selected online help topic.

4. **Toolbar buttons.** Enable you to print the topic or send documentation feedback by email.
## Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who should read this guide and what this guide covers</td>
<td>“About this guide” on page vi</td>
</tr>
<tr>
<td>BenchCel Workstation safety guidelines</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Getting started with the BenchCel Workstation</td>
<td>“Introduction to BenchCel Workstation” on page 11</td>
</tr>
<tr>
<td>Reporting problems with the BenchCel Workstation</td>
<td>“Reporting problems” on page 148</td>
</tr>
</tbody>
</table>
Preface
Accessing Automation Solutions user guides
1 Safety guidelines

Before installing and using the BenchCel Workstation, you must be familiar with the potential safety hazards and how to avoid them. This chapter contains the following topics, which describe the safety information for the BenchCel Workstation:

- “General safety information” on page 2
- “Emergency stops” on page 4
- “Potential safety hazards” on page 7
General safety information

About this topic

The BenchCel Workstation is designed for safe operation. Under normal operating conditions, you are protected from moving parts and hazardous voltage. However, you must be aware of the potential hazards and understand how to avoid being exposed to them.

Before using the BenchCel Workstation

Before using the BenchCel Workstation, make sure you are properly trained in:

- General laboratory safety
- The correct and safe operation of the BenchCel Workstation
- The correct and safe operation of other lab automation systems or components used in combination with the BenchCel Workstation

Intended product use

WARNING  Do not remove the BenchCel Workstation exterior covers or otherwise disassemble the system or device. Doing so can cause injuries and damage the BenchCel Workstation.

WARNING  Using controls, making adjustments, or performing procedures other than those specified in the user guide can expose you to moving parts, hazardous voltage, high-pressure gases, and laser radiation. Exposure to these hazards can cause severe injury.

Agilent Technologies products must only be used in the manner described in the Agilent Technologies product user guides. Any other use may result in damage to the product or personal injury. Agilent Technologies is not responsible for any damages caused, in whole or in part, by improper use of the products, unauthorized alterations, adjustments or modifications to the products, failure to comply with procedures in Agilent Technologies product user guides, or use of the products in violation of applicable laws, rules or regulations. Except as otherwise expressly provided in Agilent Technologies product user guides, any alteration, adjustment or modification to the products will void the product warranty.

The BenchCel Workstation is not intended or approved for diagnosis of disease in humans or animals. You assume full responsibility for obtaining any regulatory approvals required for such use and assume all liability in connection therewith.

Safety labels

Pay attention to any safety labels affixed to your device. A safety label consists of a warning symbol. A description of the warning and information that will help you to avoid the safety hazard are provided in this user guide.

The following figure shows an example of a warning label that indicates risk of danger. It is located on the lower left and right sides of the BenchCel robot.
1 Safety guidelines
General safety information

Figure BenchCel robot warning label location

Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety hazards</td>
<td>“Potential safety hazards” on page 7</td>
</tr>
<tr>
<td>Stopping the BenchCel</td>
<td>“Emergency stops” on page 4</td>
</tr>
<tr>
<td>Workstation in an emergency</td>
<td></td>
</tr>
<tr>
<td>Reporting problems with the</td>
<td>“Reporting problems” on page 148</td>
</tr>
<tr>
<td>BenchCel Workstation</td>
<td></td>
</tr>
</tbody>
</table>
Emergency stops

About this topic
This topic explains how to stop the BenchCel Workstation in an emergency situation and how to recover from an emergency stop.
To pause and continue a run, use the Pause command in the VWorks software. For instructions, see the VWorks Automation Control User Guide.

Stopping in an emergency

**WARNING** Pressing the robot disable button turns off power to the robot motors only. Power is still on in the rest of the workstation.

To stop the robot in an emergency:
Press the large robot disable button on the pendant. The safety interlock circuit is interrupted, disabling the robot motors. The BenchCel Workstation operation stops.

**IMPORTANT** After the motors are disabled, the robot head and arms might have momentum and continue to move until they come to the end of the x-axis, z-axis, or theta-axis, or until they bump into an obstacle.

Recovering from an emergency stop
After you press the robot disable button on the pendant, the robot stops. One of the following occurs:
- If you stopped a protocol run, a prompt dialog box opens in the VWorks software.
- If you stopped the robot while diagnosing problems in BenchCel Diagnostics, a motor-disable message appears on the screen.

Use the following procedure to recover the BenchCel Workstation in either case.

To recover the BenchCel device after an emergency stop:

1. If the robot dropped labware before or during the emergency stop, remove labware that was dropped. Also remove labware at teachpoints or other locations.
If the BenchCel robot attempted to place labware at a location that was not free, a collision might have occurred resulting in misalignment of the robot grippers. Check the robot gripper alignment:

a. Move the robot arms so that they are perpendicular to the \( x \)-axis.

b. Make sure the bottom of the robot grippers are perpendicular to the robot arms. If they are not, contact Automation Solutions Technical Support.

**Figure** Gripper alignment: (A) correct alignment, and (B) incorrect alignment
3 At the pendant, turn the robot disable button clockwise to restore power to the motors.

4 If you stopped a protocol run in an emergency, select one of the following in the VWorks software message dialog box:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnostics</td>
<td>Opens the BenchCel Diagnostics dialog box. See step 5.</td>
</tr>
<tr>
<td></td>
<td><em>Note</em>: This selection is available only when you are in the middle of a protocol run and not while you are in BenchCel Diagnostics.</td>
</tr>
<tr>
<td>Retry</td>
<td>Attempts to restart the current command or task in the run.</td>
</tr>
<tr>
<td>Ignore and continue</td>
<td>Ignores the current command or task and continues to the next command or task in the protocol sequence.</td>
</tr>
<tr>
<td>Abort</td>
<td>Aborts the current command or task in the run. Select Abort if you have determined that the protocol run is not recoverable.</td>
</tr>
</tbody>
</table>

For a full description of the selections, see the *VWorks Automation Control User Guide*.

5 *Optional*. In BenchCel Diagnostics, use the available commands to manually move the robot or other components, including:

- Release the microplate that the robot is currently holding.
- Upstack the microplate that the robot is currently holding.
- Replace the lid on the microplate.
- Home the robot.
- Verify teachpoints.

If a physical crash occurred, always start BenchCel Diagnostics to home the robot and verify teachpoints.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pausing and resuming protocol runs</td>
<td><em>VWorks Automation Control User Guide</em></td>
</tr>
<tr>
<td>The pendant and its use</td>
<td>“Hardware overview” on page 14</td>
</tr>
</tbody>
</table>
Potential safety hazards

About this topic

This topic describes potential hazards that you can encounter when using the BenchCel Workstation.

Safety shield

Make sure the BenchCel Workstation is enclosed in the supplied safety shield. Using the safety shield restricts access to the BenchCel Workstation while it is operating.

**WARNING** Operating the BenchCel Workstation without a safety shield or the enclosure covers increases the risk of injury.

Safety interlock override

The BenchCel Workstation has a safety interlock circuit that must be closed for the system to operate. Pressing the robot-disable button on the pendant interrupts the safety interlock circuit, disabling the robot motors.

**WARNING** Do not disable or override the BenchCel Workstation safety interlock circuit. Operating the BenchCel Workstation without the safety interlock circuit increases the risk of injury.

Moving parts

To minimize potential injury, the BenchCel Workstation is designed to stop immediately if the robot head hits an obstacle while it is in operation. However, be aware that the robot moves with considerable force in the vertical or z-axis direction and could pierce your skin with one of its grippers.

Not all circumstances can be foreseen and serious injury is possible. It is the responsibility of every operator to follow warnings and safety labels and keep out of the robot’s workspace whenever it is likely to move.

**WARNING** The BenchCel Workstation has moving parts that can injure you if you deviate from the procedures given in this guide. Keep your fingers, hair, clothing, and jewelry away from the BenchCel Workstation while it is in motion.
1 Safety guidelines
Potential safety hazards

**WARNING** Do not touch the BenchCel Workstation as you start the software. The robot head moves when the device initializes.

**WARNING** Never touch any of the moving parts or attempt to remove or add labware while the BenchCel Workstation is in operation. The robot head moves with considerable force and can cause pinching, piercing, or bruising injury if you are in the path of the robot head or grippers.

**WARNING** Pinch hazard! Keep your fingers out of the path of the labware racks when you mount the racks on the BenchCel device.

**WARNING** Use the rack handle to carry the labware racks. Do not hold a rack by the interior edges. The interior edges can have sharp surfaces that can cause cuts if handled improperly.

*Figure* Sharp surfaces on the labware racks: standard model (A), and front load model (B)

---

**Infrared LED injury hazard**

**WARNING** Do not look directly at the light-emitting diodes (LEDs) inside the stacker heads when the device is on. Such exposure to the LEDs can cause eye injury.

Each BenchCel device stacker head contains seven infrared LEDs that detect the presence of a labware rack, microplates, and microplate notches. The LEDs are capable of dissipating 100 mW of power. Do not look directly at the LEDs when the BenchCel device is turned on.
Hazardous-voltage electronics

Hazardous-voltage electronics can be found within the BenchCel Workstation and the integrated external devices. Under normal operating conditions, you are protected from exposure to the hazardous voltage.

**WARNING** Do not try to gain access to the interior of the BenchCel device or any device integrated with the workstation. Do not remove device panels for any reason. Exposure to the interior electronics of a device can cause severe injury.

Hazardous-voltage electronics can also be found in the computer. See the computer manufacturer documentation for the hazard warnings. Make sure you follow the instructions on the safe operation of the computer.

**WARNING** Ensure that the power cords are in good condition and are not frayed. Use of frayed or damaged power cords can cause injury. Use of incorrect power cords can cause damage to the device.

High-pressure gas

Compressed air is used to move components within the BenchCel Workstation and some devices that can be integrated with the workstation, such as the following:

- Vertical Pipetting Station shelves
- PlateLoc Sealer
- Seal Piercer
- Microplate Labeler
- Microplate Centrifuge and Centrifuge Loader

**WARNING** Working with open, charged air lines can result in injury. Turn off the compressed air line when disconnecting or reconnecting devices that use compressed air. Contact your facilities department or Automation Solutions Technical Support with questions about setting up the air line.

Follow the local, state, and federal safety codes for the placement and mounting of gas cylinders. For example, you might have to attach a standard cylinder bracket to a solid permanent structure to meet or exceed all local seismic and safety requirements.

Always use good laboratory practices when handling high-pressure cylinders. Make sure you follow any instructions provided with the cylinders.

**CAUTION** Ensure that the air coming into the BenchCel device is properly filtered from moisture or aerosolized impurities. Significant moisture or impurities in the air line can adversely affect the performance and life of the device. Using oil compressors can cause oil to leak into the device and void your warranty.

Chemical hazards

Some chemicals used when working with the BenchCel Workstation can be hazardous. Make sure you:
1 Safety guidelines

Potential safety hazards

- Follow standard laboratory procedures and cautions when working with chemicals.
- Follow your local, state, and federal safety regulations when using and disposing of the chemicals.

Improper access or use

**CAUTION** Improper use by an untrained user could damage the BenchCel Workstation. For example, the robot grippers could collide with a stacker if a teachpoint is not defined properly.

Ensure that only fully trained BenchCel administrators have access to the user account passwords.

Moving and unpacking the BenchCel Workstation

Before moving a BenchCel Workstation, ensure the new location meets the laboratory requirements.

**WARNING** Use care when lifting the BenchCel device to prevent personal injury and damage to the device. Depending on the configuration, the BenchCel device weighs 21.8 kg (48.1 lb) to 32.7 kg (72.1 lb) and requires two people to lift it.

**CAUTION** Agilent Technologies is not responsible for damage if the BenchCel Workstation is incorrectly packaged and moved by someone other than an Agilent Technologies employee.

Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>General safety</td>
<td>“General safety information” on page 2</td>
</tr>
<tr>
<td>Stopping the BenchCel Workstation in an emergency</td>
<td>“Emergency stops” on page 4</td>
</tr>
<tr>
<td>Locations of hardware components</td>
<td>“Hardware overview” on page 14</td>
</tr>
<tr>
<td>Site laboratory requirements</td>
<td>“Verifying laboratory requirements” on page 35</td>
</tr>
<tr>
<td>Reporting problems with the BenchCel Workstation</td>
<td>“Reporting problems” on page 148</td>
</tr>
</tbody>
</table>
2

Introduction to BenchCel Workstation

This chapter contains the following topics:

- “BenchCel Workstation description” on page 12
- “Hardware overview” on page 14
- “Accessories” on page 23
- “Integration options” on page 25
- “Labware considerations” on page 26
- “Software description” on page 28
BenchCel Workstation description

About this topic

This topic describes the BenchCel Microplate Handling Workstation R-Series (BenchCel Workstation) and explains its uses.

Description

The BenchCel Workstation is a microplate-processing automation system that:

- Stores stacks of labware (microplates, tip boxes, and tube racks) that will be processed during a protocol run.
- Moves labware to and from external devices such as the PlateLoc Thermal Microplate Sealer and the Microplate Barcode Labeler for processing.

Components

The BenchCel Workstation consists of the following components:

- BenchCel device
- Stacker head for 2, 4, or 6 stacks depending on model
- Labware rack for each stacker head
- Safety shield
- Operating software (VWorks software)
- Computer
- Robot-disable pendant
- Utility connections
**Figure** BenchCel Workstation with safety shield and two labware racks

---

**Related information**

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware overview</td>
<td>“Hardware overview” on page 14</td>
</tr>
<tr>
<td>Accessories</td>
<td>“Accessories” on page 23</td>
</tr>
<tr>
<td>Integration options</td>
<td>“Integration options” on page 25</td>
</tr>
<tr>
<td>Automation-ready labware</td>
<td>“Labware considerations” on page 26</td>
</tr>
<tr>
<td>Software that controls the BenchCel Workstation</td>
<td>“Software description” on page 28</td>
</tr>
<tr>
<td>Safety information</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Installation requirements</td>
<td>“Verifying laboratory requirements” on page 35</td>
</tr>
</tbody>
</table>
2  Introduction to BenchCel Workstation

Hardware overview

About this topic

This topic describes the hardware features of the BenchCel device. Note that the figures in this topic show a BenchCel device with two labware racks only. All the major components and functions are the same for devices with four and six labware racks.

**WARNING**  Do not operate the BenchCel Workstation without the safety shield. Doing so increases the risk of injury.

Front view

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labware rack</td>
<td>The accessory that stores labware to be processed in a run.</td>
</tr>
</tbody>
</table>
### Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| Stacker head     | The structure at which:  
|                  | - A labware rack is loaded. Two sensors inside of each stacker head detect the presence of the racks.  
|                  | - A microplate is checked for type and orientation using a plate-presence sensor and four plate-orientation sensors.  
|                  | - A microplate is lowered into the stacker grippers to begin a run.  
|                  | See “Stacker head” on page 18 for the location and detailed descriptions of the sensors. |
| Safety shield    | The clear panel that is installed on the front of the BenchCel device to prevent access while it is in operation. |
| Rack-release button | The button that unlocks the rack for removal. The rack-release button at the top of each stacker head displays different colors to indicate the state of the stacker head:  
|                  | - **Green.** The labware rack is installed correctly on the BenchCel device and the microplates are unloaded. The stack of microplates are ready for processing or you can unlock and remove the labware rack.  
|                  | - **Flashing green.** The labware rack is unlocked and can be removed.  
|                  | - **Blue.** The stack of microplates is loaded. You cannot unlock and remove the labware rack.  
|                  | - **Red.** The clamps are open without a rack installed. Do not install a rack until the clamps are closed. |
| Robot head       | The component that moves horizontally along the $x$-axis and vertically along the $z$-axis. |
## Introduction to BenchCel Workstation

### Hardware overview

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Robot arms</td>
<td>Two parallel structures that are attached to and rotate about the robot head along the \textit{theta}-axis.</td>
</tr>
<tr>
<td>Robot grippers</td>
<td>The structures inside the robot arms that close and open to hold and release a microplate. Using the provided software, you can adjust the distance between the grippers to hold a microplate loosely or tightly.</td>
</tr>
<tr>
<td>Air pressure regulator</td>
<td>The knob that you turn to adjust the air pressure inside the device. Compressed air is used to move components inside the stacker heads. Each regulator controls the air pressure to the two adjacent stacker heads. For details, see “Adjusting the stacker gripper pressure” on page 144.</td>
</tr>
<tr>
<td>Pendant</td>
<td>The component that is part of the safety interlock circuit, which must be closed for the BenchCel device to operate. Pressing the raised button on the pendant interrupts the safety circuit and disables the robot motors. Use this method of stopping the robot for emergencies only.</td>
</tr>
</tbody>
</table>
# Back view

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air-input fitting</td>
<td>Connects the air tubing to the BenchCel device. Compressed air is used to actuate components inside the stacker head.</td>
</tr>
<tr>
<td>Power switch</td>
<td>Turns on or off the power to the BenchCel device.</td>
</tr>
<tr>
<td>AC power entry</td>
<td>Connects the power cord to the BenchCel device.</td>
</tr>
<tr>
<td>Ethernet port</td>
<td>Connects the Ethernet cable from the controlling computer to the BenchCel device to allow communication between the computer and the device. Use this port as an alternative to the serial connection.</td>
</tr>
<tr>
<td>Serial port</td>
<td>Connects the serial cable from the controlling computer to the BenchCel device to allow communication between the computer and the device. Use this port as an alternative to the Ethernet connection.</td>
</tr>
<tr>
<td>Pendant port</td>
<td>Connects the pendant to the safety interlock circuit.</td>
</tr>
</tbody>
</table>
Stacker head

At the top of the BenchCel device are stacker heads that contain infrared sensors and mechanical components that load and unload microplates during operation.

The following table lists and describes the various components inside the stacker head.
### Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate-presence sensor</td>
<td>Detects the presence of a microplate in the stack. One plate-presence sensor is on the back wall of each stacker head.</td>
</tr>
<tr>
<td>Rack-presence sensors</td>
<td>Detect the presence of labware racks. Two rack sensors are on the back wall of each stacker head.</td>
</tr>
</tbody>
</table>
### Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate-orientation sensors</td>
<td>Detect the presence of notches in microplates. Four sensors are in the inside corners of each stacker head. For details of how the sensors work, see “Setting sensor thresholds” on page 85.</td>
</tr>
</tbody>
</table>

![Plate-orientation sensor](image1)

<table>
<thead>
<tr>
<th>Clamps</th>
<th>Close and open the grippers at the bottom of the labware rack to hold and release microplates during loading, unloading, downstacking, and upstacking processes. Two clamps are inside each stacker head. Compressed air is used to open and close the clamps.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image2" alt="Clamps" /></td>
<td></td>
</tr>
</tbody>
</table>
### Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shelves</td>
<td>Provide leveling surfaces for the microplates, thus ensuring accurate robot gripping, during the downstacking process. Two shelves (four leveling surfaces) are inside each stacker head. Compressed air is used to move the shelves.</td>
</tr>
</tbody>
</table>

![Shelves Diagram](image)
Labware racks

The labware racks are available in three models: standard rack, top-load rack, and front-load rack. All the rack models have the following basic parts.

**Figure** Standard rack containing labware

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Carrying handle</td>
<td>The standard rack has a polished top bar that can be used as a carrying handle. The top-load and front-load racks have fold-down carrying handles.</td>
</tr>
<tr>
<td>2</td>
<td>Tabs</td>
<td>A pair of vertical tabs are located at the bottom on the rack sides. The tabs insert into slots on the device when you mount the rack onto the device.</td>
</tr>
<tr>
<td>3</td>
<td>Stacker grippers (not shown)</td>
<td>A gripper is located on the interior bottom of each tab. The pair of grippers hold a microplate during the labware loading, unloading, downstacking, and upstacking processes. A clamp in the device opens and closes the grippers.</td>
</tr>
</tbody>
</table>

The following figure shows a closeup view of a labware rack, with the stacker grippers holding a microplate. The front wall of the rack is not shown to reveal the stacker grippers that are hidden from view.
Accessories provide a function without performing tasks themselves. For example, you can temporarily place a microplate on a platepad accessory. This topic lists the accessories that are compatible with the BenchCel Workstation.

Compatible accessories

The following table lists some accessories available for the BenchCel Workstation. For the latest list of accessories, contact Automation Solutions Customer Service.
## Accessories

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labware racks</td>
<td>The structures that store labware, such as microplates, to be processed in a run.</td>
</tr>
<tr>
<td></td>
<td>In addition to the standard racks that are supplied with the BenchCel Workstation, you can order additional racks, including unique racks for microtube plates and racks that offer alternative ways to load microplates.</td>
</tr>
<tr>
<td>Laptop computer</td>
<td>The computer that has a smaller footprint than the standard desktop computer for use with the BenchCel Workstation.</td>
</tr>
<tr>
<td>Platepad</td>
<td>A parking place for a microplate.</td>
</tr>
<tr>
<td>Plate hotel</td>
<td>A set of shelves that can be accessed by the BenchCel robot.</td>
</tr>
<tr>
<td>Barcode reader</td>
<td>The barcode reader assembly that can be attached to the side of the Microplate Labeler. The assembly consists of a platepad with a barcode reader sensor head attached.</td>
</tr>
<tr>
<td>Integration hardware</td>
<td>A set of metal plates, risers, and brackets that enable the mounting of an Automation Solutions or a third-party device. The base contains built-in clamps that lock the adjacent integration plate and mounted device in position for maintaining teachpoints.</td>
</tr>
<tr>
<td></td>
<td>Integration kits for third-party devices are designed with features required for specific models of the third-party device. For compatibility info contact Automation Solutions Customer Service.</td>
</tr>
</tbody>
</table>

## Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration options</td>
<td>“Integration options” on page 25</td>
</tr>
<tr>
<td>Automation-ready labware</td>
<td>“Labware considerations” on page 26</td>
</tr>
<tr>
<td>Safety information</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Installation requirements</td>
<td>“Verifying laboratory requirements” on page 35</td>
</tr>
</tbody>
</table>
Integration options

About this topic

You can integrate Automation Solutions devices and some third-party devices with the BenchCel device to create a BenchCel Workstation. The BenchCel robot can move microplates to and from these devices as specified by the protocol you create.

This topic lists some of the devices that can be integrated in the BenchCel Workstation.

Automation Solutions devices

You can integrate other Automation Solutions devices in the BenchCel Workstation as the following figure shows.

*Figure* BenchCel Workstation with examples of integrated devices

The following Automation Solutions devices can be integrated with the BenchCel Workstation.

<table>
<thead>
<tr>
<th>Device</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PlateLoc Thermal Microplate Sealer</td>
<td>Applies seal on microplates.</td>
</tr>
<tr>
<td>Microplate Barcode Labeler</td>
<td>Prints barcodes and applies the barcode labels to microplates.</td>
</tr>
</tbody>
</table>
Third-party devices

A variety of third-party devices can be integrated in the BenchCel Workstation. For the complete list of compatible devices and the device integration requirements, contact Automation Solutions Customer Service.

Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>BenchCel Workstation features</td>
<td>“Hardware overview” on page 14</td>
</tr>
<tr>
<td>Safety information</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Installation requirements</td>
<td>“Installing BenchCel Workstation” on page 33</td>
</tr>
</tbody>
</table>

Labware considerations

About this topic

This topic provides guidelines for selecting automation-ready labware for use in the BenchCel Workstation.

Acceptable microplates

The BenchCel device is designed to handle labware that meet the American National Standards Institute (ANSI) standards. For the latest labware standards, go to www.sbsonline.org. You can also contact the labware manufacturer to inquire about ANSI-compliant labware. For use of nonconforming labware, please contact Automation Solutions Technical Support.

The BenchCel device uses gripping mechanisms to hold microplates securely and repeatably in the labware rack and in the robot arms. The BenchCel device typically holds the microplates halfway between the top of the microplate and the top of the microplate skirt (5 to 10 mm above the bottom of the microplate).

In the following figure, notice the gripper-microplate contact point.
Labware considerations

**Figure**  Labware rack closeup view showing microplate held by the stacker grippers

---

**Lidded microplates**

Microplates that do not have lids or have shallow lids (lids that do not reach the microplate skirt) provide enough clearance to allow secure and repeatable gripping. Microplates with deeper lids can be more challenging, because the microplate must be held by the skirt. If the skirt is too flexible, the stacker grippers will bend the skirt. The bent skirt can grip the microplate lid stacked beneath, inadvertently removing the lid.

*Note:* Some labware vendors might offer alternative lids that are shallower. Contact the vendor for details.

---

**Figure**  Lidded microplate examples

- No lid: excellent gripper clearance
- Shallow lid: good gripper clearance
- Deep lid: no gripper clearance, must be held by the skirt

---

**Challenging microplate characteristics**

Microplates that have the following characteristics might require additional setup time to ensure repeatable performance for the BenchCel device:

- **Microplate material.** Although you can adjust the robot grip distance to compensate for a microplate’s flexibility, some microplates are too soft and tend to bend in the robot grippers or become warped after thermal cycling. (for example, low-profile polypropylene PCR microplates).

- **Manufacturing variance.** Gross variations in microplate dimensions can reduce repeatability of secure gripping. In addition, because the BenchCel device uses reflected light to sense microplate presence and orientation, variations in the reflective properties of the microplates can affect optimal operation.

- **Microplate design.** Some microplates have special features specifically designed for particular instruments but are not optimized for the BenchCel device.
Thermal cycling effects. Microplates that have been through thermal cycling might become warped.

Tall labware. Especially tall tube racks and tipboxes that are taller than 65 mm might pose challenges in the BenchCel device. Contact Automation Solutions Technical Support about acceptable tall labware.

Extra long lid. Some microplates that have lids that extend past the microplate skirt tend to pose challenges for the BenchCel device. Contact Automation Solutions Technical Support for guidance.

Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defining labware in the software</td>
<td>VWorks Automation Control Setup Guide</td>
</tr>
<tr>
<td>Location of plate-orientation sensors</td>
<td>“Stacker head” on page 18</td>
</tr>
<tr>
<td>How the plate-orientation sensors work</td>
<td>“Setting sensor thresholds” on page 85</td>
</tr>
<tr>
<td>BenchCel Workstation features</td>
<td>“Hardware overview” on page 14</td>
</tr>
<tr>
<td>Safety information</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Installation requirements</td>
<td>&quot;Installing BenchCel Workstation” on page 33</td>
</tr>
</tbody>
</table>

Software description

About this topic

This topic describes the software you use to set up, control, and troubleshoot the BenchCel Workstation.

VWorks software

The VWorks software enables you to:

- Set up the BenchCel Workstation. During setup, you create device files for the BenchCel device and external devices.

- Set up user accounts and privileges. You can set up different user accounts to enforce access policies. For instructions, see the VWorks Automation Control Setup Guide.

- Define labware. Labware definitions describe the labware you will use during protocol runs. For instructions, see the VWorks Automation Control Setup Guide.
• **Create protocols.** Protocols determine the sequence of tasks you want to automate in a run. For example, you can use a protocol to apply barcode labels to 100 microplates. For protocol-writing instructions, see the *VWorks Automation Control User Guide*.

• **Run, pause, monitor, and stop protocols.** You can start, pause, monitor, and stop a protocol run from the controlling computer. For details, see the *VWorks Automation Control User Guide*.

**Figure**  VWorks software window

---

**BenchCel ActiveX control**

Included with the VWorks software is the BenchCel ActiveX control that enables the BenchCel device to interact with any Automation Solutions or third-party lab automation system.

**BenchCel Diagnostics software**

Accessed through the VWorks software, BenchCel Diagnostics enables you to:

• **Create and manage profiles.** The software uses the information in the profile to communicate between the BenchCel device and the controlling computer. You create profiles using the BenchCel Diagnostics Profiles tab when you set up the BenchCel Workstation.
• **Set and edit teachpoints.** Teachpoints are locations that the BenchCel robot will go to and from during a protocol run. You set teachpoints using the BenchCel Diagnostics Controls tab when you set up the BenchCel Workstation.

**Figure** BenchCel Diagnostics Controls tab

• **Diagnose problems.** You can use the Jog/Teach tab on the BenchCel Diagnostics Controls page to move and adjust individual hardware components. These controls are useful for diagnosing and troubleshooting problems.

**Figure** BenchCel Diagnostics Jog/Teach tab
While testing new or troubleshooting labware definitions, you can change parameters to refine the labware definition. BenchCel Diagnostics includes a Labware tab on the Controls page, which enables you to adjust the labware definitions. Alternatively, you can use the Labware Editor to update the labware definitions.

**Figure**  BenchCel Diagnostics Labware tab

- **Change general device settings.** After diagnosing problems, you can change some of the device settings to repair problems or to optimize operation.

**Figure**  BenchCel Diagnostics General Settings tab

## Related information

For more information about...  
VWorks software instructions  See...  *VWorks Automation Control User Guide*
Software installation instructions  *VWorks Automation Control Setup Guide*
Setting up the workstation, including creating profiles and setting teachpoints  “Setup Workflow” on page 58
Using BenchCel Diagnostics to troubleshoot problems  “Diagnostic tools” on page 132
<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>BenchCel ActiveX control</td>
<td>“BenchCel ActiveX control” on page 151</td>
</tr>
</tbody>
</table>
3

Installing BenchCel Workstation

This chapter describes how to unpack and set up the BenchCel Workstation. All of the procedures in this chapter can be performed by someone with operator privileges.

This chapter contains the following topics:
- “Installation workflow” on page 34
- “Verifying laboratory requirements” on page 35
- “Unpacking the BenchCel Workstation” on page 39
- “Mounting the robot on the BenchCel device” on page 41
- “Integrating the devices” on page 43
- “Connecting the power source” on page 46
- “Connecting the pendant” on page 48
- “Connecting and disconnecting the air source” on page 50
- “Connecting the computer” on page 52
- “Installing the safety shield” on page 55
Installation workflow

About this topic

This topic presents the workflow for unpacking and installing the BenchCel Workstation.

Workflow

The following table presents the steps for unpacking and installing the BenchCel Workstation.

<table>
<thead>
<tr>
<th>Step</th>
<th>For this task...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that the installation location meets the site requirements.</td>
<td>“Verifying laboratory requirements” on page 35</td>
</tr>
<tr>
<td>2</td>
<td>Unpack the BenchCel device and mount the robot.</td>
<td>“Unpacking the BenchCel Workstation” on page 39</td>
</tr>
<tr>
<td>3</td>
<td>Integrate external devices.</td>
<td>“Integrating the devices” on page 43</td>
</tr>
<tr>
<td>4</td>
<td>Connect the power.</td>
<td>“Connecting the power source” on page 46</td>
</tr>
<tr>
<td>5</td>
<td>Connect the pendant.</td>
<td>“Connecting the pendant” on page 48</td>
</tr>
<tr>
<td>6</td>
<td>Connect the air supply.</td>
<td>“Connecting and disconnecting the air source” on page 50</td>
</tr>
<tr>
<td>7</td>
<td>Connect the computer.</td>
<td>“Connecting the computer” on page 52</td>
</tr>
<tr>
<td>8</td>
<td>Install the safety shield.</td>
<td>“Installing the safety shield” on page 55</td>
</tr>
<tr>
<td>9</td>
<td>Install the VWorks software.</td>
<td>VWorks Automation Control Setup Guide</td>
</tr>
</tbody>
</table>

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing external devices</td>
<td>External device user documentation</td>
</tr>
<tr>
<td>Setting up the BenchCel Workstation</td>
<td>“Setting up BenchCel Workstation” on page 57</td>
</tr>
<tr>
<td>Defining labware, liquids, and pipetting techniques</td>
<td>VWorks Automation Control Setup Guide</td>
</tr>
</tbody>
</table>
Verifying laboratory requirements

Laboratory space

General bench requirements
Make sure the bench for the BenchCel Workstation has the following:

- Proximity to power and air sources
- Enough space to accommodate the complete configuration of your BenchCel Workstation, which includes the number and size of the labware racks, computer, and external devices
- Sufficient clearance on the back side of the BenchCel Workstation to access power, communication, and air tubing connections
- Enough strength to support the BenchCel Workstation, including integrated devices, without excessive shaking or movement
- A level surface and a fixed position (no wheels)
- Proper height for any operator to comfortably operate the BenchCel Workstation

Space requirements
The minimum space requirements for your BenchCel device depends on its configuration and labware rack size. The following table lists dimensions for a BenchCel device in a two-, four-, or six-stack configuration.

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Two stacks</th>
<th>Four stacks</th>
<th>Six stacks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>46.3 cm</td>
<td>46.3 cm</td>
<td>46.3 cm</td>
</tr>
<tr>
<td>with x-short rack</td>
<td>68.0 cm</td>
<td>68.0 cm</td>
<td>68.0 cm</td>
</tr>
<tr>
<td>with short rack</td>
<td>88.3 cm</td>
<td>88.3 cm</td>
<td>88.3 cm</td>
</tr>
<tr>
<td>with medium rack</td>
<td>111.2 cm</td>
<td>111.2 cm</td>
<td>111.2 cm</td>
</tr>
<tr>
<td>with tall rack</td>
<td>128.9 cm</td>
<td>128.9 cm</td>
<td>128.9 cm</td>
</tr>
<tr>
<td>Width</td>
<td>43.2 cm</td>
<td>86.4 cm</td>
<td>129.5 cm</td>
</tr>
<tr>
<td>Depth</td>
<td>20.3 cm</td>
<td>20.3 cm</td>
<td>20.3 cm</td>
</tr>
<tr>
<td>Weight</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>without rack</td>
<td>21.8 kg</td>
<td>28.1 kg</td>
<td>32.7 kg</td>
</tr>
<tr>
<td>with tallest rack</td>
<td>25.2 kg</td>
<td>38.7 kg</td>
<td>52.2 kg</td>
</tr>
</tbody>
</table>
**Note:** The racks listed are the standard racks supplied with the system. In addition, the weight of the rack is of the rack alone and does not include liquid-filled microplates. The height and weight are slightly different with different rack types. See the Automation Solutions pages on the Agilent Technologies website at [www.agilent.com](http://www.agilent.com) for the height and weight information of various rack types.

**Addition of devices**

If you are integrating an Automation Solutions device or third-party device in your BenchCel Workstation, make sure you include adequate space to accommodate these devices. See the device user documentation for space requirement information.

**Electrical requirements**

The BenchCel device has the following power requirements. For power requirements of other devices in the workstation, see the device user documentation.

<table>
<thead>
<tr>
<th>Utility</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical</td>
<td>100–240~, 50/60 Hz, 5 A</td>
</tr>
<tr>
<td>Fuse</td>
<td>5 A, 250 V, 5 × 20 mm, fast acting</td>
</tr>
</tbody>
</table>

**Compressed air requirements**

The BenchCel device requires the use of clean, dry, compressed air to move pneumatic components inside the device. The compressed air can be from the following sources:

- Centralized source (house)
- Compressed-air cylinders
- Portable pumps

**CAUTION** Using oil compressors can cause oil to leak into the BenchCel device and void your warranty.

**CAUTION** Air pressure greater than 0.69 MPa (100 psi) can damage the BenchCel device

To maintain the desired air supply in the device, the BenchCel device requires a source of air as follows:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality</td>
<td>Clean, dry, compressed</td>
</tr>
<tr>
<td>Flow rate</td>
<td>34.0 Lpm (1.2 cfm)</td>
</tr>
<tr>
<td>Pressure</td>
<td>0.65–0.69 MPa (95–100 psi)</td>
</tr>
</tbody>
</table>
Environmental requirements

The lab must meet the following environmental requirements.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient temperature</td>
<td>5–40 °C</td>
</tr>
<tr>
<td>Humidity condition</td>
<td>10–90% RH, non-condensing</td>
</tr>
<tr>
<td>Elevation</td>
<td>1–2000 m</td>
</tr>
</tbody>
</table>

Make sure the BenchCel Workstation is located away from the following:
- Heat and air conditioning ducts.
- Direct sunlight.

Computer requirements

The BenchCel device is shipped with a computer that controls the BenchCel Workstation operations. The computer has all the necessary software and is configured to operate the BenchCel Workstation.

**IMPORTANT** Agilent Technologies recommends that you use the supplied computer, because it is set up and tested for BenchCel Workstation operations.

If your organization uses a computer other than one configured by Agilent Technologies, make sure the computer meets the following minimum requirements:
- **Computer system**
  - Microsoft Windows XP with Service Pack 3 or Microsoft Windows Vista with Service Pack 1
  - 2 GHz or faster 32-bit (x86) processor, multicore preferred
  - 2 GB system memory
  - 40 GB hard drive capacity with 10 GB free space
  - 1280 x 1024 pixel screen resolution
  - Microsoft Internet Explorer 6.0 or Mozilla Firefox 1.0 with JavaScript enabled (required for using the context-sensitive help and knowledge base)
  - A PDF viewer, such as Adobe Reader (required for opening the user guide PDF files)
- **Communications interface using one of the following:**
  - Dedicated 10BaseT or faster Ethernet card (two network cards if connecting to your local area network)
  - RS-232 DB9 serial port, if you are connecting via serial

To facilitate the setup process, a software installation CD is supplied. You can use the CD to install the necessary software and setup configurations.
Networking considerations

The supplied computer comes with a serial port and two Ethernet ports. You can connect the computer to the BenchCel device using either the serial port or one of the Ethernet ports. You can use the second Ethernet port to connect the computer to your local area network (LAN). You must provide an Ethernet cable for the LAN connection and make sure the lab has the proper network hookups for the connection.

If you are supplying your own computer, consider whether you will:

- Connect the computer to the BenchCel device using a serial or Ethernet connection.
- Connect the computer to your LAN.

**WARNING** Connecting the BenchCel Workstation to a company or general network can potentially cause injury. Remote computer operators might accidently initiate an operation that causes the robot to move unexpectedly, possibly injuring nearby lab personnel.

If you plan to connect the computer to the BenchCel device and to your company’s LAN, the computer might require two Ethernet cards. Two Ethernet cards allow the BenchCel Workstation to operate on an isolated network.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab requirements for external devices</td>
<td>External device user documentation</td>
</tr>
<tr>
<td>Contacting technical support</td>
<td>“Reporting problems” on page 148</td>
</tr>
<tr>
<td>Installing the BenchCel Workstation</td>
<td>“Installation workflow” on page 34</td>
</tr>
<tr>
<td></td>
<td>“Connecting the power source” on page 46</td>
</tr>
<tr>
<td></td>
<td>“Connecting the pendant” on page 48</td>
</tr>
<tr>
<td></td>
<td>“Connecting and disconnecting the air source” on page 50</td>
</tr>
<tr>
<td></td>
<td>“Connecting the computer” on page 52</td>
</tr>
<tr>
<td></td>
<td>“Installing the safety shield” on page 55</td>
</tr>
</tbody>
</table>
Unpacking the BenchCel Workstation

About this topic

This topic describes how to unpack the BenchCel Workstation from the shipping containers.

Shipping containers

The shipping containers include:

- BenchCel crate containing the BenchCel device.
- Peripherals box containing the following packages:
  - BenchCel utility kit
  - Pendant
  - BenchCel robot
  - Safety shield with hardware
  - Labware racks
- Computer box

Depending on the configuration ordered, additional packages or items can be included, such as accessories.

Before you start

Verify the following:

1. **BenchCel utility kit contents.** At a minimum, the kit contains the following:
   - Power cord
   - Serial and Ethernet cables, and Ethernet switch
   - Tubing for air line
   - Software CD-ROM
   - BenchCel Microplate Handling Workstation User Guide

2. **Site specifications.** Ensure the installation site meets the requirements. See “Verifying laboratory requirements” on page 35.

   Note the dimensions of the shipping container before moving it to make sure you have adequate clearance through doorways and passages.

3. **Tools and equipment requirements.** Obtain the following:
   - Large screwdriver to open the shipping crate
   - Hex wrenches: 5-mm and 2-mm for mounting the robot head
   - Cart for moving the BenchCel device

4. **Personnel requirements.** Make sure two people are available to lift the BenchCel device from the crate.

**WARNING** Use care when lifting the BenchCel device to prevent personal injury and damage to the device. Depending on the configuration, the BenchCel device weighs 21.8 kg (48.1 lb) to 32.7 kg (72.1 lb) and requires two people to lift it.
Procedure

**CAUTION** The packing materials and shipping container were designed to protect the device. Packing the BenchCel device using other materials might damage the device and void your warranty. Save the packing materials and shipping container in case you are required to move or ship the BenchCel device.

**To unpack the BenchCel Workstation:**

1. Use a large screwdriver to open the BenchCel device shipping container.
2. Lift the contents out of the container and set each item carefully on the lab bench or final location where you want to install the device.
3. Remove the packing foam from the device.
4. Remove components from the plastic bags or other packing material.
5. Inspect the unpacked items.
Mounting the robot on the BenchCel device

About this topic

This topic describes how to mount the robot on the BenchCel device.

Procedure

CAUTION   Handle the robot carefully. Do not use the robot arms to lift the robot. Doing so could damage the arms. Dropping or bumping the robot can damage the electronics.

To mount the robot on the BenchCel device:

1. On the BenchCel device, remove the two large black screws that prevent the \(x\)-axis carriage from moving during shipping.

2. Use a 5-mm hex wrench to remove the four screws that secure the shipping bracket to the \(x\)-axis carriage. Carefully lift the shipping bracket straight up, ensuring that you do not scratch the electronics.

3. Slide the \(x\)-axis carriage into position directly under a stacker head opening.

4. Inspect the \(x\)-axis carriage and ensure any cables are recessed. Carefully, lower the robot onto the \(x\)-axis carriage, aligning the two holes on the robot \(z\)-column bottom with the alignment pins on the \(x\)-axis carriage.

5. Gently slide the robot downwards. When the robot is in position, push down on it to ensure the electronics are fully connected.

6. Gently rotate the robot arms to one side to expose the two screw holes on the robot base. Insert the two 35-mm M6 screws and tighten to secure the robot to the base.
7 Lift the robot head from the base to expose the remaining two screw holes in the base. While firmly supporting the robot head, install the two 45-mm M6 screws to finish securing the robot base to the x-axis carriage.

8 Gently lower the robot head onto the base.

9 To secure the front panel to the robot base, use a 2-mm hex wrench to install the two screws.

Figure BenchCel robot with rotated arms to expose screw holes in the base

Figure BenchCel robot with head lifted up from base to expose mounting screws
After you unpack the system components, you can arrange the BenchCel device and external devices on the benchtop in preparation for integration. The layout and integration procedures can vary, depending on the combination of devices you are integrating and the desired configuration. Simple configurations might include one external device and the installation and alignment of basic integrations plates under the devices. Complex configurations might include several devices and require custom tables, custom integration plates, plate stage modifications, and so on.

This topic provides basic integration concepts: how integration plates are used and how to adjust device positions.

**IMPORTANT** Always contact Automation Solutions Customer Support when you want to integrate a new device.

**Before you start**

Make sure you have the following:

- The external devices you want to integrate
- Two integration plates for the BenchCel device
- Integration plate for each external device
- 4-mm hex wrench
- 3-mm hex wrench
Installing the BenchCel device integration plate

The BenchCel device integration plates have locking mechanisms that keep the BenchCel device and any external device in position during a run. The integration plates must be installed under the BenchCel device.

To install the BenchCel device integration plate:
1. Position the integration plates on the benchtop.
2. If risers are required in the integration, install the risers on the integration plates.
3. Place the BenchCel device on the integration plates or risers.
4. Tighten the screws to secure the device on the integration plates.

Installing the external device integration plate

You can integrate an external device on the left or right side of the BenchCel device. For each external device, you must install the integration plate that is specific to that device.

To install the external device and integration plate:
1. Depending on whether you are integrating a device to the left or right of the BenchCel device, loosen the left or right clamp screw using the 3-mm hex wrench. See the following figure.
   As you loosen the screw, the left or right clamp opens.

   Figure  Clamp screw (left side) on BenchCel device

2. Mount the external device on its integration plate. Tighten the bolts or screws to secure the device on the integration plate.
3. Place the external device and integration plate next to the BenchCel device.
4 Use the 3-mm hex wrench to slightly tighten the BenchCel device integration plate clamp screw. You will not tighten the screw all the way until the devices are correctly aligned.

5 Visually inspect the position of the integrated device relative to the BenchCel device. The two devices should be aligned along the $y$-axis (front-to-back direction) so that the BenchCel robot can place a microplate on the plate stage accurately. If the devices are not properly aligned, slide the devices along the $y$-axis until they appear to be correctly aligned.
Connecting the power source

About this topic

This topic explains how to connect the BenchCel Workstation to a grounded power source.

Before you start

Make sure you have the supplied power cord.

**WARNING** Ensure that the power cords are in good condition and are not frayed. Use of frayed or damaged power cords can cause injury. Use of incorrect power cords can cause damage to the device.

Connecting the power source

*To connect the BenchCel Workstation to a grounded power source:*

1. Plug one end of the power cord into the AC power entry located on the back of the BenchCel device.
2. Plug the other end of the cord into an AC outlet with grounded circuit.

**Related information**

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical requirements</td>
<td>“Verifying laboratory requirements” on page 35</td>
</tr>
<tr>
<td>Installing the BenchCel Workstation</td>
<td>“Installation workflow” on page 34</td>
</tr>
<tr>
<td>Setting up the BenchCel Workstation</td>
<td>“Setup Workflow” on page 58</td>
</tr>
<tr>
<td>Operating the BenchCel Workstation</td>
<td>“Workflow for operating the BenchCel Workstation” on page 102</td>
</tr>
</tbody>
</table>
Connecting the pendant

About this topic

Designed to protect you from moving-part hazards while the BenchCel Workstation is in operation, the pendant is part of the safety interlock circuit that must be closed for the BenchCel device to operate. Pressing the raised red button on the pendant interrupts the safety circuit and disables the robot motors.

This topic explain how to connect the pendant to the BenchCel device.

Before you start

Make sure you have the supplied pendant.

*Figure*  Pendant with the red robot-disable button

Connecting the pendant

*To connect the pendant to the BenchCel device:*

Connect the pendant cable to the pendant port on the back of the BenchCel device.
### Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The pendant and its use</td>
<td>“Hardware overview” on page 14</td>
</tr>
<tr>
<td>Electrical requirements</td>
<td>“Verifying laboratory requirements” on page 35</td>
</tr>
<tr>
<td>Safety information</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Installing the BenchCel Workstation</td>
<td>“Installation workflow” on page 34</td>
</tr>
<tr>
<td>Setting up the BenchCel Workstation</td>
<td>“Setup Workflow” on page 58</td>
</tr>
<tr>
<td>Operating the BenchCel Workstation</td>
<td>“Workflow for operating the BenchCel Workstation” on page 102</td>
</tr>
</tbody>
</table>
Connecting and disconnecting the air source

About this topic

Compressed air is used to move parts inside the BenchCel device. This topic explains how to connect the BenchCel device to the air source and check the connections for leaks before use.

Before you start

Make sure you have the supplied air tubing.

**WARNING** Working with open, charged air lines can result in injury. Turn off the compressed air line when disconnecting or reconnecting devices that use compressed air. Contact your facilities department or Automation Solutions Technical Support with questions about setting up the air line.

Connecting the air source

*To connect the BenchCel device to the air source:*

1. Turn off the air at the source (house, cylinder, or pump).
2. Connect one end of the air tubing to the air source (house, cylinder, or pump), and then connect the free end of the tubing to the quick disconnect fitting at the air-input port.

   To connect the tubing, push the end of the tubing into the quick disconnect fitting at the air source and on the back of the BenchCel device.

*Figure* Air tubing connection on the back of the BenchCel device
Checking the air connections

To check the air connections:

1. With the air source turned off, gently tug the air tubing at each connection. If you feel resistance at the connection, the tubing has been properly installed.
2. Turn on the air at the source (house, cylinder, or pump).
3. Listen near each connection for hissing sounds that might indicate a leak. If you hear hissing sounds, turn off the air at the source, check and tighten the connections, and then turn on the air again. If the problem persists, contact your facilities department or Automation Solutions Technical Support.

Disconnecting the air source

Before moving or shipping the BenchCel device and before performing maintenance or cleaning, disconnect the air tubing.

CAUTION Do not pull the tubing out of the orange quick-disconnect fitting. Doing so can damage the fitting.

To disconnect the air tubing from the BenchCel device:

1. Turn off the air at the source (house, cylinder, or pump).
2. Push and hold the locking collar against the fitting, and then gently pull the air tubing out.

Note: Alternatively, you can use the SMC Pneumatics tool (TG-2) to aid in this task. See the manufacturer's documentation for use instructions. Contact your local SMC parts supplier for ordering details.

Figure Quick-disconnect fitting (close-up view)

Push and hold the locking collar.

Gently pull out the tubing.

Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air-source requirements</td>
<td>“Verifying laboratory requirements” on page 35</td>
</tr>
<tr>
<td>How to set up the BenchCel Workstation</td>
<td>“Setup Workflow” on page 58</td>
</tr>
</tbody>
</table>
Connecting the computer

About this topic

This topic explains how to connect the controlling computer to the BenchCel device.

Before you start

Make sure you have the following:
- RS-232 DB9 serial cable or Ethernet cable (supplied)
- Ethernet switch (supplied) for Ethernet connections only

Connecting the controlling computer

You can connect the computer to the BenchCel device in one of the following ways:
- **Serial connection.** You can use the supplied RS-232 DB9 serial cable to connect the computer to the BenchCel device.
- **Ethernet connection.** You can use the supplied Ethernet cable to connect the computer to the BenchCel device. The Automation Solutions configured computer has two Ethernet ports. You can use one port to connect to the BenchCel device and the other to connect to your company network.

To connect the controlling computer to the BenchCel device:

1. Turn off the computer.
2. **Serial connection only.** Do the following:
   a. Connect the female end of the serial cable to a COM port on the controlling computer. Note the number of the COM port. You will provide this number in the software.
   b. Connect the male end of the serial cable to the serial port on the back of the BenchCel device.

For more information about... | See...
--- | ---
How to operate the BenchCel Workstation | “Workflow for operating the BenchCel Workstation” on page 102
3 Installing BenchCel Workstation

Connecting the computer

Figure Serial connector on the BenchCel device (back view)

3 Ethernet connection only. Do the following:

a Connect one end of the Ethernet cable to the back of the BenchCel device.

b Connect the free end of the Ethernet cable to any available port on the Ethernet switch.

Figure Ethernet connector on the BenchCel device (back view)

Configuring the computer network card (Ethernet connection only)

The computer configured by Automation Solutions is already set up to communicate with the BenchCel Workstation. No change to the network card IP address is required.
If you are using a computer that was not configured by Automation Solutions, make sure the value of the network card IP address and subnet mask are as follows:

- IP address: 192.168.0.1
- Subnet mask: 255.255.255.0

**WARNING** Connecting the BenchCel Workstation to a company or general network can potentially cause injury. Remote computer operators might accidentally initiate an operation that causes the robot to move unexpectedly, possibly injuring nearby lab personnel.

If your computer will be connected to your LAN, make sure the computer has a second network card. The second network card can have a dynamic IP address.

### Connecting the computer to external devices (Ethernet connection only)

**To connect the external devices to the controlling computer:**

1. Connect one end of the Ethernet cable to the Ethernet port on the external device. See the device user documentation for details.
2. Connect the free end of the Ethernet cable to any available port on the Ethernet switch.

### Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The controlling computer requirements</td>
<td>“Verifying laboratory requirements” on page 35</td>
</tr>
<tr>
<td>The Ethernet switch</td>
<td>The Ethernet switch user documentation</td>
</tr>
<tr>
<td>IP addresses</td>
<td>The Microsoft Windows user documentation</td>
</tr>
<tr>
<td>Installing the BenchCel Workstation</td>
<td>“Installation workflow” on page 34</td>
</tr>
<tr>
<td>Setting up the BenchCel Workstation</td>
<td>“Setup Workflow” on page 58</td>
</tr>
<tr>
<td>Operating the BenchCel Workstation</td>
<td>“Workflow for operating the BenchCel Workstation” on page 102</td>
</tr>
</tbody>
</table>
Installing the safety shield

About this topic

This topic explains how to install the safety shield on the front of the BenchCel device.

Before you start

Make sure you have the following:

- 3-mm hex wrench
- Low-head M5 screws (supplied)

Procedure

To install the safety shield:

1. Place the safety shield on the front of the BenchCel device. The ledge of the shield should sit on the top of the device.
2. Insert the four M5 screws into the shield.
3. Tighten the screws using the M3 hex wrench.
Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety shield description</td>
<td>“Hardware overview” on page 14</td>
</tr>
<tr>
<td>Safety information</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Installing the BenchCel Workstation</td>
<td>“Installation workflow” on page 34</td>
</tr>
<tr>
<td>Setting up the BenchCel Workstation</td>
<td>“Setup Workflow” on page 58</td>
</tr>
<tr>
<td>Operating the BenchCel Workstation</td>
<td>“Workflow for operating the BenchCel Workstation” on page 102</td>
</tr>
</tbody>
</table>
4 Setting up BenchCel Workstation

This chapter explains how to set up the BenchCel Workstation for operation. This chapter contains the following topics:

- “Setup Workflow” on page 58
- “Starting up and shutting down” on page 60
- “Creating a BenchCel device in the VWorks software” on page 62
- “Opening BenchCel Diagnostics” on page 66
- “Creating profiles” on page 68
- “Setting and managing teachpoints” on page 72
Setup Workflow

About this topic

This topic presents the workflow for setting up the BenchCel Workstation for operation.

Before you begin

Before setting up the BenchCel Workstation, you should already have definitions for the labware you want to use. For instructions on how to define labware in the VWorks software, see the VWorks Automation Control Setup Guide.

Before setting teachpoints (step 7 in the setup workflow), you should also adjust the BenchCel sensor thresholds for each type of labware that you use. For details, see “Setting sensor thresholds” on page 85.

Workflow

The following table presents the steps for setting up the BenchCel Workstation. After setting up the BenchCel Workstation for the first time, you will not likely change any of the settings in the procedure unless you add a device, replace a device, or move the BenchCel Workstation.
### 4 Setting up BenchCel Workstation

#### Setup Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>For this task...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start up the workstation.</td>
<td>“Starting up and shutting down” on page 60</td>
</tr>
<tr>
<td>2</td>
<td>Create a device file and add the BenchCel device in VWorks.</td>
<td>“Creating a BenchCel device in the VWorks software” on page 62</td>
</tr>
<tr>
<td>3</td>
<td>Create a profile.</td>
<td>“Creating profiles” on page 68</td>
</tr>
<tr>
<td>4</td>
<td>Add external devices to the device file.</td>
<td>User documentation for the Automation Solutions device or the Device Driver Guide for third-party devices</td>
</tr>
<tr>
<td>5</td>
<td>Create a profile for each external device.</td>
<td>User documentation for the Automation Solutions device or the Device Driver Guide for third-party devices</td>
</tr>
<tr>
<td>6</td>
<td>Set the sensor thresholds for your labware.</td>
<td>“Setting sensor thresholds” on page 85</td>
</tr>
<tr>
<td>7</td>
<td>Set and edit teachpoints for external devices.</td>
<td>“Setting and managing teachpoints” on page 72</td>
</tr>
<tr>
<td>8</td>
<td>Write protocols.</td>
<td><em>VWorks Automation Control User Guide</em></td>
</tr>
</tbody>
</table>

### Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation procedures</td>
<td>“Installation workflow” on page 34</td>
</tr>
<tr>
<td>Operating the BenchCel Workstation</td>
<td>“Workflow for operating the BenchCel Workstation” on page 102</td>
</tr>
<tr>
<td>Troubleshooting problems</td>
<td>“Maintenance and troubleshooting” on page 115</td>
</tr>
</tbody>
</table>
Starting up and shutting down

About this topic

This topic explains how to start up and shutdown the BenchCel Workstation.

Starting up the BenchCel Workstation

WARNING  Do not touch the BenchCel Workstation as you start the software. The robot head moves when the device initializes.

To start up the BenchCel Workstation:

1  Turn on the BenchCel device. To do this, on the back of the device, press the power switch to the on (I) position.

   Figure  Power switch on the BenchCel device (back)

   Press to turn on.

Every time you turn on the BenchCel device, the robot homes (the robot is sent to the factory-defined home position for each axis of motion). If the BenchCel robot does not home, make sure power to the robot has been restored. (See “Recovering from an emergency stop” on page 4 to reset the Robot Disable button.) If the button has been reset and the robot still does not home, turn off the device, check the connections, and turn it on again.

2  Turn on all other devices integrated in the BenchCel Workstation. See the device user documentation for instructions.

3  Turn on the compressed air supply to the BenchCel device.

4  Turn on the controlling computer. See the user documentation from the computer manufacturer.

5  Start the VWorks software. To do this, on the Windows desktop, double-click the VWorks shortcut icon. Alternatively, choose Start > All Programs > Agilent Technologies > VWorks > VWorks.
Shutting down the BenchCel Workstation

Shut down the BenchCel Workstation if you intend to:
- Leave it unused for a long period of time.
- Service the device.
- Move it to another location.

To shut down the BenchCel Workstation:
1. Follow the post-run clean-up procedure after the last protocol run. See “Cleaning up after a protocol run” on page 118.
2. Exit the VWorks software.
3. If you use devices that require a vacuum pump, turn off power at the pump if the pump module has an on/off switch.
4. Turn off the compressed air to the BenchCel device and other devices.
5. Turn off the BenchCel device. To do this, on the back of the device, press the power switch to the off (O) position.

Figure  Power switch on the BenchCel device (back)

6. Turn off other devices in the BenchCel Workstation.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up the BenchCel Workstation</td>
<td>“Setup Workflow” on page 58</td>
</tr>
<tr>
<td>Cleaning up after a protocol run</td>
<td>“Cleaning up after a protocol run” on page 118</td>
</tr>
<tr>
<td>Troubleshooting startup or shutdown problems</td>
<td>“Maintenance and troubleshooting” on page 115</td>
</tr>
</tbody>
</table>
Creating a BenchCel device in the VWorks software

About this topic

Read this topic if you are an administrator responsible for managing Agilent Technologies devices that are running the VWorks software. This topic describes how to add and delete new BenchCel devices in the VWorks software.

The VWorks software uses the information in a device file to communicate with and operate devices within the lab automation system.

- If your computer was configured by Automation Solutions. The correct device configuration is already set up for communication with the BenchCel Workstation. You are not required to create a new BenchCel device in the software unless you want to reference different profiles, integrate additional devices with the workstation, or change the rack size. To establish communication, you must initialize the device.

- If you configured your own computer. You must add a device in the VWorks software for the BenchCel Workstation. You must also add devices in the software for any devices that are physically integrated with the workstation.

For detailed information about device files and associations with profiles, teachpoints, and labware definitions, see the VWorks Automation Control User Guide. For instructions on how to add third-party devices, see the Device Driver User Guide.

Devices and device files defined

A device is an item in your lab automation system that has an entry in a VWorks software device file. A device can be a robot, an instrument, or a location in a lab automation system that can hold a piece of labware.

The device file (*.dev) stores information for all the devices in an integrated system, including:

- Type of device (for example, BenchCel device)
- Device configuration information (for example, approach height, allowed or prohibited labware, and so on)
- Profile to use

Creating a device file

If you are setting up the BenchCel Workstation for the first time, you will create a device file. You add the BenchCel device and the external devices to the device file.

To create a device file:

1. Log in to the VWorks software as an Administrator.
2. In the VWorks window, choose File > New > Device.
   A Device File tab appears in the VWorks window.
3. Choose File > Save. In the Save As dialog box, type a file name (*.dev), and click Save. By default the file is located in the following folder:
Adding the BenchCel Workstation to a device file

Before you begin:
- Ensure that any devices are physically networked to the computer.
- Turn on the devices.

To add devices to a device file:
1. In the **VWorks** window, verify that the correct device file is open.
   
   To open a device file, choose **File > Open**. In the **Open** dialog box, select your device file (*.dev), and then click **Open**. By default, the file is in the following location:
   
   C:\VWorks Workspace\Device Files

2. In the **Available Devices** area, double-click the **BenchCel** icon. Or, drag the **BenchCel** icon to the **Device File** tab.

   **Note:** To show or hide the list of available devices, choose **View > Available Devices**.
3 In the **Device File** tab, select the **BenchCel-n** icon.

4 Under **BenchCel Properties**, type a **Name** for the device. By default, the software assigns BenchCel-n, and increments the number for each BenchCel device that you add.

To identify the specific BenchCel, the device name should include the device serial number.

5 In the **Profile** list, select a profile for the device.

If the **Profile** list is empty, open BenchCel Diagnostics and create a profile. Then return to the **Profile** list under **BenchCel Properties** and select the new profile.

6 On the **Device File** tab, expand the **BenchCel** device icon to show the list of stackers, and then click the **Stacker 1** icon. The corresponding stacker properties appear.
Set the desired values for the following properties. Use the default values for the remaining properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allowed/prohibited labware</td>
<td>(Optional) Click ... if you want to specify labware restrictions for this location. The Allowed/prohibited labware dialog box appears. For details on the labware classes, see the VWorks Automation Control Setup Guide. Note: If the button is not visible, click the empty field.</td>
</tr>
<tr>
<td>Stack Height</td>
<td>Type the maximum height (mm) of the rack you are using at this location. For example, type 660 if you are using a 660-mm tall rack.</td>
</tr>
</tbody>
</table>

**IMPORTANT** Do not change the default value of the Teachpoint for robot BenchCel property. For example, the stacker 1 teachpoint identity is 1, the identity of stacker 2 is 2, and so forth.

Repeat this step for each stacker.

7 Select **File > Save**.

If you are creating a new device file, the Save As dialog box appears so that you can specify a name and location for your device file. Ensure the file type is *.dev.*

Alternatively, you can select **File > Save All** to save the device file and the current protocol file at the same time.

**Related information**

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>VWorks software</td>
<td>VWorks Automation Control User Guide</td>
</tr>
<tr>
<td>Setting up BenchCel Workstation</td>
<td>“Setup Workflow” on page 58</td>
</tr>
<tr>
<td>Profiles</td>
<td>“Creating profiles” on page 68</td>
</tr>
<tr>
<td>Teachpoints</td>
<td>“Setting and managing teachpoints” on page 72</td>
</tr>
</tbody>
</table>
Opening BenchCel Diagnostics

About this topic
This topic describes how to open BenchCel Diagnostics from a device tab displayed in the VWorks software window. Alternatively, you can use the Diagnostics button on the toolbar to open BenchCel Diagnostics. In either case, you must have an open device file.

Procedure

To open BenchCel Diagnostics:

1. In the VWorks software window, ensure the correct device file is open. To open a device file, choose File > Open, and then select the appropriate device file (*.dev) in the Open dialog box.

2. In the Devices area of the opened device file tab, highlight the device icon, and then click Device diagnostics. Alternatively, you can double-click the device icon.

The device’s diagnostics dialog box opens.
Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>VWorks software</td>
<td>VWorks Automation Control User Guide</td>
</tr>
<tr>
<td>Setting up BenchCel Workstation</td>
<td>“Setup Workflow” on page 58</td>
</tr>
<tr>
<td>Profiles</td>
<td>“Creating profiles” on page 68</td>
</tr>
<tr>
<td>Teachpoints</td>
<td>“Setting and managing teachpoints” on page 72</td>
</tr>
<tr>
<td>BenchCel Diagnostics features</td>
<td>“Diagnostic tools” on page 132</td>
</tr>
</tbody>
</table>
Creating profiles

About this topic

The computer configured by Automation Solutions already has the correct profile to communicate with the BenchCel Workstation. A new BenchCel profile is not required unless you want to set up unique communication settings or use a different teachpoint file.

If you are using a computer other than one configured by Automation Solutions, you must create a BenchCel profile. This topic describes how to create new BenchCel profiles.

You must also create profiles for devices that are integrated with the BenchCel Workstation. For instructions on how to create the profiles for other Automation Solutions devices, see the corresponding device user documentation. For instructions on how to create profiles for third-party devices, see the applicable device driver user guide.

Profiles

IMPORTANT Each BenchCel device you install requires a unique profile, which enables unique communication settings.

A profile is a collection of settings, stored in the Microsoft Windows registry, that manages how you connect to devices. A BenchCel profile does the following:

- Specifies the port used to establish communication between the BenchCel Workstation and the controlling computer.
- References a teachpoint file. For a description of teachpoint files, see “Setting and managing teachpoints” on page 72.
- Specifies the number of stackers for the BenchCel Workstation.

You use the BenchCel Diagnostics software to create and manage profiles.

Note: The profile is referenced by a device file. For information about device files, see “Creating a BenchCel device in the VWorks software” on page 62. For a detailed description of the relationships between the device file, profile, and teachpoint file, see the VWorks Automation Control User Guide.

Creating BenchCel profiles

CAUTION Each profile can be used by multiple protocols. Deleting, renaming, or changing the parameters for a profile based on one protocol can invalidate other protocols that use the same profile.

Note: Unless you login to the VWorks software as an Administrator or Technician, only the Profile list and the Initialize this profile button are available in the Profile Management area of the Profiles page.

To create a BenchCel profile:

1. Open BenchCel Diagnostics.
2. On the Profiles page, click Create a new profile.
3 In the Create Profile dialog box, type a name, and click OK. Use a profile name that identifies the specific configuration, for example, use the device serial number.

4 In the Settings area, select one of the following:
   - **Ethernet connection.** Select This BenchCel is connected via ethernet, and proceed to step 5.
   - **Serial connection.** Select This BenchCel is connected via serial, and go to step 6.

5 **Ethernet connection only.** Click Find available device to select the device to associate with the profile. In the Discovered BioNet Devices dialog box that opens:
   - a Select the correct Ethernet adaptor for the device connection. A list of devices appear.
b In the list of devices that appear, select the BenchCel device. If you have multiple BenchCel devices on the network, use the **MAC Address** to identify the BenchCel device you want. To successfully communicate with the BenchCel device, the **Status** column must display **New** or **Matched** for the device.

*Note:* To determine the MAC address, you can turn off all other BenchCel devices so that only one appears in the Discovered BioNet Devices dialog box.

c Click **OK**.

### 6 Serial connection only:

a Select the COM port number on the controlling computer.

b Select **Use flow control** to stop the flow of data from the computer before it overruns the device communication buffer. This option helps to optimize communication over the serial connection.

7 If you want to create a profile for a BenchCel device that has a different number of stacks than the one connected to the controlling computer, set the **Number of stacks** value.

**IMPORTANT** During initialization, the software automatically detects the actual number of stacks on the BenchCel device. If this number differs from the number specified by the profile, an error message appears and gives you the option to Abort, Retry, or Ignore. If you click Ignore, the software overwrites the Number of stacks value with the actual number of stacks.
8 To save the profile using the default teachpoint file name and location that the software automatically creates, proceed to step 9. Later you will add teachpoints to this teachpoint file.

*Note:* The default teachpoint file name is Teachpoints_<profilename>.xml, where <profilename> is the name of the profile. The software saves the file in the C:\VWorks Workspace folder.

To use an existing teachpoint file or to change the automatically created teachpoint file name or storage location, click the corresponding button in the Teachpoint File area:

- **To select an existing teachpoint file.** Click ![button](image). In the Select a Teachpoint File dialog box, locate and select the teachpoint file that you want to use, and then click Open.

  **CAUTION** If the teachpoint file was copied from another computer, you must verify the teachpoints for the new profile before using the profile.

- **To change the teachpoint file name or storage location.** Click ![button](image). In the Save As dialog box, type a name for the teachpoint file, select the storage location, and then click Save. The file path appears in the Teachpoint File area. Later you will add teachpoints to this file.

9 Click **Update this profile** to save the changes.

10 To establish communication with the BenchCel Workstation, click **Initialize this profile**.

  **CAUTION** Before using a profile, make sure you have verified the teachpoints.

If you are setting up the BenchCel Workstation for the first time, return to “Creating a BenchCel device in the VWorks software” on page 62 and select the profile name (step 5).

**Related information**

<table>
<thead>
<tr>
<th>For information about</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding a device in VWorks software</td>
<td>“Creating a BenchCel device in the VWorks software” on page 62</td>
</tr>
<tr>
<td>Setting teachpoints</td>
<td>“Setting and managing teachpoints” on page 72</td>
</tr>
</tbody>
</table>
Setting and managing teachpoints

About this topic

This topic describes teachpoints and how to set them.

Teachpoints defined

A teachpoint is a set of coordinates that define where the robot can pick up or place labware. The location can be on an external device or a platepad. You set, edit, and save teachpoints in BenchCel Diagnostics. The teachpoints are displayed as plus signs in the graphical display area in the BenchCel Diagnostics dialog box.

Note: The graphical display area also shows teachpoints at the stacks. These teachpoints are preset at the factory and should not be changed.

Figure Teachpoint for labware pickup and placement locations at a external devices

Teachpoint files

The teachpoints you set are saved in the XML format in a teachpoint file. The default teachpoint file name is Teachpoints_<profilename>.xml, where <profilename> is the name of the profile. The software saves the file in the C:\VWorks Workspace folder.

However, you can select another file name and location when saving the file. You must use one teachpoint file for each BenchCel device. If you integrate a new device in the BenchCel Workstation, you can add the new teachpoints to the existing file. If you have multiple BenchCel devices in a BenchCel Workstation, you must create a teachpoint file for each BenchCel device in the workstation.

The teachpoint file is referenced by a profile. For information about profiles, see “Creating profiles” on page 68.
**Workflow for setting teachpoints**

<table>
<thead>
<tr>
<th>Step</th>
<th>For this task…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Determine the teachpoint coordinates.</td>
<td>“Determining the teachpoint coordinates” on page 73</td>
</tr>
<tr>
<td>2</td>
<td>Lock the device positions.</td>
<td>“Locking the device positions” on page 77</td>
</tr>
<tr>
<td>3</td>
<td>Record the teachpoint.</td>
<td>“Recording the teachpoint coordinates” on page 78</td>
</tr>
<tr>
<td>4</td>
<td>Verify the teachpoint.</td>
<td>“Verifying the teachpoints” on page 82</td>
</tr>
<tr>
<td>5</td>
<td>Edit the teachpoint if required.</td>
<td>“Editing existing teachpoints” on page 83</td>
</tr>
</tbody>
</table>

**Before you start**

**CAUTION** Before you begin changing teachpoints, make a backup copy of the teachpoint file. If the original teachpoint file becomes lost or damaged, you can use the backup copy instead of resetting all the teachpoints and creating a new file.

Make sure:
- The correct profile is initialized (“Creating profiles” on page 68).
- The labware you want to use is defined (*VWorks Automation Control Setup Guide*).

**Determining the teachpoint coordinates**

**WARNING** During this procedure, make sure no one else can issue commands at the controlling computer while you are manually determining the teachpoint coordinates.

**To determine the coordinates of the pickup and placement location:**

1. Place two or three spare microplates in a labware rack, and then install the rack on the BenchCel Workstation. For instructions, see “Filling and emptying the labware racks” on page 105 and “Installing and uninstalling the labware racks” on page 109.
2. Open **BenchCel Diagnostics** for the BenchCel device that you are setting up.
3 On the Profiles page, look in the Teachpoint File area to make sure the correct teachpoint file is loaded. You will be adding new teachpoints to this file.

**IMPORTANT** If you have not already done so, make a backup copy of this file.

4 In the Controls tab, select the labware definition from the Labware list.
5 In the graphical display area, click **Stacker** at the top of the rack that contains the spare microplates. In the menu that appears, click **Load plates**. The BenchCel device moves the stack down and holds the stack in the stacker grippers, or supports the stack on the stacker shelf, as specified in the labware definition.

![BenchCel device](image)

6 In the graphical display area, click the plus sign (+) at the stacker head that contains the spare microplates. In the menu that appears, click **Downstack from Stacker**. The robot head moves under the stacker and holds the first spare microplate in its grippers.

![BenchCel device](image)

7 On the **Controls** page, click the **Jog/Teach** tab.

8 Click **Go Home**. The robot head moves to its home position at the center of the BenchCel Workstation.

*Note:* The microplate is still in the robot grippers from step 6.
In the **Motors Enabled** area, clear the check boxes for **X** and **Theta** to disable the **x**-axis and **theta**-axis motors. The **z**-axis motor is still enabled (the **Z** box is selected).

With the robot grippers holding the spare microplate, gently push or pull the robot head and arms close to the teachpoint location. Position the robot head and arms so that the microplate rests in the target microplate location.

To fine-tune the teachpoint until you are able to place the microplate in the target location, use the following methods:

- Visually inspect the position of the microplate relative to the plate stage. If the robot is not aligned with the plate stage along the **y**-axis (front-to-back direction), move the robot into the safe zone, physically slide the external device and its integration plate along the **y**-axis, move the robot back and see if the robot arms are aligned with the plate stage. You might have to loosen the clamp screw to slide the device (see “Integrating the devices” on page 43).

- To move the robot head up or down in small, precise increments, open **BenchCel Diagnostics**. On the **Controls** page **Jog/Teach** tab, select the jog increment from the corresponding list, and then click **Up** (↑) or **Down** (↓).

- With the **x**-axis and **theta**-axis motors disabled, gently push or pull the robot so that the robot arms are able to place the microplate on the plate stage.
The microplate should sit level on the target location. In addition, the robot arms should not come in contact with any part of the target platepad, plate stage, or other surfaces.

12 Visually inspect the position of the microplate on the target location. It should be centered on the location. If it is not, ensure that the x-axis and theta-axis motors are disabled on the Jog/Teach tab, and then manually move the robot head to the microplate at the location.

## Locking the device positions

**CAUTION** Tightening the clamp screw can cause the teachpoint to shift. Make sure you verify the teachpoint coordinates after locking the device position.

Before you record the teachpoint, lock the devices in their positions.

**To lock the devices in their positions:**

1. Tighten the BenchCel integration plate clamp screw using the 3-mm hex wrench.
2. Check the teachpoint coordinates again. See “Determining the teachpoint coordinates” on page 73.
### Recording the teachpoint coordinates

**To record the teachpoint coordinates in BenchCel Diagnostics:**

1. Ensure the robot is holding the microplate at the teachpoint location.
2. On the **Controls** page **Jog/Teach** tab, click **New teachpoint**.
3. In the **Teachpoint Details** dialog box, click **Use current positions**. The robot's current coordinates fill the Theta, X, and Z boxes.

#### Teachpoint Details

<table>
<thead>
<tr>
<th>Setting</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theta (°)</td>
<td>The angle that the robot arms are from their home position, in degrees. A positive value moves the arms counterclockwise from the home position. A negative value moves the arms are clockwise from the home position. The range of movement is from -115° to 115°.</td>
</tr>
<tr>
<td>X (mm)</td>
<td>The horizontal distance (mm) from the home position. A positive value moves the robot head to the right of the home position. A negative value moves the robot head to the left of the home position. The range of movement depends on the number of stacker heads. For two stacker heads, the range is from -145 mm to 145 mm.</td>
</tr>
<tr>
<td>Z (mm)</td>
<td>The vertical distance (mm) from the home or lowest z-axis position. A positive value moves the robot head up from the home position. A negative value moves the head down from the home position. The range of movement is from -1.5 mm to 104 mm.</td>
</tr>
</tbody>
</table>

**IMPORTANT** Ensure the Z value is greater than -1.5 mm. If it is not, jog the z-axis up to obtain a value that is larger. Otherwise, the software will issue a z-position out-of-bounds error if a plate with a smaller Robot gripper offset is used.
Set the remaining teachpoint parameters and options in the Teachpoint Details dialog box:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type a one-word name for the teachpoint. For example, if the teachpoint is on an integrated Microplate Labeler, you might want to name the teachpoint Labeler. This name appears in the graphical display area in the BenchCel Diagnostics dialog box.</td>
</tr>
<tr>
<td>Approach height</td>
<td>Type the height clearance (mm) the robot must maintain above the teachpoint as it moves towards or away from the teachpoint location. The valid range is from 0 mm to 40 mm. Use this setting to prevent the robot from colliding with raised tabs or walls at the teachpoint location. You can start with an approach height of 20 mm (default). However, if there is an obstruction above the teachpoint, a smaller approach height might be required to prevent a collision. Note: This value applies when the robot is holding a microplate. When it is not holding a microplate, the robot will approach the teachpoint at the height of the teachpoint, unless you select the Respect approach height when not holding a plate option.</td>
</tr>
</tbody>
</table>
Setting and managing teachpoints

<table>
<thead>
<tr>
<th>Setting</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cavity depth</td>
<td>This setting is not commonly used and should be set at 0 mm for most applications. You can use this setting to account for teachpoints that have a depth (or negative height). To do this, type the depth (mm) as an offset to the Robot gripper offset. A positive value causes the grippers to grab higher on the plate by the specified amount. A negative values causes the grippers to grab lower on the plate. For example, suppose the Robot gripper offset is 5 mm and the platepad you want to use has depth of 9 mm. When the microplate sits in the platepad, the robot grippers cannot reach the offset height, as the following diagram shows. To account for this depth, you can set the Cavity depth at –9 mm. The robot grippers will grip the microplate 9 mm above the 5 mm offset (at 14 mm).</td>
</tr>
</tbody>
</table>
| Gripper open limit | Type the maximum distance (mm) the robot grippers are allowed to open as they prepare to grip the microplate at the teachpoint. The maximum value you set is less than or equal to the Robot Gripper Open Position value set in the BenchCel Diagnostics Controls Labware tab. Use this setting if the teachpoint area is narrower than the robot grippers open position. (To see this value, click **Save and exit**, and then click the Labware tab in the BenchCel Diagnostics Control tab.)  
*Note:* This value is used only at the teachpoint and not during other operations. |
| Respect approach height when not holding a plate | Select the check box to use the approach height even when the robot is not holding labware. |

**CAUTION** Before you clear this check box, ensure that the grippers will not run into the locating feet of the stage. Otherwise, clearing this check box can result in a crash.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Something is above this point</td>
<td>Select the option to limit the robot’s movements within the robot safe zone. With this selection, the robot will move only along the theta-axis as long as all of its parts (head, arms, grippers, and labware) are within the safe zone when approaching or moving away from the teachpoint.</td>
</tr>
<tr>
<td>Clear the check box to allow the robot to use the full workspace. The robot’s theta-axis movements are not limited when approaching and moving away from the teachpoint.</td>
<td>Clear the check box to allow the robot to use the full workspace. The robot’s theta-axis movements are not limited when approaching and moving away from the teachpoint.</td>
</tr>
<tr>
<td>Use this option to limit the robot’s movements to prevent collision when approaching a teachpoint. For example, when moving labware to and from a multi-shelf device such as the Vertical Pipetting Station, this option prevents the robot from colliding with the shelf above the target teachpoint.</td>
<td>Use this option to limit the robot’s movements to prevent collision when approaching a teachpoint. For example, when moving labware to and from a multi-shelf device such as the Vertical Pipetting Station, this option prevents the robot from colliding with the shelf above the target teachpoint.</td>
</tr>
</tbody>
</table>

5 Click **Save and Exit** to save the teachpoint in the teachpoint file and close the Teachpoint Details dialog box.

On the **Controls** page in **BenchCel Diagnostics**, the new teachpoint appears in the graphical display area as a plus sign (+).
Gently push or pull the robot into the safe zone.

On the Jog/Teach tab, click Go Home. The software prompts you to enable all the motors. After the motors are enabled, the robot head moves to the center of the BenchCel device, and the robot arms are perpendicular to the x-axis. The robot grippers are still holding the spare microplate you used to set the teachpoint.

On the Controls page, click the plus sign (+) of the stacker that is holding the spare microplates, and then choose Upstack to Stacker. The robot moves the microplate back into the stack.

Save the device file.

Verifying the teachpoints

To verify a teachpoint:

1 Load two to three spare microplates in the labware rack and load the rack on the BenchCel device. For instructions, see “Filling and emptying the labware racks” on page 105 and “Installing and uninstalling the labware racks” on page 109.

2 In BenchCel Diagnostics, click the Controls tab, and select the desired labware definition from the Labware list.

3 In the graphical display area, click the plus sign (+) at both of the following locations:

Figure  Example of teachpoints for labware pickup and placement locations on external devices
• The stack that contains the spare microplates
• The teachpoint you want to verify

The selected teachpoints should be highlighted in red circles ( ).

4 In the Speed list, select Slow.

Note: You can set the Slow speed as a percentage of the factory-set maximum speed. To do this, see “Changing the robot speed” on page 134.

5 In the graphical display area, click the stacker that contains the spare microplates. In the command menu that appears, click Transfer to <teachpoint name>, where <teachpoint name> is the name of the teachpoint you are verifying. The robot picks up the first microplate in the stack and moves it to the selected teachpoint.

• If the robot did not move the microplate to the correct location, proceed to “Editing existing teachpoints” on page 83 to refine the teachpoint.
• If the robot correctly placed the microplate at the new teachpoint, move the microplate back to the stack as follows:

In the graphical display area, click the plus sign ( ) at the new teachpoint, and then choose Transfer to Stack. The robot moves the microplate from the teachpoint back to the stack.

Editing existing teachpoints

When you set a teachpoint for the first time, you will likely set, verify, and edit the teachpoint a number of times to ensure that the teachpoint is correct. After the teachpoint is correct, no further teachpoint adjustment is required unless you do the following:

• Move the BenchCel Workstation
• Move or replace one of the devices in the workstation
• Adjust settings on the devices

To edit an existing teachpoint:

1 In BenchCel Diagnostics, click the Profiles tab, and verify that the correct teachpoint file is loaded.
2 Click the Controls tab. In the graphical display area, double-click the plus sign (✚) of the teachpoint you want to edit.

**Figure**  Example of teachpoints for external devices

![Example of teachpoints for external devices](image)

The Teachpoint Details dialog box opens and displays the current coordinates and settings for the selected teachpoint.

3 Do one of the following:
   - Follow the instructions in “Determining the teachpoint coordinates” on page 73 to manually move the robot head to a new teachpoint position and set the teachpoint.
   - Type new coordinate values or change any of the existing settings.

4 Click Save and Exit to save the revised teachpoint in the teachpoint file.

**Deleting teachpoints**

To delete a teachpoint:

1 In BenchCel Diagnostics, click the Profiles tab, and verify that the correct teachpoint file is loaded.

2 In the graphical display area, double-click the plus sign (✚) of the teachpoint you want to delete.

3 In the Teachpoint Details dialog box, click Delete. The current teachpoint file will automatically be updated when you delete a teachpoint.

4 Save the device file.

**Related information**

<table>
<thead>
<tr>
<th>For information about</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup procedure</td>
<td>“Setup Workflow” on page 58</td>
</tr>
<tr>
<td>Integrating external devices</td>
<td>“Integrating the devices” on page 43</td>
</tr>
<tr>
<td>Moving between teachpoints</td>
<td>“Diagnostic tools” on page 132</td>
</tr>
</tbody>
</table>
This chapter describes how to set the sensor thresholds correctly for the specific type of labware you are using.

This chapter contains the following topics:

- “Overview for setting sensor thresholds” on page 86
- “Calculating the Plate presence threshold” on page 88
- “Determining the optimum Orientation sensor offset” on page 93
- “Calculating the Orientation threshold” on page 97
- “Worksheet for setting sensor thresholds” on page 99
Overview for setting sensor thresholds

About this topic

You must set the Plate-presence and Orientation thresholds correctly for the specific type of labware you are using to ensure proper operation. For example, the thresholds must be accurate to ensure proper upstacking and downstacking of the labware. You must set the thresholds for the labware type before using the labware in a BenchCel protocol run.

This topic explains how the plate-orientation sensors work and the workflow for setting the sensor thresholds.

How the plate-orientation sensors work

Four plate-orientation sensors on the inside wall of the stacker head detect the presence of microplate notches when the microplate is downstacked. Each sensor contains a light emitter that transmits light, and a receiver that reads the amount of light reflected by the surface of the microplate.

If the light beam bounces off of a wall that is perpendicular to its path, most of the light will reflect back. The resulting reading is relatively high. If the light beam bounces off of a wall that is not perpendicular to the light path, the light will be deflected. The resulting reading is significantly lower.

*Figure*  Emitted light path on the notched and unnotched corners of a plate

The amount of light that the sensor receives is displayed in BenchCel Diagnostics on the Controls page Jog/Teach tab. The microplate corners that have notches should have much lower readings than the corners that do not have notches. In the following example, the sensors detect a notch in the upper right and lower left corners of the microplate.
The following factors can affect the reading of the notch sensor and might require that you adjust the sensor light intensity:

- **Microplate position.** For optimum results, the sensor light should bounce off of the microplate at halfway between the top of the microplate and the top of the plate skirt.
- **Microplate color.** Darker microplate color might require higher light intensity.
- **Microplate material.** Shiny or reflective microplates might require lower light intensity.
- **Microplate condition.** Cracks, chips, scratches, or defects in the area where the sensor light contacts the microplate can affect sensor reading.
- **Ambient light.** Brighter rooms might require lower light intensity.

**Workflow for setting sensor thresholds**

**Before you start**

Make sure you have three spare microplates for each BenchCel Workstation stacker head. For example, if the BenchCel Workstation has six stacker heads, you should have 18 microplates.

Make a copy of the provided “Worksheet for setting sensor thresholds” on page 99. You can use it to record sensor readings and facilitate threshold calculations.

**Workflow**

<table>
<thead>
<tr>
<th>Step</th>
<th>For this task...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Calculate the Plate-presence threshold.</td>
<td>“Calculating the Plate presence threshold” on page 88</td>
</tr>
<tr>
<td>2</td>
<td>Determine the optimum sensor offset at each stack.</td>
<td>“Determining the optimum Orientation sensor offset” on page 93</td>
</tr>
<tr>
<td>3</td>
<td>Calculate the Orientation threshold based on the observed Notch Sensors readings.</td>
<td>“Calculating the Orientation threshold” on page 97</td>
</tr>
</tbody>
</table>
Calculating the Plate presence threshold

About this topic

You must calculate the Plate presence threshold for the specific type of labware you are using. Before you start, see “Overview for setting sensor thresholds” on page 86.

Workflow for calculating the Plate-presence threshold

Use the following workflow to calculate the Plate presence threshold.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Determine the highest Plate-presence reading among all the stacks when no microplate is loaded ( (P_{\text{unloaded}}) ).</td>
</tr>
<tr>
<td>2</td>
<td>Determine the lowest Plate-presence reading among all the stacks when the first microplate is loaded in each stack ( (P_{\text{loaded}}) ).</td>
</tr>
<tr>
<td>3</td>
<td>Use the results from steps 1 and 2 to calculate the threshold.</td>
</tr>
</tbody>
</table>

Determining the Plate presence reading when no microplates are loaded

To determine the highest Plate presence reading when no microplates are loaded:

1. Install a labware rack at each stacker head, and place three microplates in each labware rack. The microplates should rest on top of the stacker grippers. (See “Filling and emptying the labware racks” on page 105.)

   IMPORTANT  Do not click Load All in BenchCel Diagnostics.

2. In the BenchCel Diagnostics on the Controls page, click the Labware tab. In the Sensors area, set the initial values as follows:
   - Plate presence threshold at 225 units.
• **Intensity** at 100%.

Click **Apply and save labware parameters**.

3 Click the **Jog/Teach** tab. In the **Stacker Sensors** area:
   a  Select stack 1 from the list.
   b  Record the **Plate presence** reading.
   c  Repeat steps a and b for each of the remaining stacks.
   d  In the list, select the number of the stack that has the highest Plate presence reading.

4 On the **Labware** tab, adjust the **Intensity** value so that the highest **Plate presence** reading (Jog/Teach tab) is less than or equal to 175. Click **Apply and save labware parameters**.

Use the following guidelines when adjusting the Intensity value:

- For the most reliable sensor function, use the highest Intensity value possible while keeping the Plate presence reading no greater than 175.
- If the Plate presence reading is greater than 175, decrease the Intensity value incrementally so that the Plate presence reading is reduced to 175.

For example, if a light-colored microplate has a Plate presence reading of 200, decreasing the Intensity value to 20 reduces the reading to 175.
5 Setting sensor thresholds

Calculating the Plate presence threshold

On the Jog/Teach tab, find the highest Plate presence reading \((P_{\text{unloaded}})\) among all the stacks as follows:

a Select stack 1 from the list.

b Record the Plate presence reading.

c Repeat steps a and b for each of the remaining stacks.

d Assign the highest Plate presence reading to \(P_{\text{unloaded}}\), the highest Plate presence threshold when no microplate is loaded. The value will be used to calculate the Plate presence threshold.

In the following example, the highest Plate presence reading is 51 (stack 2).

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>48</td>
<td>51</td>
<td>50</td>
<td>45</td>
</tr>
</tbody>
</table>

Determining the Plate presence reading when microplates are loaded

To determine the lowest Plate presence reading when a microplate is loaded in each stack:

IMPORTANT The Plate presence reading can vary depending on the Stack Holding Method, which is specified in the Labware Editor. For greater precision, use the stacker grippers for the Stack Holding Method.

1 On the Controls page, click Load All.
2  On the Jog/Teach tab:
   a  Select stack 1.
   b  Record the Plate presence reading.
   c  Repeat steps a and b for each of the remaining stacks.
   d  Assign the lowest Plate presence reading to \( P_{\text{loaded}} \), the lowest Plate presence threshold when microplates are loaded. The value will be used to calculate the Plate presence threshold.

In the following example, the lowest Plate presence reading is 131 (stack 1).

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>131</td>
<td>139</td>
<td>140</td>
<td>135</td>
</tr>
</tbody>
</table>

**Calculating the threshold**

*To calculate the Plate presence threshold:*

1  Calculate the threshold using the following formula:

\[
\text{Plate presence threshold} = \frac{P_{\text{unloaded}} + P_{\text{loaded}}}{2}
\]

In the following example, the calculated threshold is 91.

<table>
<thead>
<tr>
<th>( P_{\text{unloaded}} )</th>
<th>( P_{\text{loaded}} )</th>
<th>Plate presence threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>51</td>
<td>131</td>
<td>91</td>
</tr>
</tbody>
</table>
5 Setting sensor thresholds
Calculating the Plate presence threshold

2 On the Jog/Teach tab, type the calculated **Plate presence threshold**, and then click **Apply & save**.

![Image of Jog/Teach tab with calculated Plate presence threshold]

**Related information**

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow for setting sensor thresholds</td>
<td>“Overview for setting sensor thresholds” on page 86</td>
</tr>
</tbody>
</table>
| Next steps in this workflow | • “Determining the optimum Orientation sensor offset” on page 93  
• “Calculating the Orientation threshold” on page 97 |
| Worksheet for sensor thresholds | “Worksheet for setting sensor thresholds” on page 99 |
| Labware definitions and the Labware Editor | VWorks Automation Control Setup Guide |
| Filling and emptying the labware racks | “Filling and emptying the labware racks” on page 105 |
Determining the optimum Orientation sensor offset

About this topic

Before starting this procedure, make sure you are familiar with the workflow in “Overview for setting sensor thresholds” on page 86.

Procedure

To determine the optimum Orientation sensor offset:

1. On the Controls page at Stacker 1, click Downstack from Stacker.

2. On the Labware tab, verify that the Orientation sensor offset box contains the initial offset value you want to use for the selected labware.

   If you have not already done so, follow these steps to determine the initial value for the Orientation sensor offset:

   a. Determine the midpoint height (mm) of the microplate. To do this, measure from the top of the microplate skirt to the top of the microplate and divide by 2.

   b. Measure the height (mm) of the microplate skirt.

   c. Add the values from step a and step b.
5 Setting sensor thresholds
Determining the optimum Orientation sensor offset

**Figure** Example of initial Orientation sensor offset calculation

3 On the **Controls** page at **Stacker 1**, click **Move to sensor**. The robot moves the first microplate into the line of notch sensors.

4 On the **Jog/Teach** tab, make sure the **Notch Sensors** readings are appropriate. The notches should have much lower readings than the corners. In addition, the difference between the notch readings and corner readings should be at a maximum.

In the following example, the Notch Sensors values indicate that the microplate has two notches (3 and 7) and two corners (76 and 63).
5 To find the maximum difference between the notch readings and corner readings:
   a On the Controls page, locate the initial z-axis position ($Z_{\text{initial}}$) in the upper left corner. Record the value.
   b Use the controls on the Jog/Teach tab to jog the robot up or down, and then check the Notch Sensors readings. You can repeat this step until you find the maximum difference between the notch readings and the corner readings.
   c Record the adjusted z-axis position ($Z_{\text{adjusted}}$).

6 Calculate the jog distance:
   Jog distance = $Z_{\text{initial}} - Z_{\text{adjusted}}$

In the following example, the jog distance is –5.00 mm.

<table>
<thead>
<tr>
<th>$Z_{\text{initial}}$</th>
<th>50.27 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>$Z_{\text{adjusted}}$</td>
<td>55.27 mm</td>
</tr>
<tr>
<td>Jog distance</td>
<td>–5.00 mm</td>
</tr>
</tbody>
</table>

7 Calculate the adjusted Orientation sensor offset using the following formula:
   Adjusted Orientation sensor offset =
   Initial Orientation sensor offset + Jog distance

In the following example, the adjusted orientation sensor offset is 3.80 mm.

<table>
<thead>
<tr>
<th>Initial Orientation sensor offset</th>
<th>8.80 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jog distance</td>
<td>–5.00 mm</td>
</tr>
<tr>
<td>Adjusted Orientation sensor offset</td>
<td>3.80 mm</td>
</tr>
</tbody>
</table>

8 On the Labware tab, type the adjusted Orientation sensor offset.
5 Setting sensor thresholds
Determining the optimum Orientation sensor offset

9 On the Control page at the next stacker, click Downstack from Stacker, and then click Move to sensor. Check the Notch Sensors readings on the Jog/Teach tab. The notches should have much lower readings than the corners. In addition, the difference between the notch readings and corner readings should be at a maximum.

10 Repeat step 9 for the remaining stackers.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow for setting sensor thresholds</td>
<td>“Overview for setting sensor thresholds” on page 86</td>
</tr>
<tr>
<td>Worksheet for sensor thresholds</td>
<td>“Worksheet for setting sensor thresholds” on page 99</td>
</tr>
<tr>
<td>Previous step in this workflow</td>
<td>“Calculating the Plate presence threshold” on page 88</td>
</tr>
<tr>
<td>Next step in this workflow</td>
<td>“Calculating the Orientation threshold” on page 97</td>
</tr>
</tbody>
</table>
Calculating the Orientation threshold

About this topic

Before you start this procedure, make sure you are familiar with the workflow in “Overview for setting sensor thresholds” on page 86.

Procedure

To calculate the Orientation threshold:

1. At each stacker, determine the highest reading for the notch and lowest reading for the corner as follows:
   a. In BenchCel Diagnostics, click the Controls tab. In the graphical display area click Stacker 1, and then click Move to sensors.
   b. On the Jog/Teach tab in the Stack Sensor area, select stack 1 from the list.
   c. In the Notch Sensors area, find the highest reading for the notch and lowest reading for the corner, and then record these readings. (In the example below, the highest notch reading is 7, and the lowest corner reading is 62.)
   d. Repeat step a to step c for the remaining stacks.

2. Find the highest notch reading (Notch_{highest}) among all the stacks. In the following example, the highest reading is 35 (stack 3).

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>25</td>
<td>35</td>
<td>15</td>
</tr>
</tbody>
</table>

3. Find the lowest corner reading (Corner_{lowest}) among all the stacks. In the following example, the lowest reading is 235 (stack 4).

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>244</td>
<td>238</td>
<td>245</td>
<td>235</td>
</tr>
</tbody>
</table>
4 Calculate the Orientation threshold as follows:
Orientation threshold = \( \frac{\text{Notch}_{\text{highest}} + \text{Corner}_{\text{lowest}}}{2} \)
In the following example, the calculated threshold is 135.

<table>
<thead>
<tr>
<th>Highest notch reading among all stacks</th>
<th>35</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lowest corner reading among all stacks</td>
<td>235</td>
</tr>
<tr>
<td>Orientation threshold (midpoint)</td>
<td>135</td>
</tr>
</tbody>
</table>

5 On the Jog/Teach tab, type the calculated Orientation threshold.

![Jog/Teach tab screenshot]

After you finish setting the sensor thresholds for the specific type of labware, you can use the labware in a protocol.

**Related information**

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall workflow for setting sensor thresholds</td>
<td>“Overview for setting sensor thresholds” on page 86</td>
</tr>
</tbody>
</table>
| Previous steps in this workflow | • “Calculating the Plate presence threshold” on page 88  
• “Determining the optimum Orientation sensor offset” on page 93 |
| Worksheet for sensor thresholds | “Worksheet for setting sensor thresholds” on page 99 |
Worksheet for setting sensor thresholds

About this worksheet

Use this worksheet to record sensor readings and facilitate your threshold calculations. See “Overview for setting sensor thresholds” on page 86 for the procedures to calculate the thresholds.

Plate-presence threshold

Determine the Plate presence readings when microplates are unloaded

Set the initial values as follows:

- Plate presence threshold = 225 units
- Intensity = 100%

Record the Plate presence reading for each stack.

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
<th>Stack 5</th>
<th>Stack 6</th>
</tr>
</thead>
</table>

Adjust the Intensity value so that the highest Plate presence reading is less than or equal to 175, and then record the Plate presence readings for each stack.

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
<th>Stack 5</th>
<th>Stack 6</th>
</tr>
</thead>
</table>

Highest reading among all the stacks \(P_{\text{unloaded}}\): ________________

Determine the Plate presence readings when the microplates are loaded

After loading the microplates at each stack (Load All in BenchCel Diagnostics), record the Plate presence readings for each stack.

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
<th>Stack 5</th>
<th>Stack 6</th>
</tr>
</thead>
</table>

Lowest reading among all the stacks \(P_{\text{loaded}}\): ________________

Calculate the Plate presence threshold

Plate presence threshold = \(\frac{P_{\text{unloaded}} + P_{\text{loaded}}}{2}\) = ______
Optimum Orientation sensor offset

**Initial Orientation sensor offset**
Measure A and B of your microplate.

\[
\text{Initial Orientation sensor offset} = \frac{A}{2} + B = \text{__________ mm}
\]

**Jog distance**
Jog distance = \(Z_{\text{initial}} - Z_{\text{adjusted}} = \text{__________ mm}\)

**Adjusted Orientation sensor offset**
Adjusted Orientation sensor offset =

\[
\text{Initial Orientation sensor offset} + \text{Jog distance} = \text{__________ mm}
\]

Orientation threshold

In graphical display area on the **Controls** page, click **Stacker**, and then choose **Move to Sensor**. On the **Jog/Teach** tab, find the highest notch reading in the **Notch Sensors** area. Repeat this step for each stack.

*Note:* Notches have lower readings than corners.

**Highest Notch Sensors readings**
Record the highest notch reading for each stack.

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
<th>Stack 5</th>
<th>Stack 6</th>
</tr>
</thead>
</table>

Highest reading among all stacks (\(\text{Notch}_{\text{highest}}\)): __________

**Lowest Corner readings**
Record the lowest corner reading for each stack.

<table>
<thead>
<tr>
<th>Stack 1</th>
<th>Stack 2</th>
<th>Stack 3</th>
<th>Stack 4</th>
<th>Stack 5</th>
<th>Stack 6</th>
</tr>
</thead>
</table>

Lowest reading among all stacks (\(\text{Corner}_{\text{lowest}}\)): __________

**Orientation threshold**
Orientation threshold = \(\frac{\text{Notch}_{\text{highest}} + \text{Corner}_{\text{lowest}}}{2} = \text{__________}\)
6 Preparing for a run

This chapter describes how to prepare for a protocol run on the BenchCel Workstation. All of the procedures in this chapter can be performed by someone with operator privileges.

This chapter contains the following topics:

- “Workflow for operating the BenchCel Workstation” on page 102
- “Handling the labware racks” on page 103
- “Filling and emptying the labware racks” on page 105
- “Installing and uninstalling the labware racks” on page 109
- “Performing pre-run checks” on page 114
Workflow for operating the BenchCel Workstation

About this topic

This topic presents the workflow for operating the BenchCel Workstation.

Before you begin

Make sure that you have:
- Initialized the correct profile. See “Creating profiles” on page 68.
- Verified the teachpoints per “Verifying the teachpoints” on page 82.
- Set the Plate-presence and Orientation thresholds for the type of microplate you are using. See “Setting sensor thresholds” on page 85.

Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>For this task...</th>
<th>See...</th>
</tr>
</thead>
</table>
| 1    | Place the labware into the rack and mount the rack on the device. | • “Handling the labware racks” on page 103  
• “Filling and emptying the labware racks” on page 105  
• “Installing and uninstalling the labware racks” on page 109 |
| 2    | Perform pre-run checks. | “Performing pre-run checks” on page 114 |
| 3    | Prepare devices and accessories. | Device user documentation |
| 4    | Open a protocol in the VWorks software. | VWorks Automation Control User Guide |
| 5    | Start and monitor a protocol run. | VWorks Automation Control User Guide |
| 6    | Clean up after the run. | “Cleaning up after a protocol run” on page 118 |
Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defining the labware</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• “Changing labware parameters” on page 140</td>
</tr>
<tr>
<td></td>
<td>• “Setting sensor thresholds” on page 85</td>
</tr>
<tr>
<td></td>
<td>• VWorks Automation Control Setup Guide</td>
</tr>
<tr>
<td>Pausing a run</td>
<td>VWorks Automation Control User Guide</td>
</tr>
</tbody>
</table>

Handling the labware racks

About this topic

The labware racks store the stacks of labware (microplates, tipboxes, and tube racks) that are processed during a protocol run. This topic describes how to carry labware racks safely.

Carrying the labware racks

**WARNING**  Do not hold a rack by the interior edges. The interior edges can have sharp surfaces that can cause cuts if handled improperly.

**CAUTION**  A rack that is fully loaded with labware can be heavy. Grasp the rack handle firmly to prevent the rack from slipping or tilting.

To carry a rack, firmly grasp the rack by the handle as shown in the following figure.
6 Preparing for a run
Handling the labware racks

Figure  Carrying a front-load rack

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filling and emptying the labware racks</td>
<td>“Filling and emptying the labware racks” on page 105</td>
</tr>
<tr>
<td>Mounting the labware racks onto the device and removing the</td>
<td>“Installing and uninstalling the labware racks” on page 109</td>
</tr>
<tr>
<td>racks from the device</td>
<td></td>
</tr>
<tr>
<td>Labware definitions and the Labware Editor</td>
<td>VWorks Automation Control Setup Guide</td>
</tr>
</tbody>
</table>
Filling and emptying the labware racks

About this topic

The labware racks store the stacks of labware (microplates, tipboxes, and tube racks) that are processed during a protocol run. This topic describes how to fill the racks with fresh labware and how to remove the used labware from the racks.

Before you begin

**WARNING** Make sure you understand how to handle the racks safely. See “Handling the labware racks” on page 103.

**CAUTION** Before you place labware into a rack that is mounted on the BenchCel device, the clamps in the BenchCel stacker head must be closed (extended). If the clamps are open the stacker grippers will not prevent the stack of labware from dropping. To close the clamps, open BenchCel Diagnostics. On the Controls page, click Stacker at the top of the rack that you want to remove, and then choose Close Stacker Grippers.

Before filling or emptying a labware rack:

- Depending on the rack model, the procedure can vary:
  - *Standard or top-load racks.* Place the rack on a flat, level surface. Although it is possible to fill or empty a mounted rack, the top of a mounted rack can be difficult to access safely.
  - *Front-load racks.* The rack can be mounted on the BenchCel device or placed on a flat, level surface.

For details on how to mount the racks or remove the racks from the BenchCel device, see “Installing and uninstalling the labware racks” on page 109.

- Position the rack so that the opening is facing you.
- Determine how the microplates should be oriented in the rack.

For example, if the BenchCel orientation-sensing feature is enabled, make sure the A1 wells are oriented in the rack as specified.
Filling the standard and top-load racks

**WARNING** Use care to avoid sliding your hand on the interior edges in the rack. The edges can have sharp surfaces.

The following figure shows how to slide a stack of labware into a standard rack.

*Figure* Filling a standard rack: A) Sliding the stack down through the top, B) Supporting the stack through the bottom slot

1. Place the rack on a flat, level surface.
2. Using both hands, carefully slide a small stack of labware down through the top of the rack.
   You can use one hand to support underneath the labware stack, while the other hand holds the top of the labware to keep it level. See figure.
3. *Standard racks only*. When you reach the bottom of the open slot, transfer your hand positions so that you continue supporting the labware through the bottom slot.
4. Ensure that the bottom labware in the stack rests on the rack stacker grippers.
To remove labware from a standard or top-load rack:

1. If possible, remove the rack from the device, and place the rack on a flat, level surface.

   **IMPORTANT** If you are removing labware from a mounted rack, ensure that the stack is unloaded. To unload the stack, open *BenchCel Diagnostics*. On the Control page, click Stack in the graphical display area, and then choose Unload Plates. Alternatively, you can click Unload All to unload all the stacks.

2. Carefully slide the labware in small stacks, up and out of the top of the rack.

Filling a front-load rack

The doors on the front-load rack provide easy access for placing labware into the front of a rack that is mounted on a device.

**Figure**  Door mechanism on the front-load rack

To place labware into a front-load rack:

1. If the rack is mounted on the BenchCel device, verify that the stack is in the unloaded state.

   To unload the stack, open *BenchCel Diagnostics*. On the Control page, click Stack, and then choose Unload Plates. Alternatively, you can click Unload All to unload all the stacks.

2. On each side of the rack, slide the Door-release (black) buttons forward, while pushing outward on the thumb tabs. The rack doors open.
3 Place the labware directly through the open rack doors so that the bottom labware rests on the rack stacker grippers. Ensure the labware is level in the rack.

4 To close the doors, press the thumb tabs inward until the doors snap shut.

**To remove labware from a front-load rack:**

1 If the rack is mounted on the BenchCel device, verify that the stack is in the unloaded state.

   To unload the stack, open **BenchCel Diagnostics**. On the **Control** page, click **Stacker**, and then choose **Unload Plates**. Alternatively, you can click **Unload All** to unload all the stacks.

2 To open the rack doors, slide the black Door-release buttons forward on each side of the rack, while pressing outward on the thumb tabs.

3 Carefully, lift the labware out through the front of the rack.

**Related information**

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting the rack on the BenchCel device or removing the rack from the device</td>
<td>“Installing and uninstalling the labware racks” on page 109</td>
</tr>
<tr>
<td>How to handle the racks safely</td>
<td>“Handling the labware racks” on page 103</td>
</tr>
<tr>
<td>Automation-ready labware</td>
<td>“Labware considerations” on page 26</td>
</tr>
</tbody>
</table>
| Changing labware parameters | • “Changing labware parameters” on page 140  
  • *VWorks Automation Control Setup Guide* |
Installing and uninstalling the labware racks

About this topic

This topic explains how to install the labware racks on the BenchCel device and how to uninstall the racks.

Figure   BenchCel device (front) with two front-load labware racks

Before you begin

IMPORTANT   Make sure the BenchCel power and compressed air are turned on before you install or uninstall a labware rack.

When lifting the labware rack onto and off of the stacker head, use both hands to grasp the rack securely around the four corners near the base.

WARNING   Avoid touching the interior edges of a rack when lifting the rack. The interior edges can have sharp surfaces.
Installing labware racks on the BenchCel device

To install a labware rack:

1. At the BenchCel device, verify that the clamps are closed (extended) in the stacker head.

   Note: To close the clamps, open BenchCel Diagnostics. On the Controls page, click Stacker at the top of the rack that you want to remove, and then choose Close Stacker Grippers.

   When you install the rack, the prongs in the labware rack tabs will be inserted into the slots in the clamps. If the clamps are open, the slots will be hidden, and you cannot install the rack.
2 With the rack’s open side facing the front, lower the rack onto the stacker head. Make sure the prongs at the bottom of the rack tabs insert into the slots in the extended clamps. The rack is automatically locked into position.

Figure  Installing a labware rack on the stacker head (closeup view without labware)
Uninstalling labware racks

Before you can remove a mounted rack, you must first unlock the rack. When you unlock the rack, two pins in the stacker head retract, as the following figure shows.

Figure  Stacker head with retracted locking pins

To uninstall a rack from the BenchCel device:

1. At the BenchCel device, verify that the stack is unloaded.
   To unload the stack, open BenchCel Diagnostics. On the Controls page in the graphical display area, click Stacker at the top of the rack that you want to remove, and then choose Unload Plates.

2. Unlock the rack by doing one of the following:
   - Press the green rack-release button at the top of the stacker head. The green status light flashes for 5 seconds to indicate that the rack is ready for removal. A click sounds as the locks retract. If the green light stops flashing, press the button again.
• In BenchCel Diagnostics, click the Controls tab. In the graphical display area, at the top of the rack that you want to unlock, click Stacker, and then choose Unlock rack. A click sounds as the locks retract.

3 Carefully lift the labware rack from the stacker head.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turning on the power and air</td>
<td>“Starting up and shutting down” on page 60</td>
</tr>
<tr>
<td>Automation-ready labware</td>
<td>“Labware considerations” on page 26</td>
</tr>
<tr>
<td>Labware definitions and the Labware Editor</td>
<td>VWorks Automation Control Setup Guide</td>
</tr>
<tr>
<td>How to handle the racks safely</td>
<td>“Handling the labware racks” on page 103</td>
</tr>
<tr>
<td>Placing labware into the labware racks and removing labware from the racks</td>
<td>“Filling and emptying the labware racks” on page 105</td>
</tr>
</tbody>
</table>
Performing pre-run checks

About this topic

Before you start a protocol run, you should check the BenchCel Workstation to ensure optimum operation. This topic provides the list you should check before each protocol run.

Procedure

To check that the BenchCel Workstation is ready for a run:

1. Make sure there are no stray microplates in robot-accessible locations, including:
   - Platepads
   - External device plate stages
   - Third-party device areas that will accept labware from the BenchCel device
2. Remove any obstacle in the robot’s pathways. Consider the path of the robot head and arms.
3. For the devices that require compressed air, make sure the air pressure meets the operating requirements. For the BenchCel device air supply requirements, see “Verifying laboratory requirements” on page 35. For other Automation Solutions devices, check the user documentation for the device. For third-party devices, check the product’s user documentation.
   To check the BenchCel device internal air pressure, see “Adjusting the stacker gripper pressure” on page 144.
4. Make sure all devices and accessories are set up correctly and prepared for the run. For instructions, see the user documentation for the device or accessory.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>BenchCel device air source requirements</td>
<td>“Verifying laboratory requirements” on page 35</td>
</tr>
<tr>
<td>External device air source requirements</td>
<td>External device user documentation</td>
</tr>
<tr>
<td>Diagnosing air pressure problems</td>
<td>“Maintenance and troubleshooting” on page 115</td>
</tr>
</tbody>
</table>
7

Maintenance and troubleshooting

This chapter describes how to maintain the BenchCel Workstation and provides troubleshooting information.

This chapter contains the following topics:

- “Routine maintenance” on page 116
- “Cleaning up after a protocol run” on page 118
- “Replacing the fuse” on page 120
- “Hardware problems” on page 123
- “Software error messages” on page 125
- “Diagnostic tools” on page 132
- “Adjusting the stacker gripper pressure” on page 144
- “Reporting problems” on page 148
Routine maintenance

About this topic

This topic provides recommendations for maintaining the BenchCel Workstation.

For on how to clean the BenchCel Workstation between runs, see “Cleaning up after a protocol run” on page 118.

Monthly inspection and maintenance

In general, practice good housekeeping by cleaning up spills and routinely cleaning after using the BenchCel Workstation.

Every month, check the following:

- *Robot gripper pins.* Make sure they are not too dull to grip the microplates. If the pins have become dull, contact Automation Solutions Technical Support to replace them.

*Figure*  Robot head (side view)
**Moving parts.** Ensure they are not rubbing against each other. Look for rub marks or noises that might indicate rubbing. If you see rub marks, contact Automation Solutions Technical Support.

**Air-supply tubing.** Verify that the tubing is in good shape and there are no leaks. Replace the broken tubing if necessary.

**Stacker gripper pressure.** Make sure the pressure is set correctly. On the **Controls** page in BenchCel Diagnostics, click the **Jog/Teach** tab, and check the **Air** reading.

**Integrated device**

For routine maintenance of the external devices, see the external device user documentation.

**Related information**

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cleanup procedure after every protocol run</td>
<td>“Cleaning up after a protocol run” on page 118</td>
</tr>
</tbody>
</table>
Cleaning up after a protocol run

About this topic

This topic describes the tasks you should perform when you have finished a protocol run.

Procedure

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air source requirements</td>
<td>“Compressed air requirements” on page 36</td>
</tr>
<tr>
<td>Checking and adjusting the stacker gripper pressure (internal air pressure)</td>
<td>“Adjusting the stacker gripper pressure” on page 144</td>
</tr>
</tbody>
</table>

**CAUTION** Make sure you clean up spilled liquids immediately. Do not use harsh abrasives, corrosive cleaning agents, or metal brushes to clean any BenchCel Workstation component or accessory.

**To clean up after a run:**

1. Follow the VWorks software prompts for post-run software procedures, such as unloading the microplates. See the *VWorks Automation Control User Guide* for detailed instructions.

2. Unload used sample microplates from the labware racks. See “Filling and emptying the labware racks” on page 105.

3. Remove the labware racks from the BenchCel device. See “Installing and uninstalling the labware racks” on page 109.

   **IMPORTANT** Make sure the power and compressed air are turned on when removing the racks.

4. Remove manually placed microplates from platepads and external devices.

5. Make sure the x-axis tracks are free of debris.
6 Clean the integrated devices. See the device user documentation for cleanup instructions.

7 Check run logs for errors.

8 If you have administrator or technician privileges and you have modified the protocol, save the protocol.

9 Log out of the operating software. See the *VWorks Automation Control User Guide* for instructions.

### Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>VWorks software run logs and protocols</td>
<td><em>VWorks Automation Control User Guide</em></td>
</tr>
<tr>
<td>Logging in and out of the VWorks software</td>
<td><em>VWorks Automation Control User Guide</em></td>
</tr>
<tr>
<td>Shutting down the BenchCel Workstation</td>
<td>“Shutting down the BenchCel Workstation” on page 61</td>
</tr>
</tbody>
</table>
Replacing the fuse

About this topic

This topic describes how to replace the main fuse in the BenchCel device.

Before you begin

**CAUTION** A blown fuse can indicate more serious problems. If the new fuse blows after replacement, contact Automation Solutions Technical Support.

**CAUTION** Using an incorrect fuse can damage the BenchCel Workstation.

Use only the specified fuse type: 5 A, 250 V, 5 mm x 20 mm, fast acting. You can order fuses from Agilent Technologies.

Procedure

*Tо replace the fuse in the power switch:*

1. Shut down the BenchCel Workstation, and unplug the power cable from the rear panel connector.

2. At the rear panel power switch enclosure, use a small flat-head screwdriver (2.5 mm) to pry open the tab on the fuse enclosure and open the enclosure cover.
3 At the top of the enclosure, insert the screwdriver head in the notch to dislodge the red fuse cartridge. Slide the fuse cartridge all the way out of the enclosure.

4 Replace the fuse or fuses for the type of system you are using:
   - **115 V power.** While maintaining the fuse cartridge orientation relative to the enclosure, replace the fuse on the right side of the cartridge. The cartridge might also contain a second fuse as a spare.
7 Maintenance and troubleshooting
Replacing the fuse

- **230 V power.** Inspect the fuses on each side of the cartridge, and then replace the suspect fuse.

*Figure* Fuse cartridge for 115 V: A) Right side with correctly installed fuse, B) Left side with spare fuse

**IMPORTANT** For 115 V power, ensure the fuse is properly installed in the correct side of the cartridge. Otherwise, the device might not turn on.

**IMPORTANT** For 230 V power, ensure two fuses are installed in the cartridge.

5 Slide the fuse cartridge back into the fuse enclosure.
6 Press the enclosure cover securely into the closed position.
7 Plug in the power cable at the rear panel connector, and then start up the BenchCel Workstation.

**Related information**

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware components</td>
<td>“Hardware overview” on page 14</td>
</tr>
<tr>
<td>Safety</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Starting up and shutting down the BenchCel Workstation</td>
<td>“Starting up and shutting down” on page 60</td>
</tr>
<tr>
<td>How to report a problem</td>
<td>“Reporting problems” on page 148</td>
</tr>
</tbody>
</table>
# Hardware problems

## About this topic

This topic lists possible hardware problems, the causes of the problems, and ways to resolve the problems. If you are still experiencing problems with the BenchCel Workstation after trying the solutions, contact Automation Solutions Technical Support.

## Hardware problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The BenchCel device does not turn on.</td>
<td>Your lab does not meet the electrical requirements.</td>
<td>Make sure your lab meets the electrical requirements. See “Verifying laboratory requirements” on page 35.</td>
</tr>
<tr>
<td>The BenchCel device is not connected to the power source.</td>
<td></td>
<td>Connect the BenchCel device to the power source. See “Connecting the power source” on page 46.</td>
</tr>
<tr>
<td>The fuse is blown.</td>
<td></td>
<td>See “Replacing the fuse” on page 120. A bad fuse could be indicative of other problems. If the fuse blows again, contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td>A hissing sound can be heard.</td>
<td>A leak is present in the air connection or inside the device.</td>
<td>Check the air connections at the back of the device and at the source (house, cylinder, or pump). If the connections look fine, the leak might be inside the device. Contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td>Oil is present in the stacker head.</td>
<td>The compressed air is not from an oil-free compressor and oil has leaked into the BenchCel device.</td>
<td>Contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td>The microplate drops from the robot grippers.</td>
<td>The labware definition for the microplate type might contain incorrect information.</td>
<td>Check the following in the labware definition: Stacker gripper offset, Robot gripper offset, Stacking thickness, Plate thickness, Sensor intensity, and the Plate presence threshold. To check or correct these values, open BenchCel Diagnostics. On the Controls page, click the Labware tab. <strong>Note:</strong> In the Plate offsets (mm) area, type 8 in the Robot gripper offset and the Stacker gripper offset boxes. The recommended offset for most labware is 8 mm. If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
</tbody>
</table>
### Maintenance and troubleshooting

#### Hardware problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The microplate drops or is held loosely by the stacker grippers.</td>
<td>The stacker gripper pressure is too low so that the grippers are holding the microplate too loosely.</td>
<td>Increase the stacker gripper pressure. See “Adjusting the stacker gripper pressure” on page 144.</td>
</tr>
<tr>
<td>The microplate bends when held by the stacker grippers.</td>
<td>The stacker gripper pressure is too high so that the grippers are holding the microplate too tightly.</td>
<td>Decrease the stacker gripper pressure. See “Adjusting the stacker gripper pressure” on page 144.</td>
</tr>
</tbody>
</table>
| The BenchCel device is unable to place a microplate on the target location correctly. | • The teachpoint is incorrect.  
• The robot and the platepad are not aligned along the y-axis (front-to-back direction), see “Integrating external devices” on page 38 to adjust the device positions.  
• The robot grippers and the robot arms are not properly aligned.  
• The robot homing offsets require adjustment. | Verify and edit the teachpoint. See Verifying the teachpoints and “Editing existing teachpoints” on page 83. If you suspect that one of the other factors is responsible for improper microplate placement, contact Automation Solutions Technical Support. |
| A high-pitched sound can be heard when the robot moves up or down.     | The z-axis lacks lubrication.                                                                                                                                                                          | Contact Automation Solutions Technical Support.                                                                                                                                                           |
| The rack-release button does not turn green and the labware rack cannot be removed. | The stack of microplates are still loaded.                                                                                                                                                             | In BenchCel Diagnostics, click the Controls tab. In the graphical display area at the top of the rack, click Stacker, and then choose Unload plates.                                                        |
| More than one microplate was downstacked.                             | The Plate present reading is below the Plate presence threshold.                                                                                                                                      | Use the procedure in “Setting sensor thresholds” on page 85 to adjust the threshold values.                                                                                                                |
| The stack of microplates is dropped onto the shelf during the downstacking procedure. | In the shelf stack-holding method, the stacker gripper offset is too low. So the distance between the grippers and shelves is large.                                                                | Open BenchCel Diagnostics. On the Controls page, click the Labware tab. Increase the Stacker gripper offset. See “Changing labware parameters” on page 140.                                                  |

### Related information

<table>
<thead>
<tr>
<th>For information about…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>BenchCel device component names</td>
<td>“Hardware overview” on page 14</td>
</tr>
<tr>
<td>Software error messages</td>
<td>“Software error messages” on page 125</td>
</tr>
</tbody>
</table>
Software error messages

About this topic

This topic lists possible software error messages, the causes of the errors, and ways to resolve the errors. If you are still experiencing problems with the BenchCel Workstation after trying the solutions, contact Automation Solutions Technical Support.

Software error messages

The following software error messages might appear during a protocol run or when you are using BenchCel Diagnostics. The messages are listed alphabetically.

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Communication timed out| Communication between the controlling computer and the BenchCel device or external device failed. | Try the following:  
1 Verify that the device profile has the correct the COM port number (serial) or Ethernet ID.  
2 Restart the VWorks software.  
3 Restart the BenchCel Workstation.  
4 Check the Ethernet or serial cables.  
5 (Ethernet only) Verify that the Ethernet switch has power.  
If the problem continues, contact Automation Solutions Technical Support. |
### Software error messages

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deadlock detected</td>
<td>The microplate is assigned to the wrong labware class.</td>
<td>Check that the labware belongs to the correct labware class in the Labware Editor. Most microplates should belong to the Uses Standard Plate Pad class. If you created a special class for a particular microplate, make sure it belongs to the special class. For more information about setting up labware classes, see the <em>VWorks Automation Control Setup Guide</em>.</td>
</tr>
<tr>
<td>The protocol run is unable to continue</td>
<td>Some or all of the target locations are unavailable, so the microplates cannot be moved to those locations.</td>
<td>Review the protocol and the run log. Run the simulator to determine the reason for the deadlock. In addition, check that the number of simultaneous microplates is not too high. See the <em>VWorks Automation Control User Guide</em>.</td>
</tr>
</tbody>
</table>
| The device was not found    | The BenchCel device is not connected to the controlling computer, or the incorrect profile is used. | **To connect the device:**
1. Turn off the BenchCel device and exit the VWorks software.
2. Ensure the BenchCel device is connected to the controlling computer. See “Connecting the computer” on page 52.
3. Wait 10 seconds, and then turn on the BenchCel device.
4. Wait for the BenchCel device to finish its homing routine, and then start the VWorks software.
**To check the profile:**
1. In *BenchCel Diagnostics*, click the Profiles tab.
2. Check or select the correct profile. Verify that the profile uses the correct the COM port number (serial) or Ethernet ID. |
<p>| Flash operation not successful | The robot could not write to its flash memory. | In the error message dialog box, click Retry. If clicking Retry does not resolve the problem, restart the BenchCel device. If the problem persists, contact Automation Solutions Technical Support. |
| The gripper positions are too close | The Gripper open position parameter value is less than the Gripper holding plate position parameter value. | In the labware definition, make sure the Gripper open position value is 3 mm or greater than the Gripper holding plate position value. You can change the parameters in the Labware Editor or in BenchCel Diagnostics. |</p>
<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No plate in grippers</td>
<td>The Orientation threshold was used to detect microplate presence, and the sensor readings from all four corners are below the threshold. <strong>Note:</strong> The software always uses the Orientation threshold as a secondary check, even if the Check Orientation option is not selected.</td>
<td>Reduce the Orientation threshold value.</td>
</tr>
<tr>
<td></td>
<td>The Robot gripper offset parameter value is incorrect.</td>
<td>Correct the Robot gripper offset value in the Labware Editor or in BenchCel Diagnostics. An 8-mm offset works for most labware.</td>
</tr>
</tbody>
</table>
| No plate in stack         | The plate-presence sensor does not detect a microplate in the stack because of one or more of the following:  
  - No microplate is in the stack.  
  - Plate presence threshold is not set correctly.  
  - The plate-presence sensor is not working properly. | Verify microplates are loaded in the correct stack.  
If the problem persists, contact Automation Solutions Technical Support. |
| Operation timed out       | The robot was unable to execute a command.                           | In the error message dialog box, click **Retry**. If clicking Retry does not resolve the problem, restart the BenchCel Workstation.  
If the problem persists, contact Automation Solutions Technical Support. |
| Plate in grippers         | The robot senses a microplate in its grippers, but it does not expect to have the microplate for the specified command or action. | In BenchCel Diagnostics, use commands to move and place the microplate at an available teachpoint. Retry the intended command. |
### Software error messages

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate is rotated</td>
<td>The microplate is loaded in the wrong orientation.</td>
<td>Check the microplate orientation (notch selections) in the Labware Editor or in BenchCel Diagnostics. Make sure you load the microplates in the rack accordingly.</td>
</tr>
<tr>
<td>Notch selection is incorrect in the labware definition.</td>
<td>Verify the notch selection in the Labware Editor or in BenchCel Diagnostics.</td>
<td>See “Setting sensor thresholds” on page 85 for detailed instructions.</td>
</tr>
<tr>
<td>The Orientation sensor offset parameter value is incorrect.</td>
<td>Adjust the Orientation sensor offset value in BenchCel Diagnostics.</td>
<td>See “Setting sensor thresholds” on page 85 for detailed instructions.</td>
</tr>
<tr>
<td>The sensor intensity and threshold require adjustment.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Position error on grippers</td>
<td>The robot grippers failed to move to the commanded position. For example, something is blocking the robot.</td>
<td>In the error message dialog box, click Retry. If clicking Retry does not resolve the problem, home the robot and retry the intended command. If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td>Position error on the Theta axis</td>
<td>The robot failed to move to the commanded position. For example, something is blocking the robot.</td>
<td>In the error message dialog box, click Retry. If clicking Retry does not resolve the problem, home the robot and retry the intended command. If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td>Position error on x axis</td>
<td>The robot failed to move to the commanded position. For example, something is blocking the robot.</td>
<td>In the error message dialog box, click Retry. If clicking Retry does not resolve the problem, home the robot and retry the intended command. If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td>Position error on z axis</td>
<td>The robot failed to move to the commanded position. For example, something is blocking the robot.</td>
<td>In the error message dialog box, click Retry. If clicking Retry does not resolve the problem, home the robot and retry the intended command. If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td>Rack not present</td>
<td>The labware rack is not installed on the BenchCel device.</td>
<td>Install the labware rack. See “Installing and uninstalling the labware racks” on page 109 for the procedure.</td>
</tr>
<tr>
<td></td>
<td>The rack-presence sensor is not able to detect the rack because one of the following:</td>
<td>In the BenchCel Diagnostics, click the General Settings tab, and adjust the value in the Rack sensor threshold box. If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td></td>
<td>• The rack sensor threshold is too high.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The rack-presence sensor is not working.</td>
<td></td>
</tr>
</tbody>
</table>
## Maintenance and troubleshooting

### Software error messages

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stack not loaded</td>
<td>The stacker may or may not contain microplates. However, the stacker grippers are open or the shelves are extended when they should not be.</td>
<td>Unload the microplates, if any, from the stacker. If a microplate is held by the stacker grippers, use BenchCel Diagnostics commands to open the stacker grippers to release the microplate. In BenchCel Diagnostics, use commands to retract the shelves or open the stacker grippers. Reload the microplates and retry the intended commands.</td>
</tr>
<tr>
<td>Stacker shelf not extended</td>
<td>The BenchCel device expected the shelves to be already extended but they are not.</td>
<td>In BenchCel Diagnostics, click the Controls tab. In the graphical display area, click Extend Shelf at the desired stacker.</td>
</tr>
<tr>
<td>Stacker shelf not retracted</td>
<td>The BenchCel device expected the shelves to be already retracted but they are not.</td>
<td>In BenchCel Diagnostics, click the Controls tab. In the graphical display area, click Retract Shelf at the desired stacker.</td>
</tr>
<tr>
<td>Stacker shelf position error</td>
<td>The BenchCel device is trying to extend or retract the shelves but was unable to do so.</td>
<td>Check for obstacles in the stacker head that might be blocking the shelves. In BenchCel Diagnostics, click the Controls tab. In the graphical display area, click Extend Shelf or Retract Shelf at the desired stack.</td>
</tr>
<tr>
<td>Thermal cutoff active for theta-axis</td>
<td>The theta motor is overheated. <strong>WARNING</strong> Do not touch the robot head because it might be too hot.</td>
<td>Shut down the BenchCel device and wait for the robot head to cool down before retrying the intended protocol run or commands.</td>
</tr>
<tr>
<td>Theta position out of bounds</td>
<td>The robot is commanded to move out of its range on the theta-axis.</td>
<td>Check the teachpoint theta-axis value to make sure it is not beyond the factory-set limits. If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td>Timeout on grippers</td>
<td>The motor's controller did not respond as expected.</td>
<td>Home the robot, and then move the robot in the same axis. If the robot moves, continue on. If the robot does not move, quit the VWorks software and restart the BenchCel device. If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td>Timeout on theta-axis</td>
<td>The motor's controller did not respond as expected.</td>
<td>Home the robot, and then move the robot in the same axis. If the robot moves, continue on. If the robot does not move, quit the operating software and restart the BenchCel device. If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
</tbody>
</table>
## Software error messages

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeout on x-axis</td>
<td>The motor’s controller did not respond as expected.</td>
<td>Home the robot, and then move the robot in the same axis. If the robot moves, continue on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the robot does not move, quit the operating software and restart the BenchCel device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td>Timeout on z-axis</td>
<td>The motor’s controller did not respond as expected.</td>
<td>Home the robot, and then move the robot in the same axis. If the robot moves, continue on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the robot does not move, quit the operating software and restart the BenchCel device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td>Wrong plate type</td>
<td>The microplate in the stack is different from the labware selected in the software.</td>
<td>Check the labware selected in the Labware Editor or in the BenchCel Diagnostics Controls tab.</td>
</tr>
<tr>
<td></td>
<td>The microplate is loaded in the wrong orientation.</td>
<td>Check the microplate orientation (notch selections) in the labware definition and make sure you load the microplates in the rack accordingly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Setting sensor thresholds” on page 85.</td>
</tr>
<tr>
<td>X position out of bounds</td>
<td>The robot is commanded to move out of its range in the x-axis.</td>
<td>Check the teachpoint x-axis value to make sure it is not beyond the factory-set limits.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
<tr>
<td>Z position out of bounds</td>
<td>The robot is commanded to move out of its range in the y-axis.</td>
<td>Check the teachpoint z-axis value to make sure it is not beyond the factory-set limits.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the problem persists, contact Automation Solutions Technical Support.</td>
</tr>
</tbody>
</table>
### Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>BenchCel device component names</td>
<td>“Hardware overview” on page 14</td>
</tr>
<tr>
<td>Opening BenchCel Diagnostics</td>
<td>“Opening BenchCel Diagnostics” on page 66</td>
</tr>
<tr>
<td>Hardware problems</td>
<td>“Hardware problems” on page 123</td>
</tr>
<tr>
<td>Checking and adjusting the stacker</td>
<td>“Adjusting the stacker gripper pressure” on page 144</td>
</tr>
<tr>
<td>gripper pressure (internal air pressure)</td>
<td></td>
</tr>
<tr>
<td>Reporting problems to Agilent</td>
<td>“Reporting problems” on page 148</td>
</tr>
<tr>
<td>Technologies</td>
<td></td>
</tr>
</tbody>
</table>
Diagnostic tools

About this topic

The BenchCel Diagnostics software has three tabbed pages: Controls, General Settings, and Profile. You use the commands and parameters available in the Controls and General Settings tabs when troubleshooting problems.

This topic explains how to use the commands and parameters in the Controls and General Settings tabs to do the following:

- “Sending the robot to the home position” on page 132
- “Homing the robot” on page 132
- “Disabling and enabling the robot motors” on page 133
- “Jogging the robot” on page 133
- “Changing the robot speed” on page 134
- “Moving plates between teachpoints” on page 137
- “Opening and closing clamps” on page 138
- “Extending and retracting shelves” on page 139
- “Changing labware parameters” on page 140
- “Changing the general settings” on page 142

See “Quick reference” on page 175 for the complete list of available commands.

Sending the robot to the home position

The home position is where the robot head is at the center of the BenchCel device and the robot arms are perpendicular to the x-axis. You send the robot to the home position if you want the robot out of the way in a safe position.

To send the robot to the home position:

1  On the BenchCel Diagnostics Controls page, click the Jog/Teach tab.
2  Click Go Home.

Homing the robot

Homing the robot sends the robot to the factory-defined home position for each axis of motion. The homing process recalibrates the robot position along each axis. Home the robot if you notice that the robot is not accurately picking up or placing plates. You might also want to home the robot after recovering from an emergency stop.
Note: If a labware definition is selected when you click Home motors, the robot grippers return to the Gripper open position defined for the selected labware.

To home the robot:
1. On the BenchCel Diagnostics Controls page, click the Jog/Teach tab.
2. Click Home Motors.

Disabling and enabling the robot motors

Disabling the robot motors allows you to move the robot by hand, making it easier to set and edit teachpoints.

To disable or enable the robot motors:
1. On the BenchCel Diagnostics Controls page, click the Jog/Teach tab.
2. In the Motors Enabled area, select or click the following:

<table>
<thead>
<tr>
<th>Option or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Select the option to enable the ( x )-axis motor. Clear the check box to disable the ( x )-axis motor.</td>
</tr>
<tr>
<td>Z</td>
<td>Select the option to enable the ( z )-axis motor. Clear the check box to disable the ( z )-axis motor.</td>
</tr>
<tr>
<td>Theta</td>
<td>Select the option to enable the ( \theta )-axis motor. Clear the check box to disable the ( \theta )-axis motor.</td>
</tr>
<tr>
<td>Enable All</td>
<td>Click to turn on all the motors.</td>
</tr>
<tr>
<td>Disable All</td>
<td>Click to turn off all the motors.</td>
</tr>
</tbody>
</table>

Jogging the robot

Jogging the robot moves the robot and robot grippers in small, precise increments along one of the axes. You can jog the robot to fine-tune its position when creating and editing teachpoints.
To jog the robot:

1. On the BenchCel Diagnostics Controls page, click the Jog/Teach tab.
2. Enable the robot motors. See “Disabling and enabling the robot motors” on page 133.
3. In the robot movement area, select the jog distance from the corresponding increment list, if applicable.

**CAUTION** Use smaller jog increments than you think you need to ensure that the robot does not bump into obstacles in its path (such as the stacker heads and plate stages).

4. Click the directional button:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Left](5 mm)</td>
<td>Jogs the robot arm counterclockwise from the current position by the specified ( \theta )-axis increment.</td>
</tr>
<tr>
<td>![Right](5 mm)</td>
<td>Jogs the robot arm clockwise from the current position by the specified ( \theta )-axis increment.</td>
</tr>
<tr>
<td>![Up](5 mm)</td>
<td>Jogs the robot head left from the current position by the specified ( x )-axis increment.</td>
</tr>
<tr>
<td>![Down](5 mm)</td>
<td>Jogs the robot head right from the current position by the specified ( x )-axis increment.</td>
</tr>
<tr>
<td>![Up](5 mm)</td>
<td>Jogs the robot head up from the current position by the specified ( z )-axis increment.</td>
</tr>
<tr>
<td>![Down](5 mm)</td>
<td>Jogs the robot head down from the current position by the specified ( z )-axis increment.</td>
</tr>
<tr>
<td>![Open](5 mm)</td>
<td>Opens the robot grippers by the specified grip increment.</td>
</tr>
<tr>
<td>![Close](5 mm)</td>
<td>Closes the robot grippers by the specified grip increment.</td>
</tr>
<tr>
<td><strong>Full Open</strong></td>
<td>Opens the robot grippers to the Robot Gripper Open Position value set in the Labware tab.</td>
</tr>
<tr>
<td><strong>Full Close</strong></td>
<td>Closes the robot grippers to the Robot Gripper Holding Stack value set in the Labware tab.</td>
</tr>
</tbody>
</table>

**Changing the robot speed**

The speed you select in BenchCel Diagnostics applies only to the robot commands in BenchCel Diagnostics (Jog, Move, Transfer, and so on). If the robot is holding a microplate, the slower of the following will be applied: the speed you selected in the Labware Editor or the speed you selected in BenchCel Diagnostics.

You can select the robot speed to accommodate the task you are performing. For example, you can select the Slow speed when you are creating new teachpoints, creating and testing protocols, or diagnosing problems with the system.
You can adjust the speed setting for the $x$-axis, $z$-axis, and \textit{theta}-axis for each speed (high, medium, or slow) as a percentage of the factory-set maximum speed.

\textit{To select the robot speed:}

1. In BenchCel Diagnostics, click the \textbf{Controls} tab.
2. In the \textbf{Speed} list, select \textbf{Fast}, \textbf{Medium}, or \textbf{Slow}.

\textit{Note:} During a protocol run, the robot uses the speed selection in the VWorks Tools > Options dialog box. If the robot is holding a microplate, the slower of the following will be applied: the speed in the Labware Editor or the speed in the Tools > Options dialog box. For more information, see the \textit{VWorks Automation Control User Guide}. 
To set the Slow, Medium, and Fast speeds as a percentage of the factory-set maximum speed:

1. On the General Settings tab, click Speed Settings.

2. In the Speed Settings dialog box, type the percentage of the factory-set maximum speed for the axis speed setting.

Note: The factory speed settings for all three axes are Slow 20%, Medium 40%, Fast 80%.

Note: The speed settings apply to the speeds you select in BenchCel Diagnostics, Labware Editor, and the VWorks Options dialog box.

3. Click OK to save the changes.
Moving plates between teachpoints

You can move a microplate between teachpoints when you are verifying a teachpoint or to determine whether to home the motors.

**CAUTION** To prevent collision, remove obstacles in the path of the robot.

*To move plates between teachpoints:*

1. Manually place a microplate at one of the two teachpoints.
2. In BenchCel Diagnostics, click the Controls tab, and then select the **Slow** speed.

3. In the graphical display area, click the plus sign (➕) at either of the following:
   - The teachpoint you want to move to
   - Two teachpoints between which you want to move a plate

   The selected teachpoints should be highlighted in red circles (➕).

4. Rest the pointer on a selected teachpoint. In the command menu that appears, select one of the following:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to <code>&lt;teachpoint&gt;</code></td>
<td>Moves the robot from its current position to the selected teachpoint. The robot stays at the teachpoint.</td>
</tr>
<tr>
<td>Pick from <code>&lt;teachpoint&gt;</code></td>
<td>Picks up the microplate from the selected teachpoint and moves the plate to the ready-for-upstack position under the stacker head.</td>
</tr>
<tr>
<td>Place at <code>&lt;teachpoint&gt;</code></td>
<td>Moves the robot from its current position and places the microplate at the selected teachpoint. After placing the microplate, the robot backs away from the teachpoint into the safe zone.</td>
</tr>
</tbody>
</table>
Opening and closing clamps

The clamps in the stacker head close and open the grippers at the bottom of the labware rack to hold and release the first plate in position for the robot grippers. Compressed air is used to move the clamps.

The clamps close and open the stacker grippers automatically during the loading, unloading, downstacking, and stacking procedures. When diagnosing problems or after an aborted run, you can use the commands in BenchCel Diagnostics to open or close the clamps (stacker grippers). For example, you might want to open the clamps (stacker grippers) to remove a microplate.

**CAUTION** Opening the clamps (stacker grippers) might cause the microplate or stack of microplates to drop.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer to &lt;teachpoint&gt;</td>
<td>Moves a microplate from the currently selected teachpoint. To transfer a microplate from a stack, you must first click <strong>Load Stacker</strong>. During the transfer, the robot downloads the plate, places it at the other selected teachpoint, and then backs into the safe zone. If the robot is transferring a plate from one teachpoint to another, the robot picks up the microplate from the currently selected teachpoint, places the microplate at the other selected teachpoint, and then backs into the safe zone.</td>
</tr>
<tr>
<td>Delid from &lt;teachpoint&gt;</td>
<td><em>Lidded labware only.</em> Removes the lid from the labware that is at the selected teachpoint.</td>
</tr>
<tr>
<td>Relid to &lt;teachpoint&gt;</td>
<td><em>Lidded labware only.</em> Replaces the lid on the labware that is at the selected teachpoint.</td>
</tr>
</tbody>
</table>
To open or close the clamps (stacker grippers):

1. In the BenchCel Diagnostics, click the Controls tab.
2. In the graphical display area at the top of the rack, click Stacker, and then choose Open stacker grippers or Close stacker grippers. A click sounds as the clamps (stacker grippers) open or close.

Extending and retracting shelves

The shelves in the stacker head are used to hold the stack of labware temporarily during the downstacking and upstacking processes. Resting the microplates on the shelves levels the microplates, allowing the robot grippers to accurately hold the microplate at the specified offset position. Compressed air is used to move the shelves.

The shelves extend and retract automatically during the downstacking and upstacking processes. When diagnosing problems or after an aborted run, you can use the commands in BenchCel Diagnostics to extend or retract the shelves.

**CAUTION** Retracting the shelves might cause the microplate or stack of microplates to drop.
To extend or retract the shelves:

1. In BenchCel Diagnostics, click the Controls tab.
2. In the graphical display area at the top of the desired rack, click Stacker, and then choose Extend Shelves or Retract Shelves. A click sounds as the shelves extend or retract.

Changing labware parameters

When testing new or troubleshooting existing labware definitions, you can use BenchCel Diagnostics to make changes to some of the labware parameters without opening Labware Editor. For example, you can change the stacking thickness, gripper offsets, notch specification, and lid specifications.

Note: Changes you make to the labware parameters in BenchCel Diagnostics are also updated in the Labware Editor.

Before you begin

Calculate the values for the labware sensor thresholds. See the procedure in “Setting sensor thresholds” on page 85.
Procedure

To change the labware parameters:

1. On the Controls page, select the labware definition from the Labware list.

2. Click the Labware tab and make your changes to the labware parameters.
   - Plate Dimensions. See “BenchCel Diagnostics - Labware tab” on page 183.
   - Sensors. See “Setting sensor thresholds” on page 85.
   - Plate Offsets. See “BenchCel Diagnostics - Labware tab” on page 183.
   - Robot Gripper Positions. See “BenchCel Diagnostics - Labware tab” on page 183.

3. If you want to check for notches, under Notch Locations, select Check Orientation, and then select one or more of the microplate corners to indicate the notch location.

4. If you plan to process lidded microplates:
   a. Under Lidded Plate Parameters (mm), select the Can have lid? check box.
   b. Under the graphical display area on the Controls page, select the Plates have lids check box.
   c. In the Lidded Plate Parameters (mm) area, type the following values after you verify the measurements. For details on measuring these parameters, see “BenchCel Diagnostics - Labware tab” on page 183.
      - Lidded thickness
      - Lidded stacking thickness
      - Lid gripper offset
      - Lid resting height
      - Lid departure height
      - Gripper holding lid position

5. To make changes to other labware parameters, click Editor. You can make changes in the Labware Editor. See the VWorks Automation Control Setup Guide for instructions on using the Labware Editor.

6. Click Apply and save labware parameters.
Changing the general settings

**CAUTION** Be careful when changing the general settings. Changes in this tab will affect existing protocols.

**CAUTION** The changes are stored in the BenchCel flash memory. The changes you make to the general settings will take affect any time you are using this BenchCel device regardless of profile, protocol file, or device file.

**To change general settings:**

1. In **BenchCel Diagnostics**, click the **General Settings** tab.
2. In the **Stack Settings** area, type a new value for the parameter you want to change.

### Setting | Comment
--- | ---
Rack sensor threshold | The value above which a rack is considered present at the rack-presence sensor.
Low pressure threshold (psi) | The value at or below which the system will display a low-pressure warning. The default factory setting is 30 psi.
Note: If this value is too low, the device could drop microplates without generating a low air-pressure warning.
3 Select **Home robot after protocol run finishes** if you want the robot to return to its home position after the protocol run is finished.

**IMPORTANT**  **Home robot after protocol run finishes** applies to all BenchCel devices that are controlled by the same computer running the VWorks software.

4 **Optional.** To change the speed, click **Speed Settings.** See “Changing the robot speed” on page 134 for instructions.

5 Click **OK** to apply and save the new setting values.

**Related information**

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to open BenchCel Diagnostics</td>
<td>“Opening BenchCel Diagnostics” on page 66</td>
</tr>
<tr>
<td>How to report a problem</td>
<td>“Reporting problems” on page 148</td>
</tr>
<tr>
<td>Defining labware</td>
<td><em>VWorks Automation Control Setup Guide</em></td>
</tr>
<tr>
<td>Teachpoints</td>
<td>“Setting and managing teachpoints” on page 72</td>
</tr>
<tr>
<td>Installing and removing labware racks</td>
<td>“Installing and uninstalling the labware racks” on page 109</td>
</tr>
</tbody>
</table>
Adjusting the stacker gripper pressure

About this topic

This topic explains how to check the stacker gripper pressure (internal air pressure) and how to adjust it.

Stacker gripper pressure

Compressed air is used to move the clamps that open and close the labware rack grippers and the shelves that level the microplates. See “Hardware overview” on page 14 for the location of these components.

Although the required air pressure from your lab is 0.65 to 0.69 MPa (95 to 100 psi), the BenchCel device down-regulates the pressure inside the device.

Typically, no adjustment is required for the internal air pressure. You might want to adjust the pressure when troubleshooting Load Plate problems or when you want to load different labware on the same BenchCel Workstation.

In general, you can set the internal air pressure within the range of 30 to 50 psi. For plates that are flexible and tend to bend, you should decrease the air pressure. For less flexible plates, you can increase the air pressure.

For each plate type or application, you should run optimization tests to determine the best internal pressure setting.

Note: Each stacker has an air pressure sensor, but the air pressure for each pair of stackers is controlled by one regulator.

Before you start

Make sure you turned on the air supply at the source (house, cylinder, or pump).

Checking the internal air pressure

To check the internal air pressure:

1. In BenchCel Diagnostics, click the Controls tab.
2. Click the Jog/Teach tab.
3. In the Stacker Sensors area, check the air pressure value.
Adjusting the internal air pressure

**To adjust the internal air pressure:**

1. At the front of the BenchCel device, lift the magnetic circular cover to gain access to the air-pressure regulator.

   **Figure** Accessing the BenchCel air-pressure regulator

   ![Figure](image)

   Lift cover to access the air pressure regulator.

2. Turn the lock nut counterclockwise to unlock the air pressure regulator knob.

   **Figure** Unlocking the air-pressure regulator

   ![Figure](image)

   Turn counterclockwise to unlock.
3 Turn the air pressure regulator knob. Turning the knob clockwise increases the internal air pressure. Turning the knob counterclockwise decreases the internal air pressure.

Figure  Adjusting the air pressure

4 On the Jog/Teach tab, check the air pressure value. A valid air pressure value displays only when the stacker grippers are closed.

Figure  BenchCel Diagnostics Jog/Teach tab

5 At the front of the BenchCel device, turn the lock nut clockwise to lock the air-pressure regulator knob. This prevents accidental adjustments.
6 At the front of the BenchCel device, place the magnetic cover over the air-pressure regulator opening.

Related information

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air pressure requirements</td>
<td>“Compressed air requirements” on page 36</td>
</tr>
<tr>
<td>How to open BenchCel Diagnostics</td>
<td>“Opening BenchCel Diagnostics” on page 66</td>
</tr>
<tr>
<td>How to report a problem</td>
<td>“Reporting problems” on page 148</td>
</tr>
<tr>
<td>Hardware problems</td>
<td>“Hardware problems” on page 123</td>
</tr>
<tr>
<td>Software error messages</td>
<td>“Software error messages” on page 125</td>
</tr>
</tbody>
</table>
Reporting problems

About this topic

If you have a technical problem that you cannot resolve after reading the maintenance and troubleshooting instructions, read the information in this topic for how to report hardware, software, and user guide problems.

Contacting Automation Solutions Technical Support

If you find a problem with the BenchCel Workstation, contact Automation Solutions Technical Support at one of the following:

Europe
Phone: +44 (0)1763853638
email: euroservice.automation@agilent.com

US and rest of world
Phone: 1.800.979.4811 (US only) or +1.408.345.8011
email: service.automation@agilent.com

Note: You can also send a software bug report from within the VWorks software.

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number of the device ready. You can locate the serial number on the front and back of the BenchCel device.

Figure  BenchCel device front and back views

Serial number labels
Reporting software problems

When you contact Automation Solutions Technical Support, make sure you provide the following:

- Short description of the problem
- Software version number
- Error message text (or screen capture of the error message dialog box)
- Screen capture of the About VWorks software dialog box.
- Relevant software files

*To find the VWorks software version number:*
In the VWorks software, select **Help > About VWorks.**

*To find the BenchCel Diagnostics software version number:*

1. Open **BenchCel Diagnostics.**
2. Read the version number on the title bar of the diagnostics window.

*To send compressed protocol and associated files in VZP format:*
In the VWorks software, select **File > Export** to export and compress the following files:

- Protocol file
- Device file (includes the device profile and teachpoint file)
- Labware definitions
- Liquid classes
- Pipette techniques
- Hit-picking files
- Plate map files
- Barcode files
- Error library
- Log files

Reporting user guide problems

If you find a problem with this user guide or have suggestions for improvement, send your comments using one of the following methods:

- Click the feedback button (_subset) in the online help.
- Send an email to documentation.automation@agilent.com.
## Related information

<table>
<thead>
<tr>
<th>For more information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolving hardware problems</td>
<td>“Hardware problems” on page 123</td>
</tr>
<tr>
<td>Resolving software errors</td>
<td>“Software error messages” on page 125</td>
</tr>
<tr>
<td>Safety information</td>
<td>“Safety guidelines” on page 1</td>
</tr>
<tr>
<td>Hardware description</td>
<td>“Hardware overview” on page 14</td>
</tr>
</tbody>
</table>
A

BenchCel ActiveX control

This chapter gives integrators the ActiveX control information required to integrate another company's lab automation device into the BenchCel Workstation.

The ActiveX has been verified to work with both Visual Studio 6 and Visual Studio .NET (v 7.1).

This chapter contains the following topics:

- “About ActiveX controls” on page 152
- “Properties” on page 153
- “Methods” on page 155
- “Events” on page 171
About ActiveX controls

What is the BenchCel ActiveX control

The BenchCel ActiveX control is the software component that allows the BenchCel Workstation to interact with a third-party lab automation system.

How the BenchCel ActiveX control is used

In an Agilent Technologies automation system, the VWorks software is already configured to interface with the BenchCel Workstation. The operator can control the device using the software.

In a third-party lab automation system, you use ActiveX to enable the third-party software to interface with the BenchCel Workstation. Each ActiveX control consists of a collection of the following:

- **Methods.** Functions that can be called to invoke individual operations
- **Properties.** Attributes or features of the BenchCel ActiveX control
- **Events.** Notifications that methods have completed or resulted in errors

When integrating the BenchCel Workstation in a lab automation system, you need to know the available methods and properties for the ActiveX control.

The following diagram illustrates the use of the BenchCel ActiveX control in a lab automation system environment. Actions you perform are conducted through ActiveX methods. System responses are relayed back through ActiveX events.
Properties

*IPictureDisp* ControlPicture

**Description**
Read-only property that the client can use to get an icon to represent the ActiveX control.
This example paints a BenchCel bitmap over a button.

**Visual C++ example**
/*The CPicture class is imported into your project when the ActiveX is installed*/
   CButton button;
   //Create a button
   CPicture BenchCelPic;
   BenchCelPic = m_BenchCel.GetControlPicture();
   //Retrieve the picture
   button.SetBitmap((HBITMAP)BenchCelPic.GetHandle());
   /*Paint the bitmap onto the button*/

**Visual Basic example**
'Assume that there is a button
'named Command1 on the
'current form. You must set
'the style property of
'Command1 to Graphical
   Command1.Picture = BenchCel.ControlPicture

**SHORT Speed**

**Description**
Property to specify how fast the BenchCel device should move. 0 = slow, 1 = medium, 2 = fast. This property should not be changed during an operation. Setting this property to an invalid value will have no effect (call will be ignored).

**Visual C++ example**
//Set the speed to fast
   m_BenchCel.speed = 2;

**Visual Basic example**
'Set the speed to fast
   BenchCel.Speed = 2
## BOOL Blocking

**Description**
Specifies whether the ActiveX should block during an execution of a command. If true, commands, such as PickAndPlace, will not return until the action completes or an error occurs. If false, the command will return immediately without waiting for the action to complete and invoke an event to indicate successful completion of the command. Errors will be indicated through one of two means; 1) the return value might not be S_OK (0), in this case, no event will be fired; 2) an error event is fired. When an error occurs, the ActiveX expects a call to Abort, Retry or Ignore. ShowDiagsDialog can be called to allow the user to exercise specific diagnostic/corrective functions, but when the main execution resumes, a call to Abort, Retry or Ignore is necessary to continue the operation.

**Visual C++ example**
declare
m_BenchCel.Blocking = TRUE;

**Visual Basic example**
Set the BenchCel device to block until the command completes
m_BenchCel.Blocking = 1;

---

### Related topics

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>BenchCel Workstation ActiveX methods</td>
<td>“Methods” on page 155</td>
</tr>
<tr>
<td>BenchCel Workstation ActiveX events</td>
<td>“Events” on page 171</td>
</tr>
<tr>
<td>Overview of the ActiveX controls</td>
<td>“About ActiveX controls” on page 152</td>
</tr>
<tr>
<td>Reporting problems</td>
<td>“Reporting problems” on page 148</td>
</tr>
</tbody>
</table>
Methods

Abort

LONG Abort()

Description
Method to clear an error and state information.

Parameters
None

Returns
S_OK if success; other value otherwise

Visual C++ example
m_BenchCel.Abort();

Visual Basic example
BenchCel.Abort;

AboutBox

void AboutBox()

Description
Shows a small window that indicates some version information.

Parameters
None

Returns
None

Visual C++ example
BenchCel.AboutBox();

Visual Basic example
m_BenchCel.AboutBox();

Close

void Close()

Description
Method to disconnect from the BenchCel device.

Parameters
None

Returns
None
**Visual C++ example**

```c++
m_BenchCel.Close();
```

**Visual Basic example**

```vbnet```
BenchCel.Close
```

**Delid**

LONG Delid(BSTR DelidFrom, BSTR DelidTo, LONG nRetractionCode)

**Description**

Method used to remove a lid from a microplate. You will need to specify where the microplate is located and where to place the lid once it is removed from the microplate.

**Parameters**

<table>
<thead>
<tr>
<th>Argument Type</th>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BSTR</td>
<td>DelidFrom</td>
<td>Available teachpoints</td>
<td>Name of teachpoint where the microplate with the lid is located.</td>
</tr>
<tr>
<td>BSTR</td>
<td>DelidTo</td>
<td>Available teachpoints</td>
<td>Optional. Name of teachpoint to place the lid after it has been removed from the microplate. The BenchCel robot will hold onto the lid if the DelidTo parameter is empty.</td>
</tr>
<tr>
<td>LONG</td>
<td>nRetractionCode</td>
<td>0–3</td>
<td>How to position the robot arms after delidding the microplate, where 0– Do nothing 1– Retract normally 2– Not supported 3– Not supported</td>
</tr>
</tbody>
</table>

**Returns**

S_OK if successful; other value if there was an error.

**EnumerateProfiles**

VARIANT EnumerateProfiles()

**Description**

Method to retrieve a list of defined profiles. The strings in this array are the options that should be used for Initialize.

**Parameters**

None
Returns
An array of profile names.

Visual C++ example
```c
VARIANT vProfiles = m_BenchCel.EnumerateProfiles();
SAFEARRAY *psa = vProfiles.parray;
BSTR* bstrArray;
if (FAILED(SafeArrayAccessData(psa, reinterpret_cast<void**>(
    &bstrArray))))
{
    VariantClear(&vProfiles);
    return;
}
for (ULONG i = 0; i < psa->rgsabound[0].cElements; i++)
{
    MessageBox(CString(bstrArray[i]));
}
SafeArrayUnaccessData(psa); VariantClear(&vProfiles);
```

Visual Basic example
```vb
profileNames = BenchCel.EnumerateProfiles()
For i = LBound(profileNames) To UBound(profileNames)
    MsgBox profileNames(i)
Next
```

GetFirmwareVersion

BSTR GetFirmwareVersion()

Description
Method to programmatically retrieve firmware version of the device.

Parameters
None

Returns
A version string.

Visual C++ example
```c
CString strFirmVer = m_BenchCel.GetFirmwareVersion();
```

Visual Basic example
```vb
Version = BenchCel.GetFirmwareVersion()
```

GetLabwareNames

VARIANT GetLabwareNames()

Description
Method to retrieve a list of defined labware. The strings in this array are the options that should be used for SetLabware.

Parameters
None
Returns
An array of labware names.

Visual C++ example
VARIANT vLabware = m_BenchCel.GetLabwareNames();
SAFEARRAY *psa = vLabware.parray;
if
(FAILED(SafeArrayAccessData(psa, reinterpret_cast<void**>(
&bstrArray)))
{
VariantClear(&vLabware);
return;
}
for (ULONG i = 0; i < psa->rgsabound[0].cElements; i++)
{
MessageBox(CString(bstrArray[i]));
}
SafeArrayUnaccessData(psa); VariantClear(&vLabware);

Visual Basic example
LabwareNames = BenchCel.GetLabwareNames
For i = LBound(labwareNames) To UBound(labwareNames)
MsgBox labwareNames(i)
Next

GetLastError

BSTR GetLastError()

Description
Method to retrieve a text message explaining the last error. This method can be called in blocking mode, after a command returns with a failure code, or in non-blocking mode, after the Error event has been fired.

Parameters
None

Returns
An error string.

Visual C++ example
strError = m_BenchCel.GetLastError();

Visual Basic example
strError = BenchCel.GetLastError()

GetStackCount

LONG GetStackCount(LONG *pCount)

Description
Method to retrieve the number of stacks on the BenchCel device. This method must be called after a successful connection in order for it to indicate the current number.
Methods

Parameters

<table>
<thead>
<tr>
<th>Argument Type</th>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LONG*</td>
<td>pCount</td>
<td>Valid pointer to receive the stack count</td>
<td>If successful, the value pointed to by pCount should indicate the number of stacks the device has</td>
</tr>
</tbody>
</table>

Returns

S_OK if successful; other value otherwise.

Visual C++ example

```c++
RESULT = m_BenchCel.GetStackCount(&numStacks);
```

Visual Basic example

```vb
RESULT = BenchCel.GetStackCount(numStacks)
```

GetTeachpointNames

VARIANT GetTeachpointNames()

Description

Method to retrieve the teachpoints known to the device. This method must be called after initialization is complete and it returns an array of available teachpoints, including the stackers.

Parameters

None

Returns

A safe array of teachpoint names.
Methods

Visual C++ example

VARIANT vTeachpoints = m_BenchCel.GetTeachpointNames();
SAFEARRAY *psa = vTeachpoints.parray;
BSTR* bstrArray;
if (FAILED(SafeArrayAccessData(psa,reinterpret_cast<void**>(
    &bstrArray))))
{
    VariantClear(&vTeachpoints);
    return;
}
for (ULONG i = 0; i < psa->rgsabound[0].cElements; i++)
{
    MessageBox(CString(bstrAdday[i]));
}
SafeArrayUnaccessData(psa);VariantClear(&vTeachpoints);

Visual Basic example

TeachpointNames = BenchCel.GetTeachpointNames
For i= LBound(teachpointNames) To UBound(teachpointNames)
    MsgBox teachpointNames(i)
Next

GetVersion

BSTR GetVersion()

Description
Method to programmatically retrieve the version of the ActiveX.

Parameters
None

Returns
A version string.

Visual C++ example

CString strVersion = m_BenchCel.GetVersion();

Visual Basic example

Version = BenchCel.GetVersion()

Ignore

LONG Ignore()

Description
Method to ignore the previously issued error. This is not a recommended
course of action, as the errors are issued for a reason. However, ignoring some
errors, such as “Plate is rotated”, can be appropriate if the operator
understands the implications.

Parameters
None
Returns
S_OK if success; other value otherwise.

Visual C++ example

    m_BenchCel.Ignore();

Visual Basic example

    BenchCel.Ignore

Initialize

LONG Initialize(BSTR Profile)

Description
Method to connect to the BenchCel device. A BenchCel profile specifies how to connect to the device (serial or Ethernet; if Ethernet, which device on the network and if serial, which port to use) and which teachpoint file to use. If this is called in non-blocking mode, the client application should wait for InitializeComplete before calling other methods. This method should be called before most other methods.

Parameters

<table>
<thead>
<tr>
<th>Argument Type</th>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BSTR</td>
<td>Profile</td>
<td>Valid profile name</td>
<td>The name of the profile to be used for initialization</td>
</tr>
</tbody>
</table>

Returns
S_OK (0) on success; other value otherwise.

Visual C++ example

    LONG1Result = m_BenchCel.Initialize("ethernet");

Visual Basic example

    LONG1Result = BenchCel.Initialize("ethernet")

IsConnected

LONG IsConnected()

Description
Method used to check whether a connection to the BenchCel device is established. The BenchCel device is ready to process commands from the BenchCel Active X driver when a connection has been established (using the Initialize() method).

Parameters
None
Returns
1 if there is a connection and 0 if disconnected.

IsPlatePresent

LONG IsPlatePresent(SHORT sStack, [in, out] VARIANT_BOOL* pPresent)

Description
Method to test whether a stack has a microplate and is loaded. If the stack is not loaded, the result returned through pPresent will not be meaningful. The stack number is 0-based. This method should be called after a successful connection.

Parameters

<table>
<thead>
<tr>
<th>Argument Type</th>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHORT</td>
<td>sStack</td>
<td>0 to n-1, where n is the number of stacks</td>
<td>Which stack to check</td>
</tr>
<tr>
<td>VARIANT_BOOL*</td>
<td>pLoaded</td>
<td>Valid pointer to receive whether a microplate is present</td>
<td>On a successful call, the value pointed to by pPresent should indicate whether the stack is loaded and has a microplate available for downstacking</td>
</tr>
</tbody>
</table>

Returns
S_OK if successful, other value otherwise.

Visual C++ example

```
1Result = m_Benchcel.IsPlatePresent(1,&bPlatePresent);
```

Visual Basic example

```
1Result = BenchCel.IsPlatePresent(1,bPlatePresent)
```

IsStackLoaded

LONG IsStackLoaded(SHORT sStack, [in, out] VARIANT_BOOL* pLoaded)

Description
Method to test whether a stack has been loaded. The stack number is 0-based. This method should be called after a successful connection.

Parameters

<table>
<thead>
<tr>
<th>Argument Type</th>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHORT</td>
<td>sStack</td>
<td>0 to n-1, where n is the number of stacks</td>
<td>Which stack to check</td>
</tr>
</tbody>
</table>
**LoadStack**

LONG LoadStack(SHORT sStack)

**Description**
Method to release a stack. To downstack from or upstack to a stack, the stack must be loaded. A loaded stack is locked into the stacker head and cannot be freely taken from the device. The stack number is 0-based.

**Parameters**

<table>
<thead>
<tr>
<th>Argument Type</th>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHORT</td>
<td>sStack</td>
<td>0 to n-1, where n is the number of stacks</td>
<td>The stack to be loaded</td>
</tr>
</tbody>
</table>

**Returns**
S_OK if successful; other value otherwise.

**Visual C++ example**

```cpp
1Result = m_BenchCel.LoadStack(0);
```

**Visual Basic example**

```vbnet
1Result = BenchCel.LoadStack(0)
```
MoveToHomePosition

LONG MoveToHomePosition()

Description
Method to move the device to the origin. This method is not commonly used.

Parameters
None

Returns
S_OK if successful; other value otherwise.

Visual C++ example
1Result = BenchCel.MoveToHomePosition();

Visual Basic example
1Result = BenchCel.MoveToHomePosition()

OpenClamp

LONG OpenClamp(SHORT sStack)

Description
Method used to open the stacker grippers of a given stack.

Parameters

<table>
<thead>
<tr>
<th>Argument Type</th>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHORT</td>
<td>sStack</td>
<td>0 – (number of Stacks – 1)</td>
<td>Specify which stack’s gripper to open</td>
</tr>
</tbody>
</table>

Returns
S_OK if successful; other value if there was an error.

Pause

LONG Pause()

Description
Disables the motors on the BenchCel device and pauses the motion. See also the Unpause method.

IMPORTANT After the motors are disabled, the robot head and arms might have momentum and continue to move until they come to the end of the x-axis, z-axis, or theta-axis, or until they bump into an obstacle.

Parameters
None

Returns
S_OK if successful; other value if there was an error.
PickAndPlace

LONG PickAndPlace(BSTR PickFrom, BSTR PlaceTo, VARIANT_BOOL bLidded, LONG nRetractionCode)

**Description**
Method to transfer a microplate. Stacker locations are called “Stacker 1”, “Stacker 2”, etc. Downstacking can be specified by using a stacker location for PickFrom and upstacking can be specified by using a stacker location for PlaceTo. bLidded indicates whether the robot should treat the microplate as if it has a lid. nRetractionCode should be 3 (reserved for future options).

**Parameters**

<table>
<thead>
<tr>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PickFrom</td>
<td>valid teachpoint name</td>
<td>Destination to pick from</td>
</tr>
<tr>
<td>PlaceTo</td>
<td>valid teachpoint name</td>
<td>Destination to place to</td>
</tr>
<tr>
<td>bLidded</td>
<td>VARIANT_TRUE, VARIANT_FALSE</td>
<td>Whether the microplate is lidded</td>
</tr>
<tr>
<td>nRetractionCode</td>
<td>0–3</td>
<td>0– Do nothing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1– Retract normally</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2– Not supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3– Not supported</td>
</tr>
</tbody>
</table>

**Returns**
S_OK if success; other value otherwise.

**Visual C++ example**
```
1Result = m_BenchCel.PickAndPlace("Stacker 1", "PlateLoc", FALSE, 2)
```

**Visual Basic example**
```
1Result = BenchCel.PickAndPlace("Stacker 1", "PlateLoc", FALSE, 2)
```

ProtocolStart

LONG ProtocolStart()

**Description**
Method to be called at the beginning of a run. The device is not expected to move.

**Parameters**
None

**Returns**
S_OK on success; other value on failure.
Visual C++ example
1Result = m_BenchCel.ProtocolStart();

Visual Basic example
1Result = BenchCel.ProtocolStart()

ProtocolFinish

LONG ProtocolFinish()

Description
Method to be called at the end of a run. The device might home during this call.

Parameters
None

Returns
S_OK if success; other value otherwise.

Visual C++ example
1Result = m_BenchCel.ProtocolFinish();

Visual Basic example
1Result = BenchCel.ProtocolFinish()

ReleaseStack

LONG ReleaseStack(SHORT sStack)

Description
Method to release a stack. A released stack can be freely taken from the device for the loading or unloading of microplates. However, the BenchCel Workstation cannot downstack from or upstack to a released stack. The stack number is 0-based.

Note: This method can also be used to perform the close clamp function.

Parameters

<table>
<thead>
<tr>
<th>Argument Type</th>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHORT</td>
<td>sStack</td>
<td>0 to n-1, where n is the number of stacks</td>
<td>The stack to be released</td>
</tr>
</tbody>
</table>

Returns
S_OK if successful, other value otherwise.
### Visual C++ example

```c++
1Result = m_BenchCel.ReleaseStack(0);
```

### Visual Basic example

```vbnet
1Result = BenchCel.ReleaseStack(0)
```

#### Relid

**LONG Relid(BSTR RelidFrom, BSTR RelidTo, LONG nRetractionCode)**

**Description**

Method used to put a lid on a microplate. You will need to specify where the lid is located and where the microplate is located. If the RelidFrom argument is blank, it is expected that the robot is holding the lid.

**Parameters**

<table>
<thead>
<tr>
<th>Argument Type</th>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BSTR</td>
<td>RelidFrom</td>
<td>Available teachpoints or blank string</td>
<td>Name of teachpoint where the lid is located</td>
</tr>
<tr>
<td>BSTR</td>
<td>RelidTo</td>
<td>Available teachpoints</td>
<td>Name of teachpoint where microplate that is getting the lid is located</td>
</tr>
<tr>
<td>LONG</td>
<td>nRetractionCode</td>
<td>0–3</td>
<td>How to position the robot arms after relidding the microplate, where</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0– Do nothing</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1– Retract normally</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2– Not supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3– Not supported</td>
</tr>
</tbody>
</table>

**Returns**

S_OK if successful; other value if there was an error.

#### Retry

**LONG Retry()**

**Description**

Method to retry an action after an error occurred. For example, if there is insufficient air pressure during a LoadStack operation, the application can call Retry after the air pressure has been increased.

**Parameters**

None

**Returns**

S_OK if success; other value otherwise.
**SetLabware**

LONG SetLabware(BSTR bstrLabware)

**Description**
Method to set the labware to use. The selection will be in effect for all operations until a different labware is set. If diagnostics are shown and the user selects a different labware, the original labware will be restored when the diagnostics window is closed. This method should not be called when any movement is in progress.

**Parameters**

<table>
<thead>
<tr>
<th>Argument Type</th>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BSTR</td>
<td>bstrLabware</td>
<td>Valid labware name</td>
<td>Labware to be used for subsequent operations</td>
</tr>
</tbody>
</table>

**Returns**
S_OK if successful; other value if there was an error.

**Visual C++ example**

`lResult = m_BenchCel.SetLabware("MyPlateType");`

**Visual Basic example**

`lResult = BenchCel.SetLabware("MyPlateType")`

**ShowDiagsDialog**

LONG ShowDiagsDialog(BOOL bModal, SHORT iSecurityLevel)

**Description**
Method to show the graphical diagnostics menu that allows the user to troubleshoot and correct problems. This method can be called before Initialize to create a profile.

**Parameters**

<table>
<thead>
<tr>
<th>Argument Type</th>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>bModal</td>
<td>TRUE,FALSE</td>
<td>Whether the diagnostics should be shown modally</td>
</tr>
</tbody>
</table>

**Visual C++ example**

`m_BenchCel.Retry();`

**Visual Basic example**

`BenchCel.Retry`
Methods

BenchCel Microplate Handling Workstation R-Series User Guide

Returns
LONG —no meaning.

Visual C++ example
m_BenchCel.ShowDiagsDialog(TRUE,0);

Visual Basic example
BenchCel.ShowDiagsDialog 1, 0

ShowLabwareEditor

LONG ShowLabwareEditor(BOOL bModal, BSTR bstrLabware)

Description
Method to display the labware editor graphical user interface. Through this interface dialog, the user can specify labware parameters that will be used by the device to handle the microplates. Parameters such as microplate height and notch information will be associated with a labware name, which can be used by SetLabware to indicate to the device how to handle the next microplate.

Parameters

<table>
<thead>
<tr>
<th>Argument Type</th>
<th>Argument Name</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHORT</td>
<td>iSecurityLevel</td>
<td>0-3</td>
<td>The security level that the user has to operate the diagnostics</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 = Administrator</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 = Technician</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 = Operator</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 = Guest</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>−1 - No access</td>
</tr>
<tr>
<td>BOOL</td>
<td>bModal</td>
<td>TRUE, FALSE</td>
<td>Whether to show the editor modally or not</td>
</tr>
<tr>
<td>BSTR</td>
<td>bstrLabware</td>
<td>Valid labware name</td>
<td>The labware to be selected when the editor is displayed</td>
</tr>
</tbody>
</table>

Returns
S_OK if successful; other value otherwise.
**Visual C++ example**

```cpp
m_BenchCel.ShowLabwareEditor(1,"MyPlateType");
```

**Visual Basic example**

```vbnet
BenchCel.ShowLabwareEditor 1,"MyPlateType"
```

### Unpause

```cpp
LONG Unpause()
```

#### Description

Re-enables the motors on the BenchCel device. The BenchCel device will resume any remaining movements that were in progress before the call to pause the device.

See also the Pause method.

#### Parameters

None

#### Return

S_OK if successful; other value if there was an error.

### Related topics

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>BenchCel Workstation ActiveX properties</td>
<td>“Properties” on page 153</td>
</tr>
<tr>
<td>BenchCel Workstation ActiveX events</td>
<td>“Events” on page 171</td>
</tr>
<tr>
<td>Overview of the ActiveX controls</td>
<td>“About ActiveX controls” on page 152</td>
</tr>
<tr>
<td>Reporting problems</td>
<td>“Reporting problems” on page 148</td>
</tr>
</tbody>
</table>
Events

About events

The events listed in this topic occur only if Blocking is set to false or 0.

Error

Description
This event starts when an error occurs during any BenchCel Workstation operation or initialization.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>SHORT</td>
<td>Not used.</td>
</tr>
<tr>
<td>Description</td>
<td>BSTR*</td>
<td>Description of the error.</td>
</tr>
<tr>
<td>Scode</td>
<td>LONG</td>
<td>Not used.</td>
</tr>
<tr>
<td>Source</td>
<td>BSTR</td>
<td>Name of the device where the error occurs, for example, BenchCel.</td>
</tr>
<tr>
<td>HelpFile</td>
<td>BSTR</td>
<td>Not used.</td>
</tr>
<tr>
<td>HelpContext</td>
<td>LONG</td>
<td>Not used.</td>
</tr>
<tr>
<td>CancelDisplay</td>
<td>BOOL*</td>
<td>Set to TRUE to disable the stock event handler behavior, which is to display a dialog box with the description in it.</td>
</tr>
</tbody>
</table>

Returns
None.

DelidComplete

Description
This event occurs after completing a delid operation.

Parameters
None.

Returns
None.

InitializeComplete

Description
This event occurs after the device successfully initializes.
Events

Parameters
None.

Returns
None.

LoadStackComplete

Description
This event occurs after completing a load stack operation.

Parameters
None.

Returns
None.

MoveToHomePositionComplete

Description
This event occurs after completing a move to home position.

Parameters
None.

Returns
None.

PickComplete

Description
This event occurs after completing a pick operation.

Parameters
None.

Returns
None.

PlaceComplete

Description
This event occurs after completing a place operation.

Parameters
None.

Returns
None.
ProtocolFinishComplete

Description
This event occurs after completing a protocol finish operation.

Parameters
None.

Returns
None.

ProtocolStartComplete

Description
This event occurs after completing a protocol start operation.

Parameters
None.

Returns
None.

ReleaseStackComplete

Description
This event occurs after completing a release stack operation.

Parameters
None.

Returns
None.

RelidComplete

Description
This event occurs after completing a relid operation.

Parameters
None.

Returns
None.

Related topics

<table>
<thead>
<tr>
<th>For information about...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>BenchCel Workstation ActiveX methods</td>
<td>“Methods” on page 155</td>
</tr>
<tr>
<td>BenchCel Workstation ActiveX properties</td>
<td>“Properties” on page 153</td>
</tr>
<tr>
<td>For information about...</td>
<td>See...</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Overview of the ActiveX controls</td>
<td>“About ActiveX controls” on page 152</td>
</tr>
<tr>
<td>Reporting problems</td>
<td>“Reporting problems” on page 148</td>
</tr>
</tbody>
</table>
Quick reference

This appendix provides a quick reference of the following:

- “Rack-release button indicator light” on page 176
- “BenchCel Diagnostics - Controls tab” on page 177
- “BenchCel Diagnostics - Jog/Teach tab” on page 180
- “BenchCel Diagnostics - Labware tab” on page 183
- “BenchCel Diagnostics - General Settings tab” on page 188
- “BenchCel Diagnostics - Profiles tab” on page 189
- “Teachpoint Details dialog box” on page 193
The rack-release button at the top of each stacker head displays different colors to indicate the status of the adjacent labware rack. The following table lists the possible colors and the corresponding status description.

<table>
<thead>
<tr>
<th>Color of indicator light</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| Green                   | The labware rack is installed correctly on the BenchCel device and the stack of microplates are unloaded.  
  • The stack of microplates are ready for processing.  
  • You can unlock and remove the labware rack. |
| Green, flashing         | The labware rack is unlocked and can be removed. |
| Blue                    | A microplate is loaded and the labware rack cannot be removed. |
| Red                     | The clamps are open without a rack installed. Do not install a rack until the clamps are closed. |
BenchCel Diagnostics - Controls tab

The Controls tab contains the following areas:

- “Graphical display area” on page 177
- “BenchCel Diagnostics - Jog/Teach tab” on page 180
- “BenchCel Diagnostics - Labware tab” on page 183

Graphical display area
<table>
<thead>
<tr>
<th>Selection or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labware</td>
<td>Specifies the selected labware.</td>
</tr>
<tr>
<td>Editor</td>
<td>Starts the Labware Editor.</td>
</tr>
<tr>
<td>Plates have lids</td>
<td>Indicates that the labware you selected for processing have lids.</td>
</tr>
<tr>
<td>Speed</td>
<td>Specifies the relative speed at which the robot head and arms moves: Fast, Medium, and Slow. See “Changing the robot speed” on page 134. This speed control applies only in BenchCel Diagnostics.</td>
</tr>
<tr>
<td>Load All</td>
<td>Places all the stacks of labware on the shelves in preparation for a protocol run. After a stack of labware is loaded, you cannot remove the labware rack.</td>
</tr>
<tr>
<td>Unload All</td>
<td>Places all the stacks of labware on the stacker grippers so that you can remove the labware racks.</td>
</tr>
<tr>
<td>Stacker n - Load plates</td>
<td>Moves a microplate on the shelves at the specified stacker in preparation for a downstack process or protocol run.</td>
</tr>
<tr>
<td>Stacker n - Unload plates</td>
<td>Moves the microplate back on the stacker grippers so that you can remove the labware rack.</td>
</tr>
<tr>
<td>Stacker n - Unlock rack</td>
<td>Retracts the locking pin to allow you to remove the labware rack.</td>
</tr>
<tr>
<td>Stacker n - Open stacker gripper</td>
<td>Opens the clamps that open the stacker grippers in the labware rack.</td>
</tr>
<tr>
<td>Stacker n - Close stacker gripper</td>
<td>Closes the clamps that close the stacker grippers in the labware rack.</td>
</tr>
<tr>
<td>Stacker n - Extend shelf</td>
<td>Extends the shelf at the specified stack.</td>
</tr>
<tr>
<td>Stacker n - Retract shelf</td>
<td>Retracts the shelf at the specified stack.</td>
</tr>
<tr>
<td>Move to Stacker n</td>
<td>Moves the robot into position to grip a microplate in the stack.</td>
</tr>
<tr>
<td>Downstack from Stacker n</td>
<td>Moves the first microplate from the specified labware rack in preparation for a protocol run.</td>
</tr>
<tr>
<td>Upstack to Stacker n</td>
<td>Moves the microplate into the specified labware rack.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the Teachpoint Details dialog box. See “Teachpoint Details dialog box” on page 193.</td>
</tr>
<tr>
<td>Move to sensor</td>
<td>Moves the microplate to the sensor offset position.</td>
</tr>
<tr>
<td>Selection or command</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Move to &lt;teachpoint&gt;</td>
<td>Moves the robot from its current position to the selected teachpoint.</td>
</tr>
<tr>
<td>Pick from &lt;teachpoint&gt;</td>
<td>Picks up the plate from the selected teachpoint, and then the robot backs away from the teachpoint into the safe zone.</td>
</tr>
<tr>
<td>Place at &lt;teachpoint&gt;</td>
<td>Moves the robot from its current position and places the plate at the selected teachpoint. After placing the plate, the robot backs away from the teachpoint into the safe zone.</td>
</tr>
<tr>
<td>Transfer to &lt;teachpoint&gt;</td>
<td>Moves a plate from the currently selected teachpoint to the other selected teachpoint. To transfer a plate from a stack, you must first click Load Stacker. During the transfer, the robot downstacks the plate, places it at the other selected teachpoint, and then backs into the safe zone. If the robot is transferring a plate from one teachpoint to another, the robot picks up the plate from the currently selected teachpoint, places the plate at the other selected teachpoint, and then backs into the safe zone.</td>
</tr>
<tr>
<td>Delid from &lt;teachpoint&gt;</td>
<td><em>Lidded labware only.</em> Removes the lid from the labware that is at the selected teachpoint.</td>
</tr>
<tr>
<td>Relid to &lt;teachpoint&gt;</td>
<td><em>Lidded labware only.</em> Replaces the lid on the labware that is at the selected teachpoint.</td>
</tr>
</tbody>
</table>
BenchCel Diagnostics - Jog/Teach tab

You use the Jog/Teach tab for the following procedures:

- “Setting and managing teachpoints” on page 72
- “Setting sensor thresholds” on page 85
- “Sending the robot to the home position” on page 132
- “Homing the robot” on page 132
- “Disabling and enabling the robot motors” on page 133
- “Jogging the robot” on page 133

Stacker Sensors area

<table>
<thead>
<tr>
<th>Setting, status, or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stacker list</td>
<td>The stacker identifier, numbered from left to right. For example, to select the left-most stacker, select 1.</td>
</tr>
<tr>
<td>Plate presence</td>
<td>The plate-presence sensor reading.</td>
</tr>
<tr>
<td>Air (psi)</td>
<td>The internal air pressure measurement, in psi.</td>
</tr>
<tr>
<td>Notch Sensors</td>
<td></td>
</tr>
<tr>
<td>A1</td>
<td>The plate-orientation sensor reading for the A1 corner of the microplate.</td>
</tr>
<tr>
<td>Top-right</td>
<td>The plate-orientation sensor reading for the top-right corner of the microplate.</td>
</tr>
<tr>
<td>Bottom-left</td>
<td>The plate-orientation sensor reading for the bottom-left corner of the microplate.</td>
</tr>
<tr>
<td>Bottom-right</td>
<td>The plate-orientation sensor reading for the bottom-right corner of the microplate.</td>
</tr>
<tr>
<td>Orientation threshold</td>
<td>The value that determines the presence of a microplate notch. A notch is present if the value is below this value. If the sensor value is above this threshold, no notch is reported. The default value is 100.</td>
</tr>
</tbody>
</table>

*Note:* The setting is also available in the Labware tab.
### Plate presence threshold

The value that determines if a microplate is detected. Any value equal to or greater than the threshold means a microplate is present. A lesser value means there is no microplate.

*Note:* The setting is also available in the Labware tab.

### Apply & save

The command that saves the updated settings in the Jog/Teach tab.

## Robot movement area

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CCW</strong></td>
<td>Jogs the robot arm counterclockwise from the current position by the specified ( \theta )-axis increment.</td>
</tr>
<tr>
<td><strong>CW</strong></td>
<td>Jogs the robot arm clockwise from the current position by the specified ( \theta )-axis increment.</td>
</tr>
<tr>
<td><strong>Left</strong></td>
<td>Jogs the robot head left from the current position by the specified ( x )-axis increment.</td>
</tr>
<tr>
<td><strong>Up</strong></td>
<td>Jogs the robot head up from the current position by the specified ( z )-axis increment.</td>
</tr>
<tr>
<td><strong>Right</strong></td>
<td>Jogs the robot head right from the current position by the specified ( x )-axis increment.</td>
</tr>
<tr>
<td><strong>Down</strong></td>
<td>Jogs the robot head down from the current position by the specified ( z )-axis increment.</td>
</tr>
</tbody>
</table>

### Gripper

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open</strong></td>
<td>Opens the robot grippers by the specified grip increment.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Closes the robot grippers by the specified grip increment.</td>
</tr>
<tr>
<td><strong>Full open</strong></td>
<td>Opens the robot grippers to the robot Gripper open position set in the Labware tab.</td>
</tr>
<tr>
<td><strong>Full close</strong></td>
<td>Closes the robot grippers to the robot Gripper holding plate position set in the Labware tab.</td>
</tr>
</tbody>
</table>

### Go Home

Moves the robot head to the home position, which is at the center of the BenchCel device, and the robot arms are perpendicular to the \( x \)-axis. You send the robot to the home position if you want the robot out of the way in a safe position.
BenchCel Diagnostics - Jog/Teach tab

## Teachpoint area

<table>
<thead>
<tr>
<th>Selection or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select teachpoint</td>
<td>Allows you to select from the list of available teachpoint files.</td>
</tr>
<tr>
<td>New teachpoint</td>
<td>Opens the Teachpoint Details dialog box. See “Teachpoint Details dialog box” on page 193.</td>
</tr>
</tbody>
</table>

## Motors Enabled area

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Enables or disables the $x$-axis motor. Select the check box to enable the motor. Clear the check box to disable the motor.</td>
</tr>
<tr>
<td>Z</td>
<td>Enables or disables the $z$-axis motor. Select the check box to enable the motor. Clear the check box to disable the motor.</td>
</tr>
<tr>
<td>Theta</td>
<td>Enables or disables the $\theta$-axis motor. Select the check box to enable the motor. Clear the check box to disable the motor.</td>
</tr>
<tr>
<td>Enable all</td>
<td>Enables all of the robot motors simultaneously.</td>
</tr>
<tr>
<td>Disable all</td>
<td>Disables all of the robot motors simultaneously.</td>
</tr>
</tbody>
</table>
BenchCel Diagnostics - Labware tab

You can use the Labware tab to perform the following procedures:

- “Setting sensor thresholds” on page 85
- “Changing labware parameters” on page 140

The settings in the Labware tab are also available in the Labware Editor.

<table>
<thead>
<tr>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
</tr>
<tr>
<td>Apply and save labware parameters</td>
</tr>
<tr>
<td>Saves the updated settings in the Labware tab.</td>
</tr>
</tbody>
</table>

### Plate Dimensions area

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thickness</td>
<td>The distance (mm) from the bottom surface of the plate to the top surface of the plate. For a tipbox, this is the distance from the bottom surface of the tipbox to the top of the tips. To increase the number of contact points, measure the distance at the corner of the plate or tipbox (using calipers). This method is especially useful if the plate has a lip at the top which could cause the caliper to angle inward, producing inaccurate measurements.</td>
</tr>
</tbody>
</table>
### Parameters | Description
--- | ---
Stacking thickness | The thickness (mm) of two stacked plates minus the thickness of one plate. For example: Thickness of two stacked plates \((x) = 23.14\) mm Thickness of one plate = 14.14 mm Stacking thickness: 23.14 mm - 14.14 mm = 9.00 mm

### Sensors area

| Parameters | Description |
--- | ---
Orientation threshold | The value that determines the presence of a microplate notch. A notch is present if the value is below this value. If the sensor value is above this threshold, no notch is reported. To check the sensors and for adjustment guidelines, see “Setting sensor thresholds” on page 85. Note: The setting is also available in the Jog/Teach tab. |
Plate presence threshold | The value that determines if a microplate is detected. Any value equal to or greater than the threshold means a microplate is present. A lesser value means there is no microplate. Note: The setting is also available in the Jog/Teach tab. |
Intensity (all sensors) | The intensity of the emitting sensor light. The value is a percent of the maximum intensity. Default: 50%. Some microplates are more reflective than others. Increase the intensity if microplate sensor readings are too low (not significantly higher than the corresponding threshold value) when either a microplate is present, or a notch is absent. Note: This setting applies to the plate-presence sensor, orientation sensor, and the rack-presence sensor. Changing this setting affects the sensor readings of the four orientation sensors. Always adjust the intensity and threshold values together. To check the sensors and for adjustment guidelines, see “Setting sensor thresholds” on page 85. |
## Plate Offsets (mm) area

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Robot gripper offset</td>
<td>The distance (mm) from the bottom of a microplate to where the robot grippers will hold the microplate.</td>
</tr>
<tr>
<td>Stacker gripper offset</td>
<td>The distance (mm) from the bottom of a microplate to where the stacker grippers will hold the microplate.</td>
</tr>
<tr>
<td>Orientation sensor offset</td>
<td>The distance (mm) from the bottom of a microplate to where the orientation sensors will check for notches. See the procedure in “Determining the optimum Orientation sensor offset” on page 93.</td>
</tr>
</tbody>
</table>

## Robot Gripper Positions (mm) area

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gripper open position</td>
<td>The distance (mm) the grippers move from the home position as the robot releases a microplate. A larger value moves the grippers closer together. A smaller value opens the grippers wider.</td>
</tr>
</tbody>
</table>
| Gripper holding plate position | The distance (mm) that the grippers move inward from their home position when holding a microplate that is not in a stack. A larger value moves the grippers closer together and holds the microplate tighter. A smaller value opens the grippers wider.  
  Note: How tightly the robot grippers should hold a microplate depends on the microplate material and design. You might want to run some tests to optimize the parameter. |
| Gripper holding stack position | The distance (mm) the grippers move inward from the home position when holding a microplate that is in a stack. A larger value moves the grippers closer together and holds the microplate tighter. A smaller value opens the grippers wider.  
  Note: Because the weight of the entire stack will be on the robot grippers, you should use a value greater than the Gripper holding plate parameter. |

## Notch Locations (mm) area

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check orientation</td>
<td>Turns on or turns off the plate-orientation sensors. Select the check box to turn on the sensors. Clear the check box to turn off the sensors.</td>
</tr>
</tbody>
</table>
### Options | Description
--- | ---
Plate check boxes | Indicates that the plate A1 corner has a notch. Clear the check box if the A1 corner does not have a notch.

#### Upper right corner
Indicates that the plate upper right corner has a notch. Clear the check box if the upper right corner does not have a notch.

#### Lower left corner
Indicates that the plate lower left corner has a notch. Clear the check box if the lower left corner does not have a notch.

#### Lower right corner
Indicates that the plate lower right corner has a notch. Clear the check box if the lower right corner does not have a notch.

### Lidded Plate Parameters (mm) area

#### Parameters | Description
--- | ---
Can have lid? | The option to include a microplate lid. If you select this option and plan to process lidded microplates, make sure you select the Plates have lids check box under the graphical display area.

Lidded thickness | The thickness (mm) of the plate with a lid in place. Available only if Can have lid? is selected.

Lidded stacking thickness | The stacking thickness (mm) of the plate with the lid in place. Available only if Can have lid? is selected.

Lid gripper offset | The height (mm) above the lid resting height at which to grip the lid. (Shown as b below.)

![Diagram showing lid gripper offset](image)
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lid resting height</td>
<td>The height (mm) above the bottom of the plate at which the bottom of a plate lid rests. (Shown as a below.)</td>
</tr>
<tr>
<td>Lid departure height</td>
<td>The height (mm) above the bottom of the plate to which the lid is lifted.</td>
</tr>
<tr>
<td>Gripper holding lid position</td>
<td>The distance (mm) the grippers move inward from home position when holding a microplate lid. Increasing the value moves the grippers closer together and holds the lid tighter. Decreasing the value opens the grippers wider. In general, type a value that is less than the Gripper holding plate position to open the grippers slightly. Holding the lid too tightly might cause the microplate to be lifted with the lid.</td>
</tr>
</tbody>
</table>
You use the General Settings tab to adjust various settings. See “Changing the general settings” on page 142.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stack Settings area</td>
<td></td>
</tr>
<tr>
<td>Rack sensor threshold</td>
<td>Any value at or higher than this means a rack is present. Below this value means there is no rack.</td>
</tr>
<tr>
<td>Low pressure threshold (psi)</td>
<td>The value at or below which the system displays a low-pressure warning.</td>
</tr>
<tr>
<td></td>
<td>Default value: 30 psi</td>
</tr>
<tr>
<td></td>
<td>Note: If this value is too low, the device could drop microplates without generating a low air-pressure warning.</td>
</tr>
<tr>
<td>Home robot after protocol run finishes</td>
<td>The option to return the robot to its home position after the protocol run is finished.</td>
</tr>
<tr>
<td></td>
<td>This option applies to all BenchCel devices that are controlled by the same computer running the VWorks software.</td>
</tr>
</tbody>
</table>
BenchCel Diagnostics - Profiles tab

You use the Profiles tab to create and initialize profiles. See “Creating profiles” on page 68.

The Profiles tab contains the following:

- **Profile Management area** on page 190
- **Settings area** on page 191
- **Teachpoint file area** on page 192

**CAUTION** Each profile can be used by multiple protocols. Deleting, renaming, or changing the parameters for a profile based on one protocol can invalidate other protocols that use the profile.

---

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed settings</td>
<td>The command that opens the Speed Settings dialog box, which enables you to set each speed (Slow, Medium, and Fast) as a percentage of the factory-set maximum speed.</td>
</tr>
<tr>
<td>Show current settings</td>
<td>The command that displays the parameter values that were last saved.</td>
</tr>
<tr>
<td>Write settings to file</td>
<td>The command that allows you to save the Advanced Settings information to a file.</td>
</tr>
<tr>
<td>Apply</td>
<td>The command that applies the changes so that the new values are used.</td>
</tr>
</tbody>
</table>
### Profile Management area

The Profile Management area contains the following controls.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile name list</td>
<td>Specifies the active profile. Select the profile that you want to use from the list.</td>
</tr>
<tr>
<td>Create a new profile</td>
<td>Displays the Create Profile dialog box so that you can name the new profile. To add a profile, see “Creating profiles” on page 68.</td>
</tr>
<tr>
<td>Create a copy of this profile</td>
<td>Creates a copy of the profile selected in the Profile list. The new profile name has the prefix, Copy of.</td>
</tr>
<tr>
<td>Rename this profile</td>
<td>Displays the Rename Profile dialog box so that you can rename the profile selected in the Profile list.</td>
</tr>
<tr>
<td>Delete this profile</td>
<td>Confirms the profile to be deleted, and then deletes the selected profile from the Profile list.</td>
</tr>
<tr>
<td>Update this profile</td>
<td>Saves changes to the selected profile.</td>
</tr>
</tbody>
</table>
## Settings area

<table>
<thead>
<tr>
<th>Selections and commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>This BenchCel is connected via ethernet</strong></td>
<td>Specifies an Ethernet connection for communication between the controlling computer and the device.</td>
</tr>
<tr>
<td><strong>Device ID</strong></td>
<td>Displays the selected device.</td>
</tr>
<tr>
<td><strong>Find available device</strong></td>
<td>Opens the Discovered BioNet Devices dialog box. You select the BenchCel device in the dialog box to establish communication between the controlling computer and the device. Available if you select the Ethernet connection.</td>
</tr>
<tr>
<td><strong>This BenchCel is connected via serial</strong></td>
<td>Specifies a serial connection for communication between the controlling computer and the device.</td>
</tr>
<tr>
<td><strong>Serial port</strong></td>
<td>Specifies which COM port on the computer is connected to the device.</td>
</tr>
<tr>
<td><strong>Use flow control</strong></td>
<td>Allows the BenchCel device to stop the flow of data from the computer before it overruns the device communication buffer. Select this option to optimize communication via the serial connection.</td>
</tr>
<tr>
<td><strong>Number of stacks</strong></td>
<td>Enables you to create a profile for a BenchCel device that has a different number of stacks than the one connected to the controlling computer.</td>
</tr>
</tbody>
</table>

**IMPORTANT** During initialization, the software automatically detects the actual number of stacks on the BenchCel device. If this number differs from the number specified by the profile, an error message appears and gives you the option to Abort, Retry, or Ignore. If you click Ignore, the software overwrites the Number of stacks value with the actual number of stacks.
## Teachpoint file area

<table>
<thead>
<tr>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>...</td>
<td>Allows you to select an existing teachpoint file for the profile.</td>
</tr>
<tr>
<td>New</td>
<td>Allows you to change the teachpoint file name or storage location from the default. The default teachpoint file name is <code>Teachpoints_&lt;profilename&gt;.xml</code>, where <code>&lt;profilename&gt;</code> is the name of the profile. The software saves the file in the <code>C:\VWorks Workspace</code> folder.</td>
</tr>
</tbody>
</table>
Teachpoint Details dialog box

You can use the Teachpoint Details dialog box to enter a new teachpoint ("Determining the teachpoint coordinates" on page 73) or edit an existing teachpoint.

To open this dialog box:

Do one of the following:

- On the Jog/Teach tab, click New teachpoint.
- In the graphical display area of the Controls page, double-click the plus sign (➕) for the teachpoint of interest.

<table>
<thead>
<tr>
<th>Parameter or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the teachpoint. For example, if the teachpoint is on an integrated Microplate Labeler, you might want to name the teachpoint Labeler. This name appears in the graphical display area on the Controls page.</td>
</tr>
<tr>
<td>Theta</td>
<td>The angle that the robot arms are from their home position, in degrees. A positive value moves the arms counterclockwise from the home position. A negative value moves the arms clockwise from the home position. The range of movement is from -115° to 115°.</td>
</tr>
</tbody>
</table>
### Teachpoint Details dialog box

<table>
<thead>
<tr>
<th>Parameter or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>The horizontal distance (mm) from the home position. A positive value moves the robot head to the right of the home position. A negative value moves the robot head to the left of the home position. The range of movement depends on the number of stacker heads. For two stacker heads, the range is from -145 mm to 145 mm.</td>
</tr>
<tr>
<td>Z</td>
<td>The vertical distance from the home or lowest z-axis position. A positive value moves the robot head up from the home position. A negative value moves the head down from the home position. The range of movement is from -1.5 mm to 104 mm. <strong>IMPORTANT</strong> Ensure the Z value is greater than -1.5 mm. If it is not, jog the z-axis up to obtain a value that is larger. Otherwise, the software will issue a z-position out-of-bounds error if a plate with a smaller robot gripper offset is used.</td>
</tr>
<tr>
<td>Use current positions</td>
<td>The command that reads the robot's current coordinates and writes them in the Theta, X, and Z boxes.</td>
</tr>
<tr>
<td>Approach height</td>
<td>The height clearance (mm) the robot maintains above the teachpoint as it moves towards or away from the teachpoint location. The valid range is from 0 mm to 40 mm. Use this setting to prevent the robot from colliding with raised tabs or walls at the teachpoint location. You can start with the approach height set to 20 mm (default). However, if there is an obstruction above the teachpoint, a smaller approach height might be required to prevent a collision. <strong>Note:</strong> This value applies when the robot is holding a microplate. When it is not holding a microplate, the robot will approach the teachpoint at the height of the teachpoint, unless you select the Respect approach height when not holding a plate option.</td>
</tr>
</tbody>
</table>

![Diagram of approach height](image)
### Parameter or command | Description
--- | ---
Cavity depth | This setting is not commonly used and should be set at 0 mm for most applications. You can use this setting to account for teachpoints that have a depth (or negative height). To do this, type the depth (mm) as an offset to the Robot gripper offset. A positive value causes the grippers to grab higher on the plate by the specified amount. A negative values causes the grippers to grab lower on the plate. For example, suppose the Robot gripper offset is 5 mm and the platepad you want to use has depth of 9 mm. When the microplate sits in the platepad, the robot grippers cannot reach the offset height, as the following diagram shows. To account for this depth, you can set the Cavity depth at –9 mm. The robot grippers will grip the microplate 9 mm above the 5 mm offset (at 14 mm).

![Cavity depth diagram]

Gripper open limit | The maximum distance (mm) the robot grippers are allowed to open as they prepare to grip the microplate at the teachpoint. The maximum value you set is less than or equal to the Robot Gripper Open Position value set in the Labware tab. Use this setting if the teachpoint area is narrower than the robot grippers open position. (To see this value, click Save and exit, and then click the Labware tab on the Controls page.)

*Note:* This value is used only at the teachpoint and not during other operations.

Respect approach height when not holding a plate | Select the check box to use the approach height even when the robot is not holding labware.

*CAUTION* If you want to clear this check box, verify that the grippers will not run into the locating tabs of the stage. Otherwise, clearing this check box can result in a crash.
<table>
<thead>
<tr>
<th>Parameter or command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Something is above this point</td>
<td>The option to limit the robot’s movements within the robot safe zone. With this selection, the robot will only move along the ( \theta )-axis as long as all of its parts (head, arms, and grippers) are within the safe zone when approaching or moving away from the teachpoint.</td>
</tr>
<tr>
<td>Clear the check box to allow the robot to use the workspace. The robot’s ( \theta )-axis movements are not limited when approaching and moving away from the teachpoint.</td>
<td></td>
</tr>
<tr>
<td>Select the check box to limit the robot’s movements to prevent collision when approaching a teachpoint. For example, when moving labware to and from a multi-shelf device such as the Vertical Pipetting Station, this option prevents the robot from colliding with the shelf above the target teachpoint.</td>
<td></td>
</tr>
</tbody>
</table>
clamps (BenchCel) The components inside of the stacker head that close and open the stacker grippers during the loading, unloading, downstacking, and upstacking processes.

controlling computer The lab automation system computer that controls the devices in the system.

cycle See seal cycle.

deadlock An error that occurs when the number of locations available in the system is less than the number of microplates in the system. Because the microplates cannot move to the expected locations, the protocol pauses.

device An item on your lab automation system that can have an entry in the device file. A device can be a robot, an instrument, or a location on the lab automation system that can hold a piece of labware.

device file A file that contains the configuration information for a device. The device file has the .dev file name extension and is stored in the folder that you specify when saving the file.

downstack The process in which a microplate is moved out of the stack.

error handler The set of conditions that define a specific recovery response to an error.

home position The position where all robot axes are at the 0 position (the robot head is approximately at the center of the x-axis and at 0 of the z-axis, and the robot arms are perpendicular to the x-axis).

homing The process in which the robot is sent to the factory-defined home position for each axis of motion.

hot plate (PlateLoc) A heated metal plate inside the sealing chamber that descends and presses the seal onto the plate.

insert A pad placed under the plate to support the bottom of the wells for uniform sealing.

location group A list of labware that can be moved into or out of particular slots in a storage device.

plate group A list of specific labware that can be moved into or out of a storage device without regard for the slot locations.

plate instance A single labware in a labware group that is represented by the process plate icon.

plate stage The removable metal platform on which you load a plate.

plate-stage support The structure on which you load a plate stage. The plate-stage support extends when the door opens.

profile The Microsoft Windows registry entry that contains the communication settings required for communication between a device and the VWorks software.

process A sequence of tasks that are performed on a particular labware or a group of labware.

protocol A schedule of tasks to be performed by a standalone device, or devices in the lab automation system.

regrip station A location that enables the robot to change its grip orientation (landscape or portrait), or adjust its grip at the specified gripping height. Grip height adjustment might be necessary after a robot picks up a labware higher than the specified gripping height because of physical restrictions at a teachpoint.

robot grippers The components that the robot uses to hold labware.

run A process in which one or more microplates are processed. In a standalone device, the run consists of one cycle. In a lab automation system, a run can consist of multiple cycles that are automated.

safe zone The boundary within which the robot is allowed to move without colliding with external devices.

seal cycle The process in which a single plate is sealed on the PlateLoc Sealer.

seal entry slot The narrow entry on the back of the PlateLoc Sealer where the seal is inserted into the device.

seal-loading card A rectangular card that is used to facilitate the seal loading process on the PlateLoc Sealer.

seal-roll support The triangular structures at the top of the PlateLoc Sealer where a roll of seal is mounted.
Glossary

**sealing chamber** The area inside of the PlateLoc Sealer where the seal is applied to a plate.

**shelves (BenchCel)** The components inside of the stacker head that provide leveling surfaces for the microplates, thus ensuring accurate robot gripping, during the downstacking process.

**stacker grippers** The padding at the bottom of the stacker racks that hold microplates when a microplate is loaded, downstacked, or upstacked.

**subprocess** A sequence of tasks performed as a subroutine within a protocol. Typically the subprocess is performed by a single device type, such as the Bravo device.

**task** An operation performed on one or more labware.

**task parameters** The parameters associated with each task in a protocol. For example, in a labeling task, the parameters include the label value.

**teachpoint** A set of coordinates that define where the robot can pick up or place labware and the location of a known object.

**teachpoint file** The XML file that contains the settings for one or more device teachpoints.

**touch screen** The interface on the front of the PlateLoc Sealer where sealing parameters are set, the seal cycle can be started or stopped, and the seal cycle can be monitored.

**upstack** The process in which a microplate is moved back into the stack.

**waypoint** A set of coordinates that define a location the robot passes through on its way to a teachpoint.

**workspace** The boundary within which the robot can move without limitations.
Index

A
AC power entry, 17
AC power, connecting, 46
accessories, 23
ActiveX
   described, 29, 152
   Error event, 171
   methods, 155
   properties, 153
air
   connecting and disconnecting, 50
   disconnecting, 51
   leaks, checking, 51
   pressure regulator, 16
   pressure, internal, 117, 144
   requirements, 36
   safety, 9
   tubing maintenance, 117
   uses for, 20, 21
air-input fitting, 17
ANSI standards, 26
Approach height parameter, 79
axes of motion
   described, 15
   jogging the robot, 133

B
back view, 17
barcode reader, 24
bench requirements, 35

c
Can have lid option, 141, 186
Cavity depth parameter, 80, 195
chemical safety, 9
clamps
   described, 20
   opening and closing, 138
components, 12
computer
   connecting, 52
   requirements, 37
connection panel, 17
context-sensitive help, ix
Controls tab quick reference, 177

d
deadlock, 126
Delid from command, 138
devices
   compatible devices, 25
defined, 62
device file, adding devices, 62
device file, creating, 63
device file, saving, 62
device files defined, 62
integrating, 44
integrating procedure, 43
integration options, 25
MAC address, 70
profiles in, 68
third-party, integrating, 44
Diagnostics
   opening, 66
Diagnostics software
   clamps, opening and closing, 138
   Controls tab quick reference, 177
   described, 29
   disabling and enabling robot motors, 133
   general settings, 142
   General Settings tab quick reference, 188
   homing the robot, 132
   Jog/Teach tab quick reference, 180
   jogging the robot, 134
   labware parameters, changing, 141
   Labware tab quick reference, 183
   Profiles tab quick reference, 189
   profiles, creating, 68
   robot speed, changing, 134
   Sending robot to home position, 132
   shelves, extending and retracting, 139
   Teachpoint Details dialog box reference, 193
   teachpoints, moving between, 137
tools, 132
dimensions, 35
downstacking process, 21, 75, 139

e
electrical requirements, 36
environmental requirements, 37
errors
   messages, 125
   reporting, 148, 149
Ethernet
   connection setup, 53, 54
   networking considerations, 38
   port location, 17
   profile selection, 69

f
features
   back view, 17
Index

front view, 14
overview, 12
front view, 14
fuse
  replacing, 120
  specifications, 36

G
gas cylinder safety, 9
General Settings tab
  changing parameters, 142
  described, 31
  quick reference, 188
Gripper holding lid position parameter, 141, 187
Gripper holding plate position parameter, 185
Gripper holding stack position parameter, 185
Gripper open limit parameter, 80, 195
Gripper open position parameter, 185

H
hardware
  back view, 17
  connection panel, 17
  errors, 148
  front view, 14
  maintenance, 116
  troubleshooting problems, 123
hazardous-voltage electronics hazards, 9
high-pressure gas safety, 9
home position, 132
Home robot after protocol finishes option, 143
homing the robot, 60, 132

I
infrared sensors, 8, 18
installing the workstation
  air, connecting and disconnecting, 50
  computer, connecting, 52
  laboratory requirements, 35
  mounting the robot, 41
  pendant, connecting, 48
  power, connecting, 46
  safety shield, 55
  workflow, 34
integrating devices
  integration plate, 44
  options, 25
  procedure, 43
integration plate, accessory, 24
Intensity (all sensors) parameter, 184
interlock circuit, 7, 16, 17
IP address, 54

J
job roles for readers of this guide, vi
Jog/Teach tab quick reference, 180
jogging the robot, 134

K
knowledge base, vii, viii

L
labels
  safety, 2
  serial number, 148
laboratory space requirements, 35
labware
  characteristics that affect automation, 27
  lidded, 27
  loading into racks, 107
  parameters, changing, 141
  requirements, 26
  unloading from racks, 107, 108
labware definitions, about creating, 28
labware racks
  accessory, 24
  described, 14, 22
  filling and emptying, 105
  handling safely, 103
  rack-release button, 112
  uninstalling, 112
Labware tab quick reference, 183
Lid departure height parameter, 141, 187
Lid gripper offset parameter, 141, 186
Lid resting height parameter, 141, 187
lidded microplates, 27
Lidded stacking thickness parameter, 141, 186
Lidded thickness parameter, 141, 186
local area network considerations, 38, 53
Low pressure threshold parameter, 142

M
MAC address, 70
maintenance
  adjusting stacker gripper pressure, 144
  fuse, replacing, 120
  reporting problems, 148
  routine, 116
methods, ActiveX, 155
microplates
  characteristics that affect automation, 27
  leveling, 21
  lidded, 27
  loading into racks, 107
  orientation, 15, 20, 86
  requirements, 26
  Stacking thickness parameter, 184
Thickness parameter, 183
unloading from racks, 107, 108
motors, enabling and disabling, 133
mounting the robot, 41
Move to command, 137
moving parts injury hazard, 7
moving the device, safely, 10
moving the robot incrementally, 134

N
network card, configuring, 53
Number of stacks option, 70

O
online help, vii
operating requirements, 36
options
  Can have lid, 141, 186
  Home robot after protocol finishes, 143
Orientation sensor offset parameter, 185
Orientation sensor offset, determining, 93
Orientation threshold parameter, 184
Orientation threshold, calculating, 97

P
packing materials, 40
parameters
  Gripper holding lid position, 141, 187
  Gripper holding plate position, 185
  Gripper holding stack position, 185
  Gripper open limit, 80, 195
  Gripper open position, 185
  Intensity (all sensors), 184
  Lid departure height, 141, 187
  Lid gripper offset, 141, 186
  Lid resting height, 141, 187
  Lidded stacking thickness, 141, 186
  Lidded thickness, 141, 186
  Low pressure threshold, 142
  Orientation sensor offset, 185
  Orientation threshold, 184
  Rack sensor threshold, 142
  robot gripper offset, 185
  Stacker gripper offset, 185
  Stacking thickness, 184
  Thickness, 183
PDF guide, vii, viii
pendant
  connecting, 48
  port, 17
  port location, 17
Pick from command, 137
Place at command, 137
plate hotel, 24
Plate presence threshold, calculating, 88
plate-orientation sensors, 15, 20, 86
platepad, 24
plate-presence sensor, 19
power
  connecting, 46
  fuse, replacing, 120
power switch
  location, 17
  turning on, 60
powering off, 61
powering up, 60
pre-run checks, performing, 114
profiles
  creating, 68
  defined, 68
  initializing, 71
  updating, 71
Profiles tab quick reference, 189
properties, ActiveX, 153
protocols, about creating, 29

R
rack lock, 15
Rack sensor threshold parameter, 142
rack-presence sensors, 15, 19
rack-release button, 15, 112, 176
racks, labware
  accessory, 24
  described, 14, 22
  filling and emptying, 105
  handling safely, 103
  uninstalling, 112
recovering from emergency stop, 4
Respect approach height when not holding a plate option, 80, 195
robot
  arms, 16
  enabling and disabling motors, 133
  gripper alignment, 5
  grippers, 16, 116
  head, 15
  home position, 132
  homing, 60, 132
  jogging, 134
  mounting, 41
  speed, selecting, 135
robot disable button, 6, 16
Robot gripper offset parameter, 185
rub marks, 117
running a protocol, before, 114
running a protocol, workflow, 102
## Index

**S**
- Safe zone, described, 81
- Safety
  - Chemical, 9
  - General information, 2
  - Hazardous-voltage electronics, 9
  - High-pressure gas, 9
  - Infrared LEDs, 8
  - Interlock circuit, 7, 16, 17
  - Labels, 2
  - Moving parts, 7
  - Pendant, connecting, 48
  - Training, 2
- Safety shield
  - Described, 7, 15
  - Installing, 55
- Sensors, 8, 15, 19, 20
  - Functional description, 86
  - Orientation sensor offset, determining, 93
  - Orientation threshold, calculating, 97
  - Plate presence threshold, calculating, 88
  - Setting thresholds workflow, 87
  - Worksheet, 99
- Serial connection
  - Networking considerations, 38
  - Port location, 17
  - Profile selection, 69
- Serial number label, 148
- Service, 2, 148
- Setting sensor thresholds worksheet, 99
- Setup workflow, 58
- Shelves
  - Described, 21
  - Extending and retracting, 139
- Shipping container, 40
- Shutting down, 61
- SMC Pneumatics tool, 51
- Software
  - ActiveX control, described, 29
  - BenchCel Diagnostics, described, 29
  - Error messages, troubleshooting, 125
  - Errors, 149
  - Reporting errors, 149
  - Version number, 149
  - VWorks, described, 28
- Something is above this point option, 81
- Space requirements, 35
- Speed setting, 83, 135
- Stacker gripper offset parameter, 185
- Stacker gripper pressure, 117
- Stacker gripper pressure, adjusting, 144
- Stacker grippers
  - Described, 22
  - Opening and closing, 138
- Stacker heads described, 15
- Stacking thickness parameter, 184
- Starting the workstation, 60
- Status lights, rack-release button, 15, 176
- Subnet mask, 54

**T**
- Teachpoint Details dialog box, 78
- Teachpoint Details dialog box, reference, 193
- Teachpoints
  - Coordinates, determining, 73
  - Coordinates, recording, 78
  - Creating file for, 71
  - Defined, 72
  - Deleting, 84
  - File name and storage, 71, 72
  - Fine-tuning, 76
  - Locking devices in position, 77
  - Moving between, 137
  - Name, 79
  - Selecting file, 71
  - Setting, workflow for, 73
  - Verifying, 82
- Theta-axis movement, 16
- Thickness parameter, 183
- Third-party devices, integrating, 44
- Training, 2
- Transfer to command, 138
- Troubleshooting, 115
  - Error messages, 125
  - Hardware problems, 123
  - Reporting problems, 148
- Turning off, 61
- Turning on the workstation, 60

**U**
- Unpacking, 40
- Untrained user, caution, 10
- Upstacking process, 82, 139
- Use flow control option, 70
- User accounts, 28

**V**
- VWorks software
  - Described, 28
  - Starting, 60

**W**
- Warranty, 2
- Weight, 35
- Windows registry files, 68
- Workflows
  - Installation, 34
  - Running a protocol, 102
Index

setting sensor thresholds, 87
setup, 58
  teachpoints, setting, 73
worksheet, sensor thresholds, 99
workspace, described, 81

X
x-axis movement, 15

Z
z-axis movement, 15